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Introduction

ython is an example of a language that does everything right within the

domain of things that it’s designed to do. This isn’t just me saying it, either:

Programmers have voted by using Python enough that it’s now the first-
ranked language in the world (see https://www.tiobe.com/tiobe-index/ for
details). The amazing thing about Python is that you really can write an applica-
tion on one platform and use it on every other platform that you need to support.
In contrast to other programming languages that promised to provide platform
independence, Python really does make that independence possible. In this case,
the promise is as good as the result you get.

Python emphasizes code readability and a concise syntax that lets you write
applications using fewer lines of code than other programming languages require.
You can also use a coding style that meets your needs, given that Python supports
the functional, imperative, object-oriented, and procedural coding styles (see
Chapter 3 for details). In addition, because of the way Python works, you find it
used in all sorts of fields that are filled with nonprogrammers. Beginning Program-
ming with Python For Dummies, 3rd Edition is designed to help everyone, including
nonprogrammers, get up and running with Python quickly.

Some people view Python as a scripted language, but it really is so much more.
(Chapter 19 gives you just an inkling of the occupations that rely on Python to
make things work.) However, Python does lend itself to educational and other
uses for which other programming languages can fall short. In fact, this book uses
both Google Colab and Jupyter Notebook for examples, which rely on the highly
readable literate programming paradigm advanced by Stanford computer scientist
Donald Knuth (see Chapter 4 for details). Your examples end up looking like highly
readable reports that almost anyone can understand with ease.

About This Book

Beginning Programming with Python For Dummies, 3rd Edition is all about getting up
and running with Python quickly. You want to learn the language fast so that you
can become productive in using it to perform your real job, which could be any-
thing. With the goal in mind of making things simple in every environment, this
book emphasizes a code anywhere approach. If you want to code on your
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smart phone (not really recommended unless you like to squint a lot), you can do
so as long as your smart phone has a browser that can access Google Colab. Like-
wise, coding while watching a TV equipped with a keyboard is possible, but not
necessarily recommended because of the distractions involved. Besides, trying to
write code that you can see only in that small square in the corner of the screen
would be very tough. Highly recommended is your desktop, laptop, or tablet.

Unlike most books on the topic, this one starts you right at the beginning by
showing you what makes Python different from other languages and how it can
help you perform useful work in a job other than programming. As a result, you
gain an understanding of what you need to do from the start, using hands-on
examples and spending a good deal of time performing actually useful tasks. By
the time you finish working through the examples in this book, you’ll be writing
simple programs and performing tasks such as sending an email using Python.
No, you won’t be an expert, but you will be able to use Python to meet specific
needs in the job environment. To make absorbing the concepts even easier, this
book uses the following conventions:

¥ Text that you're meant to type just as it appears in the book is bold. The
exception is when you're working through a step list: Because each step is
bold, the text to type is not bold.

3 When you see words in italics as part of a typing sequence, you need to
replace that value with something that works for you. For example, if you see
“Type Your Name and press Enter,” you need to replace Your Name with your
actual name.

3 Web addresses and programming code appear in monofont. If you're reading a
digital version of this book on a device connected to the Internet, note that you
can click the web address to visit that website, like this: www.dummies . com.

3 When you need to type command sequences, you see them separated by a
special arrow, like this: File > New File. In this case, you go to the File menu
first and then select the New File entry on that menu. The result is that you
see a new file created.

Foolish Assumptions

You might find it difficult to believe that I’ve assumed anything about you — after
all, T haven’t even met you yet! Although most assumptions are indeed foolish,
I made these assumptions to provide a starting point for the book.
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Familiarity with the platform you want to use is important because the book
doesn’t provide any guidance in this regard. To provide you with maximum
information about Python, this book doesn’t discuss any platform-specific issues.
You really do need to know how to install applications (when working with a
desktop system), use applications, work with your browser, and generally work
with your chosen platform before you begin working with this book.

This book also assumes that you can locate information on the Internet. Sprinkled
throughout are numerous references to online material that will enhance your
learning experience. However, these added sources are useful only if you actually
find and use them.

Icons Used in This Book

TIP

®

WARNING

LD,
TECHNICAL
STUFF

REMEMBER

As you read this book, you see icons in the margins that indicate material of inter-
est (or not, as the case may be). This section briefly describes each icon in this
book.

Tips are nice because they help you save time or perform some task without a lot
of extra work. The tips in this book are time-saving techniques or pointers to
resources that you should try in order to get the maximum benefit from Python.

I don’t want to sound like an angry parent or some kind of maniac, but you should
avoid doing anything marked with a Warning icon. Otherwise, you could find that
your program only serves to confuse users, who will then refuse to work with it.

Whenever you see this icon, think advanced tip or technique. You might find these
tidbits of useful information just too boring for words, or they could contain the
solution you need to get a program running. Skip these bits of information when-
ever you like.

If you don’t get anything else out of a particular chapter or section, remember the
material marked by this icon. This text usually contains an essential process or a
bit of information that you must know to write Python programs successfully.
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Beyond the Book

4

This book isn’t the end of your Python programming experience — it’s really just
the beginning. I provide online content to make this book more flexible and better
able to meet your needs. That way, as I receive email from you, I can do things like
address questions and tell you how updates to either Python or its associated
libraries affect book content. In fact, you gain access to all these cool additions:

3 Cheat sheet: You remember using crib notes in school to make a better mark
on a test, don't you? You do? Well, a cheat sheet is sort of like that. It provides
you with some special notes about tasks that you can do with Python that not
every other developer knows. You can find the cheat sheet for this book by
going to www . dummies . com and searching for Beginning Programming with
Python For Dummies, 3rd Edition Cheat Sheet. It contains really neat informa-
tion like how to perform magic when using Python.

3 Updates: Sometimes changes happen. For example, | might not have seen an
upcoming change when | looked into my crystal ball during the writing of this
book. In the past, that simply meant the book would become outdated and
less useful, but you can now find updates to the book by going to www.
dummies.com and searching for this book’s title.

In addition to these updates, check out the blog posts with answers to reader
questions and demonstrations of useful book-related techniques athttp://
blog. johnmuellerbooks.com/.

3 Companion files: Hey! Who really wants to type all the code in the book?
Most readers would prefer to spend their time actually working through
coding examples, rather than typing. Fortunately for you, the source code is
available for download, so all you need to do is read the book to learn Python
coding techniques. Each of the book examples even tells you precisely which
example project to use. You can find these files by going to www . dummies.com
and searching for this book’s title. You can also find the downloadable source
on my website athttp://www. johnmuellerbooks .com/source—code/;
just click the Download button for Beginning Programming with Python For
Dummies, 3rd Edition. Be sure to unzip the file using the instructions at
https://support.microsoft.com/en-us/windows/zip-and-unzip—
files-8d28fa72-f2f9-712f-67df-£80c f89fd4e5 before attempting to use
the source code, even if you can see it in Windows Explorer.
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Where to Go from Here

It’s time to start your Programming with Python adventure! If you’re a complete
programming novice, you should start with Chapter 1 and progress through the
book at a pace that allows you to absorb as much of the material as possible.

If you’re a novice who's in an absolute rush to get going with Python as quickly as
possible, you could skip to Chapter 2 with the understanding that you may find
some topics a bit confusing later. Skipping to Chapter 3 is possible if you want to
start working with Python immediately and have access to Google Colab or a
Jupyter Notebook installation.

Readers who have some exposure to Python can save time by moving directly to
Chapter 4. This chapter gets you started working with notebooks so that you have
a better idea of how to work with Google Colab or Jupyter Notebook for the exam-
ples in the remainder of the book. Make sure you also read through Chapter 5,
which tells you how to perform magic in notebooks.

Assuming that you already have access to either Google Colab or Jupyter Notebook
and know how to use your IDE of choice, you can move directly to Chapter 6. You
can always go back to earlier chapters as necessary when you have questions.
However, it’s important that you understand how each example works before
moving to the next one. Every example has important lessons for you, and you
could miss vital content if you start skipping too much information.
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Chapter 1

Talking to Your
Computer

©

REMEMBER

aving a conversation with your computer might sound like the script of a

science fiction movie. After all, the members of the Enterprise on Star Trek

regularly talked with their computer. In fact, the computer often talked
back. However, with the rise of Apple’s Siri (https://www.apple.com/siri/),
Amazon’s Echo (https://www.amazon.com/dp/B@7XKF5RM3/) and other interac-
tive software (https://windowsreport.com/talking-pc-software/), perhaps
you really don’t find a conversation so unbelievable.

Asking the computer for information is one thing, but providing it with instruc-
tions is quite another. This chapter considers why you want to instruct your com-
puter about anything and what benefit you gain from it. You also discover the need
for a special language when performing this kind of communication and why you
want to use Python to accomplish it. However, the main thing to get out of this
chapter is that programming is simply a kind of communication that is akin to
other forms of communication you already have with your computer.
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Understanding Why You Want to
Talk to Your Computer

FIGURE 1-1:

Communication

with your

computer may be
invisible unless
you really think
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about it.

Talking to a machine may seem quite odd at first (then again, people do talk to
cats, dogs, cars, toasters, and other odd assorted things), but it’s necessary
because a computer can’t read your mind — yet. Mind-reading computers are
getting closer, as described in the article at https://www.psychnewsdaily.com/
this-computer-can-read-your-mind-and-render-your-thoughts-as-
pictures/. Even if the computer did read your mind, it would still be communi-
cating with you. Nothing can occur without an exchange of information between
the machine and you. Activities such as

¥ Reading your email
3 Writing about your vacation

¥ Finding the greatest gift in the world

are all examples of communication that occurs between a computer and you. That
the computer further communicates with other machines or people to address
requests that you make simply extends the basic idea that communication is nec-
essary to produce any result.

In most cases, the communication takes place in a manner that is nearly invisible
to you unless you really think about it. For example, when you visit a chat room
(sometimes called spaces now; see https://workspaceupdates.googleblog.
com/2021/09/google-chat-rooms-are-now-spaces.html) online, you might
think that you’re communicating with another person. However, you’re commu-
nicating with your computer, your computer is communicating with the other
person’s computer through the chat room (whatever it consists of), and the other
person’s computer is communicating with that person (or possibly an AI).
Figure 1-1 gives you an idea of what is actually taking place.

Ny ¥’
Sl om e

Notice the cloud in the center of Figure 1-1. The cloud could contain anything, but
you know that it at least contains other computers running other applications.
These computers make it possible for your friend and you to chat. Now, think
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about how easy the whole process seems when you’re using the chat application.
Even though all these things are going on in the background, it seems as if you’re
simply chatting with your friend, and the process itself is invisible.

Knowing that an Application Is a
Form of Communication

Computer communication occurs through the use of applications. You use one
application to answer your email, another to purchase goods, and still another to
create a presentation. An application (sometimes called an app) provides the means
to express human ideas to the computer in a manner the computer can under-
stand and defines the tools needed to shape the data used for the communication
in specific ways. Data used to express the content of a presentation is different
from data used to purchase a present for your mother. The way you view, use, and
understand the data is different for each task, so you must use different applica-
tions to interact with the data in a manner that both the computer and you can
understand.

You can obtain applications to meet just about any general need you can conceive
of today. In fact, you probably have access to applications for which you haven’t
even thought about a purpose yet. Programmers have been busy creating millions
of applications of all types for many years now, so it may be hard to understand
what you can accomplish by creating some new method for talking with your
computer through an application. The answer comes down to thinking about the
data and how you want to interact with it. Some data simply isn’t common enough
to have attracted the attention of a programmer, or you may need the data in a
format that no application currently supports, so you don’t have any way to tell
the computer about it unless you create a custom application to do it. The follow-
ing sections describe applications from the perspective of working with unique
data in a manner that is special in some way.

Thinking about procedures you use daily

A procedure is simply a set of steps you follow to perform a task. For example,
when making toast, you might use a procedure like this:

1. Getthe bread and butter from the refrigerator.
2. Open the bread bag and take out two pieces of bread.

3. Remove the cover from the toaster.
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Place each piece of bread in its own slot.

Push the toaster lever down to start toasting the bread.
Wait for the toasting process to complete.

Remove toast from the toaster.

Place toast on a plate.

O ooNOo U A

Butter the toast.

Your procedure might vary from the one presented here, but it’s unlikely that
you’d butter the toast before placing it in the toaster. Of course, you do actually
have to remove the bread from the wrapper before you toast it (placing the bread,
wrapper and all, into the toaster would likely produce undesirable results). Most
people never actually think about the procedure for making toast. However, you
use a procedure like this one even though you don’t think about it.

Computers can’t perform tasks without a procedure. You must tell the computer
which steps to perform, the order in which to perform them, and any exceptions
to the rule that could cause failure. All this information (and more) appears within
an application. In short, an application is simply a written procedure that you use
to tell the computer what to do, when to do it, and how to do it. Because you’ve
been using procedures all your life, all you really need to do is apply the knowl-
edge you already possess to what a computer needs to know about specific tasks.

Writing procedures down

When I was in grade school, our teacher asked us to write a paper about making
toast. After we turned in our papers, she brought in a toaster and some loaves of
bread. Each paper was read and demonstrated. None of our procedures worked as
expected, but they all produced humorous results. In my case, I forgot to tell the
teacher to remove the bread from the wrapper, so she dutifully tried to stuff the
piece of bread, wrapper and all, into the toaster. The lesson stuck with me. Writing
about procedures can be quite hard because we know precisely want we want to
do, but often we leave steps out — we assume that the other person also knows
precisely what we want to do.

Writing procedures down isn’t really sufficient, though — you also need to test
the procedure by asking someone who isn’t familiar with the task to perform it
using your procedure. When working with computers, the computer is your per-
fect test subject.
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Seeing applications as being like
any other procedure

A computer acts like the grade school teacher in my example in the previous sec-
tion. When you write an application, you’re writing a procedure that defines a
series of steps that the computer should perform to accomplish whatever task you
have in mind. If you leave out a step, the results won’t be what you expected. The
computer won’t know what you mean or that you intended for it to perform cer-
tain tasks automatically. The only thing the computer knows is that you have
provided it with a specific procedure and it needs to perform that procedure.

Making your computer do funny things

People eventually get used to the procedures you create. They automatically com-
pensate for deficiencies in the procedure or make notes about things that were left
out. In other words, people compensate for problems with the procedures that you
write.

When you begin writing computer programs, you’ll get frustrated because com-

@ puters perform tasks precisely and read your instructions literally. For example, if
you tell the computer that a certain value should equal 5, the computer will look

rememser  fOr a value of exactly 5. A human might see 4.9 and know that the value is good
enough, but a computer doesn’t see things that way. It sees a value of 4.9 and
decides that it doesn’t equal 5 exactly. In short, computers are inflexible, unintui-
tive, and unimaginative. When you write a procedure for a computer, the com-
puter will do precisely as you ask absolutely every time and never modify your
procedure or decide that you really meant for it to do something else. In some
cases (not many), the results can actually be quite humorous (such as that time
the computer began reciting a limerick that you meant to keep private). A sense of
humor is helpful in computer programming.

Defining What an Application Is

As previously mentioned, applications provide the means to define and express
human ideas in a manner that a computer can understand. To accomplish this
goal, the application relies on one or more procedures that tell the computer how
to perform the tasks related to the manipulation of data and its presentation.
What you see onscreen is the text from your word processor, but to see that infor-
mation, the computer requires procedures for retrieving the data from disk, putt-
ing it into a form you can understand, and then presenting it to you. The following
sections define the specifics of an application in more detail.
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Understanding that computers
use a special language

Human language is complex and difficult to understand. Even applications such as
Siri and Alexa have serious limits in understanding what you’re saying. Over the
years, computers have gained the capability to input human speech as data and to
interpret certain spoken words as commands, but computers still don’t under-
stand human speech. What the computer does is match voice patterns to data it
understands and then match that data to specific commands.

Given what you know from previous sections of this chapter, computers could
never rely on human speech to understand the procedures you write. Computers
always take things literally, so you’d end up with completely unpredictable results
if you were to use human language to write applications. That’s why humans use
special languages, called programming languages, to communicate with computers.
These special languages make it possible to write procedures that are both specific
and completely understandable by both humans and computers.

Computers don’t actually speak any language. They use binary codes to flip
e switches internally and to perform math calculations. Computers don’t even
\J understand letters — they understand only numbers. A special application turns
tecunica  the computer-specific language you use to write a procedure into binary codes.
STUFF For the purposes of this book, you really don’t need to worry too much about the
low-level specifics of how computers work at the binary level. However, it’s
interesting to know that computers speak math and numbers, not really a lan-

guage at all.

Helping humans speak to the computer

It’s important to keep the purpose of an application in mind as you write it. An
application is there to help humans speak to the computer in a certain way. Every
application works with some type of data that is input, stored, manipulated, and
output so that the humans using the application obtain a desired result. Whether
the application is a game or a spreadsheet, the basic idea is the same. Computers
work with data provided by humans to obtain a desired result.

When you create an application, you’re providing a new method for humans to
speak to the computer. The new approach you create will make it possible for
other humans to view data in new ways. The communication between human and
computer should be easy enough that the application actually disappears from
view. Think about the kinds of applications you’ve used in the past. The best
applications are the ones that let you focus on whatever data you’re interacting
with. For example, a game application is considered immersive only if you can
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WARNING

focus on the planet you’re trying to save or the ship you’re trying to fly, rather
than the application that lets you do these things.

One of the best ways to start thinking about how you want to create an application
is to look at other applications. Writing down what you like and dislike about other
applications is a useful way to start discovering how you want your applications to
look and work. Here are some questions you can ask yourself as you work with the
applications:

¥ What do | find distracting about the application?

3 Which features were easy to use?

¥ Which features were hard to use?

¥ How did the application make it easy to interact with my data?
¥ How would | make the data easier to work with?

3 What do | hope to achieve with my application that this application doesn't
provide?

Professional developers ask many other questions as part of creating an applica-
tion, but these are good starter questions because they begin to help you think
about applications as a means to help humans speak with computers. If you’ve
ever found yourself frustrated by an application you used, you already know how
other people will feel if you don’t ask the appropriate questions when you create
your application. Communication is the most important element of any applica-
tion you create.

You can also start to think about the ways in which you work. Start writing pro-
cedures for the things you do. It’s a good idea to take the process one step at a
time and write everything you can think of about that step. When you get fin-
ished, ask someone else to try your procedure to see how it actually works. You
might be surprised to learn that even with a lot of effort, you can easily forget to
include steps.

The world’s worst application usually begins with a programmer who doesn’t
know what the application is supposed to do, why it’s special, what need it
addresses, or whom it is for. When you decide to create an application, make sure
that you know why you’re creating it and what you hope to achieve. Just having a
plan in place really helps make programming fun. You can work on your new
application and see your goals accomplished one at a time until you have a com-
pleted application to use and show off to your friends (all of whom will think
you’re really cool for creating it).
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Many programming languages are available today. In fact, a student can spend an
entire semester in college studying computer languages and still not hear about
them all. (I did just that during my college days.) You’d think that programmers
would be happy with all these programming languages and just choose one to talk
to the computer, but they keep inventing more.

Programmers keep creating new languages for good reason. Each language has
something special to offer — something it does exceptionally well. In addition, as
computer technology evolves, so do the programming languages in order to keep
up. Because creating an application is all about efficient communication, many pro-
grammers know multiple programming languages so that they can choose just the
right language for a particular task. One language might work better to obtain data
from a database, and another might create user interface elements especially well.

As with every other programming language, Python does some things exception-
ally well, and you need to know what they are before you begin using it. You might
be amazed by the really cool things you can do with Python. Knowing a program-
ming language’s strengths and weaknesses helps you use it better as well as avoid
frustration by not using the language for things it doesn’t do well. The following
sections help you make these sorts of decisions about Python.

Unearthing the reasons for using Python

When Guido van Rossum (https://gvanrossum.github.io/) decided to create
Python, the main objective was to develop a programming language that would
make programmers efficient and productive. With that in mind, here are the rea-
sons that you want to use Python when creating an application:

¥ Less application development time: Python code is usually 2-10 times
shorter than comparable code written in languages like C/C++ and Java, which
means that you spend less time writing your application and more
time using it.

¥ Ease of reading: A programming language is like any other language — you
need to be able to read it to understand what it does. Python code tends to be
easier to read than the code written in other languages, which means you
spend less time interpreting it and more time making essential changes.

¥ Reduced learning time: The creators of Python wanted to make a program-
ming language with fewer odd rules that make the language hard to learn.
After all, programmers want to create applications, not learn obscure and
difficult languages.
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Although Python is a popular language, it’s not always the most popular language
out there (depending on the site you use for comparison). However, it currently
ranks first on sites such as TIOBE (https://www.tiobe.com/tiobe-index/), an
organization that tracks usage statistics (among other things). Another good place
to look is Statistics Times (https://statisticstimes.com/tech/top-computer-
languages . php), which also ranks Python as the number one language today.

If you’re looking for a language solely for the purpose of obtaining a job, Python
is a great choice, but Java, C/C++, or C# might be better choices, depending on the
kind of job you want to get. Visual Basic is also a great choice, even if it isn’t cur-
rently quite as popular as Python. Make sure to choose a language you like and one
that will address your application-development needs, but also choose on the
basis of what you intend to accomplish. You may be surprised to learn that many
colleges use Python to teach coding, and it has become the most popular language
in that venue (see https://www.pythoncentral.io/how-is—python-used-in-
education/ for details).

Deciding how you can personally
benefit from Python

Ultimately, you can use any programming language to write any sort of applica-
tion you want. If you use the wrong programming language for the job, the pro-
cess will be slow, error prone, bug ridden, and you’ll absolutely hate it — but you
can get the job done. Of course, most of us would rather avoid horribly painful
experiences, so you need to know what sorts of applications people typically use
Python to create. Here’s a list of the most common uses for Python (although
people do use it for other purposes):

¥ Creating rough application examples: Developers often need to create a
prototype, a rough example of an application, before getting the resources to
create the actual application. Python emphasizes productivity, so you can use
it to create prototypes of an application quickly.

3 Scripting browser-based applications: Even though JavaScript is probably
the most popular language used for browser-based application scripting,
Python is a close second. Python offers functionality that JavaScript doesn't
provide (see the comparison athttps: //www.educba.com/python-vs—
javascript/ for details) and its high efficiency makes it possible to create
browser-based applications faster (a real plus in today's fast-paced world).

¥ Designing mathematic, scientific, and engineering applications:
Interestingly enough, Python provides access to some really cool libraries
that make it easier to create math, scientific, and engineering applications.
The two most popular libraries are NumPy (https: //numpy.org/) and SciPy

CHAPTER 1 Talking to Your Computer 17


https://www.tiobe.com/tiobe-index/
https://statisticstimes.com/tech/top-computer-languages.php
https://statisticstimes.com/tech/top-computer-languages.php
https://www.pythoncentral.io/how-is-python-used-in-education/
https://www.pythoncentral.io/how-is-python-used-in-education/
https://www.educba.com/python-vs-javascript/
https://www.educba.com/python-vs-javascript/
https://numpy.org/

18

(https://scipy.org/). These libraries greatly reduce the time you spend
writing specialized code to perform common math, scientific, and engineering
tasks.

3 Working with XML: The eXtensible Markup Language (XML) is the basis of
most data storage needs on the Internet and many desktop applications
today. Unlike most languages, where XML is just sort of bolted on, Python
makes it a first-class citizen. If you need to work with a web service, the
main method for exchanging information on the Internet (or any other
XML-intensive application), Python is a great choice.

¥ Interacting with databases: Business relies heavily on databases. Python
isn't quite a query language, like the Structured Query Language (SQL) or
Language INtegrated Query (LINQ), but it does do a great job of interacting
with databases. It makes creating connections and manipulating data
relatively painless.

3 Developing user interfaces: Python isn't like some languages like C# where
you have a built-in designer and can drag and drop items from a toolbox onto
the user interface. However, it does have an extensive array of graphical user
interface (GUI) frameworks — extensions that make graphics a lot easier to
create (see https://wiki.python.org/moin/GuiProgramming for details).
Some of these frameworks do come with designers that make the user
interface creation process easier. The point is that Python isn't devoted to
just one method of creating a user interface — you can use the method that
best suits your needs.

Discovering which organizations
use Python

Python really is quite good at the tasks that it was designed to perform. In fact,
that’s why a lot of large organizations use Python to perform at least some
application-creation (development) tasks. You want a programming language
that has good support from these large organizations because these organizations
tend to spend money to make the language better. Table 1-1 lists some of the large
organizations that use Python the most.

can find a more complete list of organizations at https://www.python.org/
about/success/. The number of success stories has become so large that even

TIP this list probably isn’t complete and the people supporting it have had to create
categories to better organize it.

‘ These are just a few of the many organizations that use Python extensively. You
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TABLE 1-1 Large Organizations That Use Python
Vendor URL Uses Python For . ..
Alice Educational Software - Carnegie https://www.alice.org/ Educational applications
Mellon University
Fermilab https://www.fnal.gov/ Scientific applications
Go.com http://go.com/ Browser-based applications
Google https://www.google.com/ Search engine
Industrial Light & Magic https://www.ilm.com/ Just about every programming
need
Lawrence Livermore National Library https://www.1lnl.gov/ Scientific applications
National Space and Aeronautics (https://www.nasa.gov/) Scientific applications
Administration (NASA)
New York Stock Exchange https://www.nyse.com/ Browser-based applications
index
Redhat https://www.redhat.com/en Linuxinstallation tools
Yahoo! https://www.yahoo.com/ Parts of Yahoo! Mail
YouTube https://www.youtube.com/  Graphics engine

Finding useful Python applications

You might have an application written in Python sitting on your machine right
now and not even know it. Python is used in a vast array of applications on the
market today. The applications range from utilities that run at the console to full-
fledged CAD/CAM suites. Some applications run on mobile devices, while others
run on the large services employed by enterprises. In short, there is no limit to
what you can do with Python, but it really does help to see what others have done.
You can find a number of places online that list applications written in Python, but
the best place to look is https://wiki.python.org/moin/Applications.

As a Python programmer, you’ll also want to know that Python development tools
are available to make your life easier. A development tool provides some level of
automation in writing the procedures needed to tell the computer what to do.
Having more development tools means that you have to perform less work in
order to obtain a working application. Developers love to share their lists of favor-
ite tools, but you can find a great list of tools broken into categories at https://
www . python.org/about/apps/.
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Comparing Python to other languages

Comparing one language to another is somewhat dangerous because the selection
of a language is just as much a matter of taste and personal preference as it is any
sort of quantifiable scientific fact. So before I'm attacked by the rabid protectors
of the languages that follow, it’s important to realize that I also use a number of
languages and find at least some level of overlap among them all. There is no best
language in the world, simply the language that works best for a particular appli-
cation. With this idea in mind, the following sections provide an overview com-
parison of Python to other languages. (You can find comparisons to other
languages at https://wiki.python.org/moin/LanguageComparisons.)

C#

A lot of people claim that Microsoft simply copied Java to create C#. That said, C#
does have some advantages (and disadvantages) when compared to Java. The
main (undisputed) intent behind C# is to create a better kind of C/C++ language —
one that is easier to learn and use. However, we’re here to talk about C# and
Python. When compared to C#, Python has these advantages:

¥ Significantly easier to learn

9 Smaller (more concise) code

¥ Supported fully as open source

¥ Better multiplatform support

¥ Easily allows use of multiple development environments
¥ Easier to extend using Java and C/C++

¥ Enhanced scientific and engineering support

Java

For years, programmers looked for a language that they could use to write an
application just once and have it run anywhere. Java is designed to work well on
any platform. It relies on some tricks that you’ll discover later in the book to
accomplish this magic. For now, all you really need to know is that Java was so
successful at running well everywhere that other languages have sought to emu-
late it (with varying levels of success). Even so, Python has some important
advantages over Java, as shown in the following list:

¥ Significantly easier to learn

¥ Smaller (more concise) code
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¥ Enhanced variables (storage boxes in computer memory) that can hold
different kinds of data based on the application’s needs while running

(dynamic typing)

¥ Faster development times

Perl

Perl was originally an acronym for Practical Extraction and Report Language.
Today, people simply call it Perl and let it go at that. However, Perl still shows its
roots in that it excels at obtaining data from a database and presenting it in report
format. Of course, Perl has been extended to do a lot more than that — you can use
it to write all sorts of applications. (I’ve even used it for a web service application.)
In a comparison with Python, you’ll find that Python has these advantages over
Perl:

¥ Simpler to learn

¥ Easier to read

¥ Enhanced protection for data
¥ Better Java integration

¥ Fewer platform-specific biases

R

Data scientists often have a tough time choosing between R and Python because
both languages are adept at statistical analysis and the sorts of graphing that data
scientists need to understand data patterns. Both languages are also open source
and support a large range of platforms. However, R is a bit more specialized than
Python and tends to cater to the academic market. Consequently, Python has these
advantages over R:

¥ Emphasizes productivity and code readability
¥ Is designed for use by enterprises

¥ Offers easier debugging

¥ Uses consistent coding techniques

¥ Has greater flexibility

¥ Iseasiertolearn
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Haskell

Pure functional languages, such as Haskell, have some significant advantages
because they work extremely well in multithreaded application due to the fact that
pure functions always return the same value for the same inputs. There are no
side effects. Many developers also see functional languages as easier to debug and
less likely to produce bugs. Python is an impure functional language, which means
it doesn’t strictly adhere to all of the functional language requisites. However,
Python has these advantages over Haskell:

¥ Iseasiertolearn

¥ Greater selection of libraries

¥ Easier to use for prototyping and modeling
¥ Viewed as a better server-side language

¥ Has greater flexibility
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» Using Google Colab as an editor

» Performing the common tasks to
create code files

» Making your code run faster as you
execute it

» Getting help when you need it

Chapter 2

Working with Google
Colab

ack in the Stone Age of computing, developers used punch cards to write

their applications and then waited, sometimes a week, to get time on the

computer to run an application that might instantly fail with an error.
Programmers in that age were a frustrated bunch, prone to grimacing a lot. So
moving to Integrated Development Environments (IDEs) (special editors that you
use to write and run code) on large desktop machines seemed like a real achieve-
ment, but things became even better with time. Now you can write your applica-
tions anywhere and at any time with browser-based IDEs like Colabortory.
Colaboratory (https://colab.research.google.com/notebooks/welcome. ipynb),
or Colab for short, is a Google cloud-based service that lets you write Python code
using a notebook-like environment, rather than the usual desktop IDE. (Jupyter
Notebook, https://jupyter.org/, provides an environment similar to Colab on
the desktop if you don’t have an Internet connection.)

You don’t have to install anything on your system to use Colab. The benefit of this
approach is that you can work with code in small pieces and obtain nearly instant
results from any work you do (no more frustrated grimacing). A notebook format
also lends itself to output in a report format that works well for presentations and
reports. The first section of this chapter helps you work through some Colab basics
and understand how Colab differs from a standard IDE (and why this difference
imparts significant benefit when learning how to program).
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You can use Colab to perform specific tasks in a cell-oriented paradigm. The next
sections of the chapter present a range of task-related topics that start with the
use of notebooks. Of course, you also want to perform other sorts of tasks, such as
creating various cell types and use them to create notebooks that have a report-
like appearance with functional code.

Part of working with Colab is knowing how to run the example code, making it run
as quickly as possible. Two sections of the chapter are dedicated to using hardware
acceleration and running the example code in various ways.

Finally, this chapter can’t address every aspect of Colab, so the last section of the
chapter serves as a handy resource for locating the most reliable information
about Colab.

You don’t have to type the source code for this chapter manually. In fact, using
the downloadable source is a lot easier. You can find the source for this chapter in
the BPP4D3E; 02; Colab Examples.ipynb file of the downloadable source. See the
Introduction for details on how to find these source files.

Defining Google Colab

24

Colab helps you write, document, and test Python code using a single application.
It’s designed to mimic a desktop application called Jupyter Notebook (https://
jupyter.org/), so you can use Jupyter Notebook in place of Colab to run the
applications in this book. In fact, it’s somewhat difficult to tell the two applica-
tions apart in the functionality they provide. Google Colab is the cloud version of
Notebook, and the Welcome page makes this fact apparent. It even uses IPython
(the previous name for Jupyter) Notebook (. ipynb) files for the site.

Even though the two applications are similar and both use . ipynb files, they do
have some differences that you need to know about. The previous edition of this
book used Jupyter Notebook, but Colab offers the ability to compute anywhere on
any device that sports a browser, so this edition of the book focuses on Colab
instead. The following sections help you understand the Colab differences.

Understanding what Google Colab does

You can use Colab to perform many tasks, but for the purpose of this book, you use
it to write and run code, create its associated documentation, and display graph-
ics. The downloadable source for this book is designed to run on Colab, but you can
also use it with Jupyter Notebook if you want.
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Jupyter Notebook is a localized application in that you use local resources with it.
You could potentially use other sources, but doing so could prove inconvenient or
impossible in some cases. For example, according to https://docs.github.com/
repositories/working-with-files/using-files/working-with-non-code-
files, your Notebook files will appear as static HTML pages when you use a
GitHub repository. (GitHub is a cloud-based storage technology specifically ori-
ented to working with code.) In fact, some features won’t work at all.

Colab enables you to fully interact with your Notebook files using GitHub as a
repository, and Colab supports a number of other online storage options as well,
so you can regard Colab as your online partner in creating Python code. The GitHub
repository for this book is at https://github.com/JohnPaulMueller/BPP4D3E.

The other reason you really need to know about Colab is that you can use it with
your alternative device. During the writing process, some of the example code was
tested on an Android-based tablet (an ASUS ZenPad 3S 10). The target tablet has
Chrome installed and executes the code well enough to follow the examples. All
this said, you likely won’t want to try to write code using a tablet of that size (it
has a 9.7-inch diagonal screen) — the text was incredibly small, for one thing,
and the lack of a keyboard could be a problem, too. The point is that you don’t
absolutely have to have a Windows, Linux, or macOS system to try the code, but
the alternatives might not provide quite the performance you expect.

Google Colab generally doesn’t work with browsers other than Chrome (the
browser used in this chapter), Firefox, or Safari (although initial tests with Micro-
soft Edge have also been encouraging). In most cases, you see an error message,
such as This site may not work in your browser. Please use a supported
browser, and no other display if you try to start Colab in a browser that it doesn’t
support. The included More Info link takes you to https://research.google.
com/colaboratory/faq.html#browsers, where you can learn more information.

Working with Google Colab features

Google Colab provides access to a number of features through the menu system.
One of these features, hardware acceleration, appears in the “Using Hardware
Acceleration” section, later in this chapter. The features in this section all appear
on the Tools menu.

Locating commands

The Tools= Command Palette option displays a list of commands you can execute,
as shown in Figure 2-1. Some of these commands also have shortcut keys, such as
Ctrl+Alt+M for adding a comment to a cell. All these commands help you to per-
form tasks associated with Notebook content, such as adding forms.
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SOME FIREFOX ODDITIES

Even with online help, you may still find that your copy of Firefox displays a
SecurityError: The operation is insecure. error message. The initial error
dialog box points to some unrelated issue, such as cookies, but you see this error mes-
sage when you click Details. Simply dismissing the dialog box by clicking OK makes
Colab appear to be working because it displays your code, but you won't see results
from running the code.

As a first step toward fixing this problem, make sure that your copy of Firefox is current;
older versions don't provide the required support. After you've updated your copy, set-
ting the network . websocket . al lowInsecureFromHTTPS preference using

About :Config to True should resolve the problem, but sometimes it doesn't. In this
case, verify that Firefox actually does allow third-party cookies by selecting both the
Always option for Accept Third Party Cookies and Site Data entry and the Remember
History option in the History section on the Privacy & Security tab of the Options dialog
box. Restart Firefox after each change and then try Colab again. If none of these fixes
works, you must use Chrome to work with Colab on your system.

Type to search commands...

Add a comment Ctri+Alt+M
Add a form

Add a form field

A ode cell

ction header cell

able of contents cell

Configuring settings
The Tools= Settings option displays the Settings dialog box, shown in Figure 2-2.

The four common and one optional (not shown) settings tabs perform these tasks:

¥ Site: Configures how the site works. The most interesting setting is the theme.
Selecting Adaptive lets Colab choose the interface colors based on lighting
conditions. You can also configure display and access settings on this tab.
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FIGURE 2-2:

The Settings
dialog box helps
you configure the
Colab IDE.

»

»

»

»

Editor: Determines how text appears onscreen and how the interface works.
For example, you can set the key bindings to work like those in Vim (a text
editor included on Unix and Linux systems, generally as the vi utility,
https://www.vim.org/) if desired. You can also select font size, spaces for
each level of indentation, and a plethora of other settings.

Colab Pro: Provides an advertisement for Colab Pro (https://colab.
research.google.com/signup), which gives you some significant benefits
like faster GPUs, longer runtimes, and more memory — all of which let you
get more work done in a shorter time.

GitHub (optional): Shows that your GitHub account is connected to Colab
when this tab appears. The various options let you remove GitHub access and
determine whether you can see private repositories when opening files.
Figure 2-2 doesn't show this particular tab because you won't normally see it
until you grant GitHub access using the instructions found athttps://
medium.com/analytics-vidhya/how-to-use-google-colab-with-
github-via-google-drive-68efb23a42d. You can find some additional
insights athttps://stackoverflow.com/questions/67553747/
how-do-i-1link-a—-github-repository-to-a—-google-colab—-notebook.

Miscellaneous: Contains fun settings. You can choose from three visual
effects: adding thunder and lightning using the Power Level setting; letting a
Corgi run across the top of the display; and allowing a kitten to run across the
top of the display. You can choose any mix of these visual effects.

Settings
si Theme
o adaptive

Editor |:| Show desktop notifications for completed executions
[ Mew notebocks use private outputs (omit outputs when saving)

Colab Pro Request GitHub access to view and edit private repositories and

organizations

More info

Miscellaneous

Custom snippet notebook URL

Cancel Save
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Set shortcut Add a form
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Set shortcut Add code cell
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FIGURE 2-3: Set shortcut Add text cell
Customize Ctrl+Space or Tab  Autocomplete @
ortcut keys for Setshocut | Clear all outputs .
Speed of access Restore defaults Cancel Save
to commands.
Comparing files
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Customizing keyboard shortcuts

If you don’t like the default keyboard shortcuts, you can customize them to match
your needs. To do so, choose Tools= Keyboard Shortcuts, and you see the Key-
board Preferences dialog box, shown in Figure 2-3. If you see Set Shortcut, it
means that the command doesn’t currently have a shortcut, so you can add one if
desired. Here’s how you work with shortcuts:

¥ To add or change a shortcut, place the cursor in the box next to the command
and press the shortcut key you want to use for that command.

3 Toremove a shortcut, press Delete.

Editor key bindings
default

Keyboard preferences

Shortcuts

Enter key accepts suggestions

To add or change a shortcut, click the key combination and then type the new keys. Note that
Ctrl+M can be used as a prefix for multi-key-event shortcuts

Sometimes you need to compare two files to see how they differ. When you select
Tools= Diff Notebooks, Colab opens a new browser tab and shows you two
notebooks side by side, as shown in Figure 2-4. These are files selected by random
from your Google Drive. To select the files you actually want to work with,
click the down arrow next to the file path in each pane. The differences appear

onscreemn.
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& Cc 0O # colab.research.google.com/diff#left=%2Fdrive%2F 1bnUVavxylmM... ¥ S g

Reference Radio Stations Search Engines La Valle, Wl 10-Day... i§li John Mueller Books »

QO https://colab.research.google.com/dri ~ [ https://colab.research.google.com/dri ~ [

[ rawsource [ Inline diff Show output

/drive/1bnUVavxylmMZid2wKsFdMC5P3dvrlgYu /drive/1drKdCUK5vaSlkvSegnDi6siFWTLzZyvp -
~Helle @2.ipynb —t.upy of A4D2E; @3; Colab Examples.ipynb .o
L
~Code cell <9k3rfaJvCoUN> +Code cell <rlLZaSaijcQzy>
#%% [code] #%% [code]
1-print("Hello there again!") 1+print("Hello There!™)

Working with Notebooks

FIGURE 2-5:
Create a new
Python 3
Notebook.

The notebook forms the basis for interactions with Colab. In fact, Colab is built on
notebooks, as previously mentioned. When you place the mouse on certain parts
of the Welcome page at https://colab.research.google.com/notebooks/
welcome. ipynb, you see opportunities for interacting with the page by adding
either code or text entries (which you can use for notes as needed). These entries
are active, so you can interact with them. You can also move cells around and copy
the resulting material to your Google Drive. Of course, although interacting with
the Welcome page is both unexpected and fun, the real purpose of this chapter is
to demonstrate how to interact with Colab notebooks. The following sections
describe how to perform basic notebook-related tasks with Colab.

Creating a new notebook

To create a new notebook, choose File> New Notebook. You see a new Python 3
notebook, like the one shown in Figure 2-5.

O X
CO Untitledlipynb - Colsboratory X [I0ap (-]
c 0O # colab.research.google.com/drive/1x8lk4SBytApWz1mO8qhXpsBOT... ¥r » e
Reference Radio Stations Search Engines La Valle, Wl 10-Day.. i John Mueller Baoks »
£ Untitledl.ipynb ;
[ Py B comment &% Share €% Q
File Edit View Insert Runtime Tools Help Allc
. + Code + Text Connect # Editing ~
A= K- NN |
* 0
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FIGURE 2-6:
Use this dialog
box to open
existing
notebooks.

TIP

The notebook shown in Figure 2-5 lets you change the filename by clicking it. To
run the code in a particular cell, you click the right-pointing arrow on the left side
of that cell. After you run the code, you must choose the next cell directly.

Opening existing notebooks

You can open existing notebooks found in local storage, on Google Drive, or on
GitHub. You can also open any of the Colab examples or upload files from sources
that you can access, such as a network drive on your system. In all cases, you
begin by choosing File> Open Notebook. You see the dialog box shown in
Figure 2-6.

Examples Recent Google Drive GitHub Upload
Title Last opened & First opened « [ H
L Untitled1.ipynb 412PM 412PM | sV
€O Welcome To Colaboratory 4710 PM Aug 27,2018 @
L AADZE; 03; Colab Examples.ipynb 3:44PM 3:41PM P Z
€O Welcome To Colaboratory 343PM May 2 E4]
L A4D2E; 03; Colab Examples.ipynb 3:22 PM Nov 30,2020 B Z
Cancel

The default view shows all the files you opened recently, regardless of location.
The files appear in alphabetical order. You can filter the number of items dis-
played by typing a string into the Filter Notebooks field. Across the top are other
options for opening notebooks.

Even if you’re not logged in, you can still access the Colab example projects. These
projects help you understand Colab but won’t allow you to do anything with your
own projects. Even so, you can still experiment with Colab without logging into
Google first. The following sections tell you more details about these options.
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FIGURE 2-7:
When using
GitHub, you must
provide the
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source code.

Using Google Drive for existing notebooks

Google Drive is the default location for many operations in Colab, and you can
always choose it as a destination. When working with Google Drive, you see a list
of files similar to those shown in Figure 2-6. To open a particular file, you click its
link in the dialog box. The file opens in the current tab of your browser.

Using GitHub for existing notebooks

When working with GitHub, you initially need to provide the location of the source
code online by modifying the Repository field, as shown in Figure 2-7. If the proj-
ect contains more than one branch (path of code changes), you must also select an
option in the Branch field. The location must point to a public project or a private
project owned by you; you can’t use Colab to access other people’s private projects.

Examples Recent Google Drive GitHub Upload
Enter a GitHub URL or search by organization or user Include private repos
JohnPaulMueller (o}
Repository: [ Branch: [

JohnPaulMueller/BPPAD3E A main v
Path
O BPP4D3E; 02; Colab Examples.ipynb B =@

Cancel

After you make the connection to GitHub, you see two lists: repositories, which
are containers for code related to a particular project; and branches, a particular
implementation of the code. Selecting a repository and branch displays a list of
notebook files that you can load into Colab. Simply click the required link, and it
loads as if you were using a Google Drive (https://drive.google.com/), which is
another type of online storage.

Using local storage for existing notebooks

If you want to use the downloadable source for this book, or any local source for
that matter, you select the Upload tab of the dialog box. In the center is a single
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button, Choose File. Clicking this button opens the File Open dialog box for your
browser. You locate the file you want to upload, just as you normally would for
opening any file.

Selecting a file and clicking Open uploads the file to Google Drive. If you make
changes to the file, those changes appear on Google Drive, not on your local drive.
Depending on your browser, you usually see a new window open with the code
loaded. However, you may also simply see a success message, in which case you
must now open the file using the same technique as you would when using Google
Drive. In some cases, your browser asks whether you want to leave the current
page. You should tell the browser to do so.

The File=> Upload Notebook command also uploads a file to Google Drive. In fact,
uploading a notebook works like uploading any other kind of file, and you see the
same dialog box. If you want to upload other kinds of files, using the File=> Upload
Notebook command is likely faster.

Saving notebooks using GitHub

Colab provides a significant number of options for saving your notebook. How-
ever, none of these options works with your local drive. After you upload content
from your local drive to Google Drive or GitHub, Colab manages the content in the
cloud and not on your local drive. To save updates to your local drive, you must
download the file to your local drive by choosing one of the options on the
File> Download menu (either an . ipynb or a . py file format). The following sec-
tions review the cloud-based options for saving notebooks.

Using Drive to save notebooks

The default location for storing your data is Google Drive. When you choose
File= Save, the content you create goes to the root directory of your Google Drive.
If you want to save the content to a different folder, you need to select that folder
in Google Drive.

Colab tracks the versions of your project as you perform saves. However, as these
revisions age, Colab removes them. To save a version that won’t age, you use the
File> Save and Pin Revision command. To see the revisions for your project,
choose File=> Revision History.

You can also save a copy of your project by choosing File=> Save a Copy In Drive.
The copy receives the word Copy as part of its name. Of course, you can rename it
later. Colab stores the copy in the current Google Drive folder.
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Using GitHub to save notebooks

GitHub provides an alternative to Google Drive for saving content. It offers an
organized method of sharing code for the purpose of discussion, review, and dis-
tribution. You can find GitHub at https://github.com/. The source code for this
book appears at https://github.com/JohnPaulMueller/BPP4D3E, SO you can
access it easily from Colab.

You may use only public repositories and private repositories that you own when
working with GitHub from Colab, even though GitHub also supports private
repositories. To save a file to GitHub, choose Filec> Save a Copy in GitHub. If you
aren’t already signed into GitHub, Colab displays a window that requests your
sign-in information. After you sign in, you see a dialog box similar to the one
shown in Figure 2-8.

Copy to GitHub
Repository: [ Branch: [
JohnPaulMueller/BPPAD3E v main v

File path
BPP4D3E; 02; Colab Examples.ipynb

Commit message
Created using Colaboratory
[ include alink to Colaboratory

Cancel 0K

If your account doesn’t currently have a repository, you must either create a new
repository or choose an existing repository in which to store your data. After you
save the file, it appears in the GitHub repository of your choice. The repository can
include a link to open the data in Colab by default when you check the Include a
Link to Colaboratory option.

Getting the gist of things

You use GitHub gists as a means of sharing single files or other resources with
other people. Some people use them for full projects as well, but the idea is that you
have a concept you want to share — something that isn’t quite fully formed and
doesn’t necessarily represent a usable application. You can read more about gists at
https://docs.github.com/en/get-started/writing-on-github/editing-and-
sharing-content-with-gists/creating-gists.
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has the URL can see it. The only difference between a public and a secret gist is
that someone can’t use Discover (https://gist.github.com/discover) to locate

warning  the gist. If you really need to keep your code private, you need to use a GitHub
private repository instead of a gist.

‘ Gists come in two forms, public and secret. A secret gist isn’t private; anyone who

When you choose Filew> Save a Copy as a GitHub gist, Colab opens a new copy of
the file for you and places it on GitHub gist as a secret gist. The saved file auto-
matically includes an Open in Colab button (badge) so that you can open the file in
Colab as needed. The problem is that you really don’t know much about the gist
(not even where Colab put it), so here are some helpful pointers:

¥ Locate: To locate your gist, open Discover (https://gist.github.com/
discover), type the name of the file in the Search field, and press Enter. You
see a list of matching files, one of which is going to be the one you saved. It's
also possible to locate your gists by accessing them on your gist page, such as
https://gist.github.com/JohnPaulMueller.

3 Delete: You may not want to keep the file around because it contains secrets,
or perhaps you're just embarrassed about it. Open the file and click the Delete
button that appears at the top of the browser page. GitHub displays a dialog
box asking whether you're positive that you want to delete the file. Click OK to
complete the action.

3 Publicize: After your masterpiece is complete, you may want to share it with
the world. To perform this task, open the file and click Edit at the top of the
page. GitHub will display the editable form of the file for you. Click Make
Public at the top of the page.

& Making your gist public is a one-way trip. After the gist is public, you can't
make it private again, so your only option is to delete the gist if you want to
keep it out of the public view.
WARNING
3 Share: You have multiple options for sharing your gist: Embed, Share, Clone
via HTTPS, and Clone via SSH. To share a gist, choose the option you want to
use from the drop-down box (Embed is the default) and then click the Copy
button to the right of the option selection. You can now paste the link to your
gist anywhere you need to.

3 Download: If you need a local copy of your gist, click the Download ZIP button.
GitHub will download a . zip file to your local drive that contains the gist.

Working with Drive

When you upload a file or obtain it from another source, such as GitHub, you can
choose to save a copy of it to Drive by choosing File> Save a Copy in Drive. When
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you choose this option, Colab opens another copy of the file in a window that says
Copy Of and then the original name of the file. When you open Google Drive, you
see a new folder named Colab Notebooks with the copy of the file in it. You can
double-click this entry to open the notebook in Colab later.

Performing Common Tasks

Most tasks in Colab and Notebook work the same. Each has both code cells and
noncode cells, and you can create code cells in both Colab and Notebook by using
the options on the Insert menu. Likewise, both environments have noncode cells
that come in three forms:

» Text

¥ Section header

¥ Form field, which comes in these types:
Drop-down
Input
Slider

Markdown

Noncode cells in Colab work somewhat differently from the Markdown cells found
in Notebook, but the idea is the same. Two interesting additions in Colab that
aren’t found in Notepad are the scratch code cell, which allows you to experiment
with code in real time, and code snippets, which are canned code for performing
specific tasks (you just insert them where needed).

You can also edit and move cells. One important difference between the two envi-
ronments is that you can’t change a cell type in Colab but you can in Notebook. A
cell that you create as a section header can’t suddenly transform into a code cell.
The following sections offer a brief overview of the various features.

Creating code cells

The first cell that Colab creates for you is a code cell. Colab and Notebook share the
same features with regard to code, so code you write in Colab also works in Note-
pad (and vice versa). However, off to the side of the cell, you see a menu of extras
that you can use with Colab (see Figure 2-9); these aren’t present in Notebook.
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You use the icons shown in Figure 2-9 to augment your Colab code experience.
Here’s what these features do (in order of appearance, left to right, in the figure):

3 Move cell up: Moves the cell up one position in the cell ordering.
3 Move cell down: Moves the cell down one position in the cell ordering.

¥ Link to cell: Displays a dialog box containing a link you can use to access a
specific cell within the notebook. You can embed this link anywhere on a web
page or within a notebook to allow someone to access that specific cell. The
person still sees the entire notebook but doesn't have to search for the cell
you want to discuss.

3 (Optional) Add a comment (assuming that you have the right to make a
comment): Creates a comment balloon to the right of the cell. This is not the
same as a code comment, which exists inline with the code, but this kind of
comment affects the entire cell. You can edit, delete, or resolve comments.

A resolved comment is one that received attention and is no longer
applicable.

3 Open editor settings: Opens the same dialog box shown in Figure 2-2 and
discussed in the “Working with Google Colab features” section, earlier in this
chapter. This option appears when you are editing a cell.

3 Mirror cell in tab: Mirrors the currently selected cell in a Cell pane that
appears on the right side of the window. You can scroll wherever you want
within the code in the left pane and keep this code accessible. The right-
pointing arrow lets you execute the cell at any time after making changes in
left-pane code. A pair of double-pointing arrows lets you move the focus back
to the selected code in the left pane with a single click. You can also move the
cell code to a scratch cell, where you can play with it without modifying your
original code. You can have more than one Cell pane. You simply select the
one you want and move between them as needed, which lets you move easily
from place to place in your code. Close a Cell pane by clicking the X next to the
word Cell.

¥ Delete Cell: Removes the cell from the notebook.

¥ Vertical ellipses: Contains a number of additional features in a menu (not all
of which may appear because they depend on the file you have opened, the
tasks you have performed, and your rights to work with the file content):

Select Cell: Highlights the entire content of the current cell, including the
output, which is a convenient way to copy the material for use elsewhere.
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FIGURE 2-10:
Use the GUI to
make formatting
your text easier.

Copy Cell: Copies the content of the currently selected cell to the
Clipboard.

Cut Cell: Deletes the content of the currently selected cell and places it on
the Clipboard.

Clear Output: Removes the output from the cell. You must run the code
again to regenerate the output.

View Output Fullscreen: Displays the output (not the entire cell or any
other part of the notebook) in full-screen mode on the host device. This
option is useful when displaying a significant amount of content, or when a
detailed view of graphics helps explain a topic. Press Esc to exit full-screen
mode.

Add a Form: Inserts a form into the cell to the right of the code. You use
forms to provide a graphical input for parameters. Forms don't appear in
Notebook, but because of how you create them, they won't prevent you
from running the code in Notebook. You can read more about forms at
https://colab.research.google.com/notebooks/forms. ipynb.

Code cells also tell you about the code and its execution. The little icon next to the
output displays information about the execution when you hover your mouse over
it. Clicking the icon clears the output. You must run the code again to regenerate
the output.

Creating text cells

Text cells work much like Markdown cells in Notebook. However, Figure 2-10
shows that you receive additional help in formatting the text using a graphical
interface. The markdown is the same, but you have the option of allowing the GUI
to help you create the markdown. For example, in this case, to create the hash sign
(#) for a heading, you click the double T icon that appears first in the list. Clicking
the double T icon again would increase the header level. To the right, you see how
the text will appear in the notebook.

o g AER

iT B I < o= N = - [

# This is a **Main** Heading

## This is a *Second Level* Heading Th|S |S a Main Head|ng

This is some text.

This is a Second Level Heading

| This is some text.
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Notice the menu to the right of the text cell. This menu contains many of the same
options that a code cell does. For example, you can create a list of links to help
people access specific parts of your notebook through an index. In contrast to
Notebook, you can’t execute text cells to resolve the markup they contain.

You can find details of Colab markdown at https://colab.research.google.
com/notebooks/markdown_guide. ipynb. The tutorial at https://www.datacamp.
com/community/tutorials/markdown—in-jupyter-notebook is helpful in dis-
covering how to use both Colab and Notebook markdown.

Creating special cells

The special cells that Colab provides are variations of the text cell. These special
cells, which you access using the Insert menu option, make creating the required
cells faster. However, you shouldn’t use these special cells if you need to maintain
compatibility between Colab and Notebook. The following sections describe each
of these special cell types.

Working with headings

When you choose Insert= Section Header Cell, you see a new cell created below
the currently selected cell that has the appropriate header level-1 entry in it. You
can increase the heading level by clicking the double T icon. The GUI looks the
same as the one in Figure 2-10, shown previously, so you have all the standard
formatting features for your text.

Working with a table of contents

An interesting addition to Colab is the automatic generation of a table of contents
for your notebook. To use this feature, click the Table of Contents icon on the left
side of the window. The table of contents contains one entry for each heading you
provide in your notebook. The entries are automatically organized according to
level, so you see the hierarchy of your code. Clicking an entry automatically takes
you to that location in your code.

Editing cells

Both Colab and Notebook have Edit menus that contain the options you expect,
such as the ability to cut, copy, and paste cells. The two products also have some
interesting differences. For example, Notebook allows you to split and merge cells.
Colab contains an option to show or hide the code as a toggle. These differences
give each product a slightly different flavor but don’t really change your ability to
use each one to create and modify Python code.
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Moving cells

The same technique you use for moving cells in Notebook also works with Colab.
The only difference is that Colab relies exclusively on toolbar buttons (refer to in
Figure 2-9); Notebook also has cell movement options on the Edit menu. To move
a cell, select it and then click the Move Cell Up or Move Cell Down buttons as
needed.

Using Hardware Acceleration

Even though you won’t need it for the examples in this book, Colab does offer
hardware acceleration in the form of a Graphics Processing Unit (GPU) or Tensor
Processing Unit (TPU). Both of these special processors offer the ability to process
multiple sets of data in parallel at high speed. When working with big data in a
machine learning or deep learning environment, a GPU or TPU can make a huge
difference in the time required to accomplish a task. The main difference between
a GPU and a TPU is that a GPU appears as part of most high-end display adapters
today and can double for rendering complex graphics, while a TPU is a custom
processor designed by Google specifically for machine learning and deep learning
tasks. (There are other differences, but they aren’t important for this book.)

GPU and TPU support are disabled by default in Colab. To enable GPU or TPU sup-
port, choose Runtime= Change Runtime Type. A Notebook Settings dialog box
appears. In this dialog box is the Hardware Accelerator drop-down list, from
which you can choose None (the default), GPU, or TPU.

Executing the Code

For your code to be useful, you need to run it at some point. Previous sections have
mentioned the right-pointing arrow that appears in the current cell. Clicking it
runs just the current cell. Of course, you have other options than clicking the
right-pointing arrow, and all these options appear on the Runtime menu (the Cell
menu in Notebook). The following list summarizes these options:

3 Running the current cell: Instead of clicking the right-pointing arrow, you
can also choose Runtime = Run the Focused Cell to execute the code in the
current cell.

3 Running other cells: Colab provides options on the Runtime menu for
executing the code in the next cell, the previous cell, or a selection of cells.
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Simply choose the option that matches the cell or set of cells you want to
execute.

3 Running all the cells: In some cases, you want to execute all the code in a
notebook. In this case, choose Runtime => Run All. Execution starts at the top
of the notebook, in the first cell containing code, and continues to the last cell
that contains code in the notebook. You can stop execution at any time by
choosing Runtime = Interrupt Execution.

Choosing Runtimer> Manage Sessions displays a dialog box containing a list of all
the sessions that are currently executing for your account on Colab. You can use
this dialog box to determine when the code in that notebook last executed and how
much memory the notebook consumes. Click the trash can icon (also shown as a
TERMINATE link) to end execution for a particular notebook.

Getting Help

40

The most obvious place to obtain help with Colab is from the Colab Help menu.
The menu doesn’t have a general help link, but you can find it at https://colab.
research.google.com/notebooks/welcome.ipynb (which requires you to log
into the Colab site). This menu does contain all the usual entries (some of which
may not appear on your browser):

¥ Frequently Asked Questions (FAQs): Takes you to a page with questions
that other people have asked.

¥ View Release Notes: Takes you to a page that contains the release notes for
the current Colab version, along with all of the versions before it.

3 Search Code Snippets: Opens a pane showing common tasks, such as
working with a camera, in which you can search for example code that may
meet your needs with a little modification. Clicking the Insert button inserts
the code at the current cursor location in the cell that has focus. Each of the
entries also shows an example of the code.

3 Report a Bug: Takes you to a page where you can report Colab errors.

3 Ask a Question on Stack Overflow: Displays a new browser tab, where you
can ask questions from other users. You see a login screen if you haven't
already logged in to Stack Overflow.

¥ Send Feedback: Displays a dialog box with links for locations where you can
obtain additional information. If you really do want to send feedback, you click
the Continue Anyway link at the bottom of the dialog box.
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IN THIS CHAPTER

» Using commands to perform tasks

» Obtaining help about Python
» Discovering functions and objects

» Employing the inspector

Chapter 3
Interacting with Python

ltimately, any application you create interacts with the computer and the

data it contains. The focus is on data because without data, there isn’t a

good reason to have an application. Any application you use (even one as
simple as Solitaire) manipulates data in some way. In fact, the acronym CRUD
sums up what most applications do:

¥ Create
¥ Read

¥ Update
3 Delete

If you remember CRUD, you’ll be able to summarize what most applications do
with the data your computer contains (and some applications really are quite
cruddy). However, before your application accesses the computer, you have to
interact with a programming language that creates a list of tasks to perform in a
language the computer understands. That’s the purpose of this chapter. You begin
interacting with Python. Python takes the list of steps you want to perform on the
computer’s data and changes those steps into bits the computer understands. The
chapter helps you understand how to obtain help about data manipulation meth-
ods, work with functions and objects that interact with data, and use the Python
inspect module to perform detective work on your data.
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You don’t have to type the source code for this chapter manually. In fact, using the
downloadable source is a lot easier. You can find the source for this chapter in the
BPP4D3E; @3; Working with Commands.ipynb file of the downloadable source.
See the Introduction for details on how to find these source files.

Typing a Command

42

When you tame your lion (or cat or dog), you teach it commands such as sit, stay,
and don’t eat me. Each command instructs the animal to perform a task or do
something else interesting. Likewise, using commands in Python makes it possi-
ble to perform application tasks, test ideas that you have for writing your
application, and discover more about Python. Using the commands let you gain
hands-on experience with how Python actually works.

UNDERSTANDING THE IMPORTANCE OF
THE README FILE

Many applications include a README file (not necessarily named README). The
README file usually provides updated information that didn’t make it into the docu-
mentation before the application was put into a production status. Unfortunately, most
people ignore the README file and some don't even know it exists. As a result, people
who should know something interesting about their shiny new product never find out.

The version of Python you use has a Release Notes file (just because the developers
didn't want to call it a README file) that contains essential information about Python.

If you download and install a copy of Python on your local machine, this Release Notes
file is named NEWS . txt and it appears in the main Python folder. If you use Colab and
don't download anything, you can find the same information online. For example, the
Python 3.10.3 Release Notes appear athttps://docs.python.org/release/
3.10.3/whatsnew/changelog.html. You can find Release Notes links for other ver-
sion of Python athttps: //www.python.org/downloads/. When you open this file,
you find all sorts of really interesting information, most of which centers on upgrades to
Python that you really need to know about.

Opening and reading the Release Notes file (named NEWS . txt or changelog.html
because people were apparently ignoring the other file) will help you become a Python
genius. People will be amazed that you really do know something interesting about
Python and will ask you all sorts of questions (deferring to your wisdom). Of course, you
could always just sit there, thinking that the README is just too much effort to read.
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TIP

Telling the computer what to do

Python, like every other programming language in existence, relies on commands.
A command is simply a step in a procedure. In Chapter 1, you see how “Get the
bread and butter from the refrigerator” is a step in a procedure for making toast.
When working with Python, a command, such as print(), is simply the same
thing: a step in a procedure.

To tell the computer what to do, you issue one or more commands that Python
understands. Python translates these commands into instructions that the com-
puter understands, and then you see the result. A command such as print() can
display the results onscreen so that you get an instant result. However, Python
supports all sorts of commands, many of which don’t display any results onscreen
but still do something important.

As the book progresses, you use commands to perform all sorts of tasks. Each of
these tasks will help you accomplish a goal, just as the steps in a procedure do.
When it seems as if all the Python commands become far too complex, simply
remember to look at them as steps in a procedure. Even human procedures become
complex at times, but if you take them one step at a time, you begin to see how
they work. Python commands are the same way. Don’t get overwhelmed by them;
instead, look at them one at a time and focus on just that step in your procedure.

Telling the computer you're done

At some point, the procedure you create ends. When you make toast, the proce-
dure ends when you finish buttering the toast. Computer procedures work pre-
cisely the same way. They have a starting and an ending point. When typing
commands, the ending point for a particular step is the Enter key. You press Enter
to tell the computer that you’re done typing the command.

Pressing Enter doesn’t actually run the command; you need to click Run Cell in
Colab or click Run in Jupyter Notebook. As an alternative, you can also type a
single command in a code cell and then press Ctrl+Enter in either IDE to run it.

As the book progresses, you find that Python provides a number of ways to signify
that a step, group of steps, or even an entire application is complete. No matter
how the task is accomplished, computer programs always have a distinct starting
and stopping point.
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FIGURE 3-1:
Issuing com-
mands tells
Python what to
tell the computer
to do.
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Seeing the result

You now know that a command is a step in a procedure and that each command
has a distinct starting and ending point. In addition, groups of commands and
entire applications also have a distinct starting and ending point. So, take a look
at how this works. The following procedure helps you see the result of using a
command:

1. starta copy of either Google Colab or Jupyter Notebook and then create
a new Python 3 Notebook as described in the “Creating a new notebook”
section of Chapter 2.

You see a code cell where you can type a command.
2. Type print(“This is a line of text.”) in the code cell.

Notice that nothing happens. Yes, you typed a command, but you haven't
signified that the command is complete.

3. Press Ctrl+Enter.

The command is complete, so you see a result like the one shown in Figure 3-1.

= (m] *
€O BPP4D3E; 03; Working with Com: X + -
& C {} & nhttps//colab.research.google.com/drive/1t6Rwl_Lyj9uuakZ... (& Yr » 0 H
( & BPP4D3E; 03; Working with Commands... B comment 2% shere  o% Q
File Edit View Insert Runtime Tools Help All chang
+ Code + Text v RMR - # Editing A
0 =N |
Q ° printi(("This is a line of text.")l

This is a line of text.

1

~ 0s completed at 9:07 AM ® X

This exercise shows you how things work within Python. Each command that you
type performs some task, but only after you tell Python that the command is com-
plete in some way. The print() command displays data onscreen. In this case,
you supplied text to display. Notice that the output shown in Figure 3-1 comes
immediately after the command because this is an interactive environment — one
in which you see the result of any given command immediately after Python per-
forms it. Later, as you start creating applications, you notice that sometimes a
result doesn’t appear immediately because the application environment delays it.
Even so, the command is executed by Python immediately after the application
tells Python that the command is complete.
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PYTHON'S CODING STYLES

Most programming languages are dedicated to using just one coding style, which
reduces flexibility for the programmer. However, Python is different. You can use a
number of coding styles to achieve differing effects with Python. The four commonly
used Python coding styles are

® Functional: Every statement is a kind of math equation. This style lends itself well
to use in parallel processing activities.

® Imperative: Computations occur as changes to program state. This style is most
used for manipulating data structures.

® Object-oriented: This is the style commonly used with other languages to simplify
the coding environment by using objects to model the real world. Python doesn't
fully implement this coding style because it doesn't support features like data hid-
ing, but you can still use this approach to a significant degree. You see this style
used later in the book.

® Procedural: All the code you've written so far (and much of the initial code in this
book) is procedural, meaning that tasks proceed a step at a time. This style is most
used for iteration, sequencing, selection, and modularization. It's the simplest form
of coding you can use.

Even though this book doesn't cover all these coding styles (and others that Python sup-
ports), it's useful to know that you aren't trapped using a particular coding style.
Because Python supports multiple coding styles and you can mix and match those
styles in a single application, you have the advantage of being able to use Python in the
manner that works best for a particular need. You can read more about the coding
styles athttps://newrelic.com/blog/nerd-1life/python-programming-styles.

Getting Python's Help

Python is a computer language, not a human language. As a result, you won’t
speak it fluently at first. If you think about it for a moment, it makes sense that
you won’t speak Python fluently (and as with most human languages, you won'’t
know every command even after you do become fluent). Having to discover Python
commands a little at a time is the same thing that happens when you learn to
speak another human language. If you normally speak English and try to say
something in German, you find that you must have some sort of guide to help you
along. Otherwise, anything you say is gibberish and people will look at you quite
oddly. Even if you manage to say something that makes sense, it may not be what
you want. You might go to a restaurant and order hot hubcaps for dinner when
what you really wanted was a steak.
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Likewise, when you try to speak Python, you need a guide to help you. Fortunately,
Python is quite accommodating and provides immediate help to keep you from
ordering something you really don’t want. The help provided inside Python works
at two levels:

3 Help mode, in which you can browse the available commands

3 Direct help, in which you ask about a specific command

There isn’t a correct way to use help — just the method that works best for you at
a particular time. The following sections describe how to obtain help.

Entering into help mode

One of the ways in which Jupyter Notebook excels over Google Colab is that Jupy-
ter Notebook provides a good language reference as part of the Help menu. In fact,
you can also find references for NumPy, SciPy, MatPlotLib, SymPy, and pandas.
However, it’s also important to realize that you have access to other forms of help
that are supported by both Jupyter Notebook and Colab in the form of the four
commands shown in the following list:

¥ copyright()
¥ credits()
¥ license()

¥ help()

All four commands provide you with help, of a sort, about Python. For example,
the copyright() command tells you about who holds the right to copy, license, or
otherwise distribute Python. The credits() command tells you who put Python
together. The license() command describes the usage agreement between you
and the copyright holder. Unlike copyright() and credits(), license() requires
that you either press Enter to obtain more licensing information or type q and
press Enter to exit the licensing screen, as shown in Figure 3-2, when working
with Colab. (Jupyter Notebook simply prints the following: See https://www.
python.org/psf/license/.) Notice that the Run Cell icon to the left of the cell
continues to remain active as long as there is more licensing information to see.

The command you most want to know about is simply help(). To enter help
mode, type help() and click Run Cell. Notice that you must include the parentheses
after the command. Every Python command has parentheses associated with it.
After you enter this command, Python goes into help mode and you see a display
similar to the one shown in Figure 3-3.
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[1] copyright()

Copyright (c) 2001-2022 Python Software Foundation.
All Rights Reserved.

Copyright (c) 2068 BeOpen.com.
All Rights Reserved.

Copyright (c) 1995-2801 Corporation for Mational Research Initiatives.
All Rights Reservad.

Copyright (c) 1291-1995 sStichting Mathematisch Centrum, Amsterdam.
All Rights Reserved.
° credits()

C» Thanks to CWI, CMRI, BeOpen.com, Zope Corporation and & cast of thousands
for supporting Python development. See www.python.org for more information.

O nicense0)

A. HISTORY OF THE SOFTWARE

Python was created in the early 1998s by Guido van Rossum at Stichting
Mathematisch Centrum (CWI, see http: .cwi.nl) in the Netherlands
&8s a successor of a language called ABC. Guido remains Python's
principal author, although it includes many contributions from others.

In 1995, Guido continued his work on Python at the Corporation for
National Research Initiatives (CMNRI, see htip:/ t.cnri.reston.va.us)
in Reston, Virginia where he released several versions of the
software.

In May 208@, Guido and the Python core development team moved to
BeOpen.com to form the BeOpen PythonlLabs team. In October of the same
year, the Pythonlabs team moved to Digital Creations, which became
Zope Corporation. In 2081, the Python Software Foundation (PSF, see

FIGURE 3-2: https://www.python.org/psf/) was formed, a non-profit organization
created specifically to own Python-related Intellectual Property.
Some commands Zope Corporation was a sponsoring member of the PSF.
. require further All Python releases are Open Source (see http://www.opensource.org for
input from you to the Open Source Definition). Historically, mest, but not all, Python
Complete. Hit Return for more, or g (and Return) to quit:
@ thelp()
Welcome to Python 3.7's help utility!
If this is your first time using Python, you should definitely check out
the tutorial on the Internet at https://docs.python.org/3.7/tutorial/.
Enter the name of any module, keyword, or topic to get help on writing
Python programs and using Python modules. To quit this help utility and
return to the interpreter, just type "quit”.
FIGURE 3-3: To get a list of available modules, keywords, symbols, or topics, type
You ask PythOn "modules”, "keywords", "symbols", or "topics". Each module alsoc comes
b t th with a one-line summary of what it does; to list the modules whose name
about other or summary contain a given string such as "spam", type "modules spam”.
commands in -
N —
help mode.
You can always tell that you’re in help mode by the help> prompt that you see in
the cell and that the Run Cell icon remains active. As long as you see the help>
prompt, you know that you’re in help mode.
REMEMBER
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FIGURE 3-4:

The topics help

topic provides
you with a

starting point for

48

your Python
adventure.

REMEMBER

Asking for help

To obtain help, you need to know what question to ask. The initial help message
that you see when you go into help mode (refer to Figure 3-3) provides some help-
ful tips about the kinds of questions you can ask. If you want to explore Python,
the four basic topics are

¥ modules
¥ keywords
¥ symbols

¥» topics

The first two topics won’t tell you much for now. You won’t need the modules
topic until Chapter 11. The keywords topic will begin proving useful in Chapter 5.
However, the symbols and topics keywords are already useful because they help
you understand where to begin your Python adventure. When you type symbols
and press Enter, you see a list of symbols used in Python. To see what topics are
available, type topics and press Enter. You see a list of topics similar to those
shown in Figure 3-4.

help> topics

Here is a list of available topics. Enter any topic name to get more help.
ASSERTION DELETION LOOPING SHIFTING
ASSIGNMENT DICTIONARIES MAPPINGMETHODS SLICINGS
ATTRIBUTEMETHODS DICTIONARYLITERALS MAPPINGS SPECTALATTRIBUTES
ATTRIBUTES DYMAMICFEATURES METHODS SPECIALIDENTIFIERS
AUGMENTEDASSIGNMENT ELLIPSIS MODULES SPECTALMETHODS
BASICMETHODS EXCEPTIONS NAMESPACES STRINGMETHODS
BINARY EXECUTION NONE STRINGS

BITWISE EXPRESSIONS NUMBERMETHODS SUBSCRIPTS
BOOLEAN FLOAT NUMBERS TRACEBACKS
CALLABLEMETHODS FORMATTING OBJECTS TRUTHVALUE
CALLS FRAMEOBIECTS OPERATORS TUPLELITERALS
CLASSES FRAMES PACKAGES TUPLES
CODEOBJIECTS FUNCTIONS POWER TYPEOBJECTS
COMPARTISON IDENTIFIERS PRECEDENCE TYPES

COMPLEX IMPORTING PRIVATENAMES UMNARY
CONDITIONAL INTEGER RETURNING UNICODE
CONTEXTMANAGERS LISTLITERALS SCOPING

CONVERSIONS LISTS SEQUENCEMETHODS

DEBUGGING LITERALS SEQUENCES

e —

Chapter 7 begins the discussion of symbols when you explore the use of operators
in Python. When you see a topic that you like, such as FUNCTIONS, simply type that
topic and press Enter. To see how this works, type FUNCTIONS and press Enter
(yvou must type the word in uppercase — don’t worry, Python won’t think you’re
shouting). You see help information similar to that shown in Figure 3-5.
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FIGURE 3-5:

You must use
uppercase when
requesting topic
information.

FIGURE 3-6:
Request
command help
information by
typing the
command using
whatever case it
actually uses.
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help> FUNCTIONS
Functi

Function objects are created by function definitions. The only
operation on a function object is to call it: "func(argument-list)”.

There are really two flavors of function objects: built-in functions
and user-defined functions. Both support the same operation (to call
the function), but the implementation is different, hence the
different object types.

See Function definitions for more information.

Related help topics: def, TYPES

As you work through examples in the book, you use commands that look interest-
ing, and you might want more information about them. For example, in the “See-
ing the result” section of this chapter, you use the print() command. To see
more information about the print() command, type print and press Enter (notice
that you don’t include the parentheses this time because you’re requesting help
about print(), not actually using the command). Figure 3-6 shows typical help
information for the print() command.

help> print
Help on built-in function print in module builtins:

print(...)
print(value, ..., sep=" ", end="\n", file=sys.stdout, flush=False)

Prints the values to a stream, or to sys.stdout by default

Optional keyword arguments:

file: a file-like object (stream); defaults to the current sys.stdout.
sep: string inserted between values, default a space.

end: string appended after the last value, default a mewline.

flush: whether to forcibly flush the stream.

Y S—

Unfortunately, reading the help information probably doesn’t help much yet
because you need to know more about Python. However, you can ask for more
information. For example, you might wonder what sys.stdout means — and the
help topic certainly doesn’t tell you anything about it. Type sys.stdout and press
Enter. You see the help information shown in Figure 3-7.

You may still not find the information as helpful as you need, but at least you
know a little more. In this case, help has a lot to say and it can’t all fit on one
screen (Figure 3-7 is a truncated view). To see more of the information, you’ll
need to scroll up or down in the cell.

CHAPTER 3 Interacting with Python 49



FIGURE 3-7:
You can ask for
help on the help
you receive.

FIGURE 3-8:

Exit help mode by
pressing Enter
without typing
anything.

helpr sys.stdout
Help on QutStream in sys object:

sys.stdout = class OutStream(io.TextIOBase)
sys.stdout{session, pub_thread, name, pipe=None, echo=None)

A file like object that publishes the stream to a @MQ PUB socket.
Output is handed off to an IO Thread

Method resolution order:
Qutstream
io.TextIOBase
_io._TextIOBase
io.IOBase
_io._IOBase
builtins.object

Methods defined here:

_ init_ (self, session, pub_thread, name, pipe=None, echo=None)
Initialize self. See help(type(self)) for accurate signature.

close(self)
Flush and close the 10 object.

This method has no effect if the file is already closed.

Leaving help mode

At some point, you need to leave help mode to perform useful work. All you have
to do is press Enter without typing anything. When you press Enter, you see a
message about leaving help, and then the Run Cell icon changes to the standard
Python prompt, as shown in Figure 3-8.

help>

You are now leaving help and returning to the Python interpreter.

If you want to ask for help on a particular object directly from the
interpreter, you can type "help(object)”. Executing "help('string")"”
has the same effect as typing a particular string at the help> prompt.

Obtaining help directly

Entering help mode isn’t necessary unless you want to browse, which is always a
good idea, or unless you don’t actually know what you need to find. If you have a
good idea of what you need, all you need to do is ask for help directly (a really nice
thing for Python to do). So, instead of fiddling with help mode, you simply type
the word help, followed by a left parenthesis and single quote, whatever you want
to find, another single quote, and the right parenthesis. For example, if you want
to know more about the print() command, you type help(‘print’) and click Run
Cell. Figure 3-9 shows typical output when you access help this way.

You can browse directly within a cell, too. For example, when you type help(‘topics’)
and press Enter, you see a list of topics like the one that appears in Figure 3-10.
You can compare this list with the one shown in Figure 3-4. The two lists are

50 PART 1 Getting Started with Python



FIGURE 3-9:
Python lets you
obtain help
whenever you
need it without
leaving the
Python prompt.

FIGURE 3-10:
You can browse
at the Python
prompt if you
really want to.
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identical, even though you typed one while in help mode and the other while at the
Python prompt.

help{'print")
Help on built-in function print in module builtins

print(...)

print(value, ..., sep=" ", end="\n", file=sys.stdout, flush=False)
Prints the values to a stream, or to sys.stdout by default.
Optional keyword arguments:

file: a file-like object (stream); defaults to the current sys.stdout.
sep: string inserted between values, default a space.
end: ring appended after the last value, default a newline.

flush: whether to forcibly flush the stream.

help(‘topics")

Here is a list of available topics. Enter any topic name to get more help.

ASSERTION DELETION LOOPING SHIFTING
ASSIGNMENT DICTIONARIES MAPPINGMETHODS SLICINGS
ATTRIBUTEMETHODS DICTIONARYLITERALS MAPPINGS SPECTALATTRIBUTES
ATTRIBUTES DYNAMICFEATURES METHODS SPECIALIDENTIFIERS
AUGMENTEDASSIGMMENT ELLIPSIS MODULES SPECIALMETHODS
BASICMETHODS EXCEPTIONS NAMESPACES STRINGMETHODS
BINARY EXECUTION NOME STRINGS

BITWISE EXPRESSIONS NUMBERMETHODS SUBSCRIPTS
BOOLEAN FLOAT NUMBERS TRACEBACKS
CALLABLEMETHODS FORMATTING 0BJECTS TRUTHVALUE

CALLS FRAMEOBJIECTS OPERATORS TUPLELITERALS
CLASSES FRAMES PACKAGES TUPLES
CODEOBIECTS FUNCTIONS POWER TYPEOBJECTS
COMPARISON IDENTIFIERS PRECEDENCE TYPES

COMPLEX IMPORTING PRIVATEMAMES UNARY

CONDITIONAL INTEGER RETURNING UNICODE
CONTEXTMANAGERS LISTLITERALS SCOPING

CONVERSIONS LISTS SEQUENCEMETHODS

DEBUGGING LITERALS SEQUENCES

You might wonder why Python has a help mode at all if you can get the same
results directly as a cell command. The answer is convenience. It’s easier to browse
in the help mode. In addition, even though you don’t do a lot of extra typing as a
separate cell command, you do perform less typing while in help mode. Help mode
also provides additional helps, such as by listing topics that you can type, as
shown previously in Figure 3-4. So you have all kinds of good reasons to enter
help mode when you plan to ask Python a lot of help questions.

No matter where you ask for help, you need to observe the correct capitalization
of help topics. For example, if you want general information about functions, you
must type help(‘FUNCTIONS’) and not help( 'Functions') or help( ' functions').
When you use the wrong capitalization, Python will tell you that it doesn’t know
what you mean or that it couldn’t find the help topic. It won’t know to tell you that
you used the wrong capitalization. Someday computers will know what you meant
to type, rather than what you did type, but that hasn’t happened yet.
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The help feature in Python offers an overview of the various functions and objects
found in an application. However, you often need to know more than what help
provides. In this case, you can use a type of alternative approach to help as
described in the following sections.

Yelling “Hello There” doesn’t help:
Use dir() instead

There is a need to determine the details of what an application requires without
expending a lot of effort. Of course, you could try simply asking, starting with
“Hello There!” as a form of greeting, but extensive testing shows that speaking to
your computer won’t work. The dir() function gives you a means of discovering
new things about functions and objects in Python. It also provides more informa-
tion in some respects to using help() and is more flexible to boot. Using the dir ()
function by itself displays a listing of functions, classes, and objects that are cur-
rently available and are similar to this list (your list could vary depending on what
you have loaded into Python):

["In', 'Out', '_', '__', '___', '__builtin__',
'__builtins__"', '__doc__', '__loader__', '__name__',
'__package__', '__spec__', '_dh', '_i', '_i1', '_ih"',
'_ii', '_iii', '_oh', '_sh', ‘'exit', 'get_ipython',
'quit']

Note that this list is reformatted into horizontal form to save space in the book.
You’ll actually see it in a vertical format that can be a little hard to read.

As you import packages, classes, and functions and execute code, the list will
change to reflect the new additions. For example, when you execute the following
code:

myNum = 2056
dir (myNum)

you see a list of the functions you can use with myNum, as shown here:

["__abs__', '__add__', '__and__', '__bool__",
_ceil__', '__class__', '__delattr__', '__dir__"',
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__divmod__"', '__doc__', '__eq__', '__float

— 7

'__floor__', '__floordiv__', '__format__',6 '__ge__',
'__getattribute__', '__getnewargs__', '__gt__"',
'__hash__', '__index__', '__init__",
'__init_subclass__', '__int__', '__invert__', '__le__"',
'_lshift__', '__1t__', '__mod__', '__mul__', '__ne__"',
'__neg__', '__new__', '__or__', '__pos__', '__pow__"',
'__radd__', '__rand__', '__rdivmod__', '__reduce__',

' __reduce_ex__', '__repr__', '__rfloordiv__",
'__rlshift__', '__rmod__', '__rmul__', '__ror__"',
'__round__', '__rpow__', '__rrshift__', '__rshift__"',
'__rsub__', '__rtruediv__', '__rxor__', '__setattr__',
' __sizeof__', '__str__', '__sub__"', '__subclasshook__",
'__truediv__', '__trunc__', '__xor__"',
'as_integer_ratio', 'bit_length', 'conjugate',
'denominator', 'from_bytes', 'imag', 'numerator',

'real', 'to_bytes']

That’s quite a list of things you can do with myNum! What this list tells you is the
details about myNum, an object that you created. So, you could type myNum.bit__
length() and press Enter to see that the bit length for this particular variable is 12.
Using dir() can help jog your memory or make you aware of new features you
might not have known about.

What are those double underscores
all about?

Python lacks the concept of private variables, classes, functions, and so on. Some
developers feel that this makes the object-oriented programming (OOP) features
in Python incomplete (see https://www.geeksforgeeks.org/data-hiding-in-
python/ for a conversation about the topic). The creator of Python, Guido van
Rossum, put it this way, “We are all adults. Feel free to shoot yourself in the foot
if you must.” So, Python lacks true data hiding and the benefits and problems that
data hiding provides. What it has instead is double underlines (__), which indi-
cates that the member is private and you shouldn’t use it, but many developers do

anyway.

Some Python implementations enforce the double underline as private, even
though this functionality isn’t part of the specification. For example, myNum. __
eq__(2056) returns True if myNum actually does contain the value 2056, but the
__eq__() function is listed as private so what you should use in your code instead
ismyNum == 2056.
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Drilling, drilling, drilling down into classes

In any OOP implementation, classes inherit from other classes, so you end up with
an object hierarchy. Drilling down into this hierarchy can tell you a lot about how
to interact with Python objects in ways that you might not have considered in the
past. For example, when working with myNum, you can use the myNum. to_bytes(4,
byteorder = 'big') call to display myNum as a series of bytes: b' \x00\x00\x08\
x08'. The output is another object. Consequently, you can use dir(myNum.to_
bytes(4, byteorder = 'big')) call to find out more about how you can use this
new object:

['__add__', '__class__', '__contains__', '__delattr__',
'__dir__', '__doc__', '__eq__', '__format__', '__ge__"',
'__getattribute__', '__getitem__', '__getnewargs__"',
'__gt__', '"__hash__"', '__init__', '__init_subclass__"',
'__iter__', '__le__', '__len__"', '__1t__', '__mod__"',
' mul__', '__ne__', '__new__"', '__reduce__",

' __reduce_ex__', '__repr__', '__rmod__', '__rmul__",
'__setattr__', '__sizeof_ _', '__str__',
'__subclasshook__"', 'capitalize', 'center', 'count',
'decode', 'endswith', 'expandtabs', 'find', 'fromhex',
'hex', 'index',6 'isalnum', 'isalpha', 'isascii',
'isdigit', 'islower',6 'isspace',6 'istitle',6 'isupper',
'join', 'ljust', 'lower',6 'lstrip',6 'maketrans',
'partition', 'replace', 'rfind', 'rindex', 'rjust',
'rpartition', 'rsplit', 'rstrip', 'split’',
'splitlines', 'startswith', 'strip', 'swapcase',

'title', 'translate', 'upper', 'zfill']

0ddly enough, you can replace some of the bytes in the value with different bytes
using myNum.to_bytes(4, byteorder = 'big').replace(b'\x@0', b'\x01'),
which provides an output of: b'\x01\x01\x08\x08'. However, you might not
have known you could do this without drilling down into the original myNum object
using dir().

If you really want to get fancy, you can start combining bits of knowledge you
obtain while drilling down into objects. For example, myNum. from_bytes (myNum.
to_bytes(4, byteorder = 'big').replace(b'\x00', b'\x01'), 'big') pro-
duces a new myNum value of 16844808. That’s a really large number, but it also
shows that you can work with Python to produce a wide assortment of interesting
effects just by playing with dir().
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The inspect module (see https://docs.python.org/3/library/inspect.html)
allows you to get even more in depth than the dir() function by playing the role
of a detective. You can query any object, class, or variable about its details in a
detailed manner. The following sections give you the briefest overview of what
you can do because this module can become really involved. As with all tools, you
need to spend time with inspect before you become proficient at using it.

Gaining access to inspect

The inspect module isn’t included with the standard Python setup, so you must
import it into the environment so that you can use it by adding the following line
of code:

import inspect

This code imports the entire inspect module. If you want to use a limited number
of features, you can also use other Python methods of importation, such as

from inspect import isfunction

Instead of importing everything, this approach imports just the isfunction()
method.

Using inspect

There are a lot of different ways to use inspect. For example, you can use it to ask
direct questions such as inspect. ismodule(inspect ), which returns True because
inspect is a module. It’s also possible to use inspect on any object, including those
you create. The query inspect . getmembers(myNum) returns a considerable amount
of information, as shown here (in part; the actual list is much longer):

[("__abs__"', <method-wrapper '__abs__' of int object at
0xT7fT71e52ea4b0> ),
('__add__"', <method-wrapper '__add__' of int object at

0xT7fT71e52ea4b0> ),
('__and__', <method-wrapper
0xT7fT71e52ea4b0> ),

1

__and__"' of int object at

('__bool__"', <method-wrapper '__bool__' of int object
at OxT7fT71e52ea4b0> ),

("__ceil__', <function int.__ceil__»>),

('__class__', int),
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('__delattr__",
<method-wrapper '__delattr__' of int object at

0x7f71e52ea4b0> ),
('__dir__', <function int.__dir__>),
('__divmod__"', <method-wrapper '__divmod__' of int

object at 0x7f71e52eadb0>),

('bit_length', <function int.bit_length>),
('conjugate', <function int.conjugate>),
('denominator', 1),

('from_bytes', <function int.from_bytes>),
('imag', @),

("numerator', 2056),

('real', 2056),

('to_bytes', <function int.to_bytes>)]

Most of the added information tells you what a particular member is, such as a
method or a function. In some cases, you also get the member value. For example,
the denominator () function output is1.

It may take some time for you to go through all the inspect features, but it’s
worth the effort. For example, you can quickly check whether a function is built in.
A call to inspect.isbuiltin(dir) returns True because the dir() function is
part of the default Python functionality.

Is reflection really like looking in a mirror?

The process used by the inspect module to obtain detailed information about
your code is called reflection, but it has nothing to do with looking in a mirror.
Instead, reflection looks back through the compiled code in an effort to recon-
struct the original element information. Another term, introspection, means essen-
tially the same thing when it comes to viewing code, and some people would say
that the inspect module performs introspection.

In addition to viewing element information, reflection can also allow you to mod-
ify the underlying objects, but this is an extremely advanced technique that most
developers don’t really need. For the purposes of this book, looking back through
code to find out more about it is called reflection, just to keep things simple (and to
keep the terminology on par with what other languages use). You can discover
more about the differences between introspection and reflection at https://
betterprogramming.pub/python-reflection-and-introspection-
97b348be54d8 and see some advanced used of reflection at https://www.
geeksforgeeks.org/reflection-in-python/.
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Chapter 4

Writing Your First
Application

any people view application development as some sort of magic prac-
ticed by wizards called geeks who wave their keyboard to produce soft-
ware both great and small. However, the truth is a lot more mundane.

Application development follows a number of processes. It’s more than a strict
procedure, but is most definitely not magic of any sort. As Arthur C. Clark once
noted, “Any sufficiently advanced technology is indistinguishable from magic.”
This chapter is all about removing the magic from the picture and introducing you
to the technology. By the time you’re finished with this chapter, you, too, will be
able to develop a simple application (and you won’t use magic to do it).

As with any other task, people use tools to write applications. In the case of
Python, you don’t have to use a tool, but using a tool makes the task so much
easier that you really will want to use one. In this chapter, you use a commonly
available Integrated Development Environment (IDE) named Google Colab (dis-
cussed in Chapter 2). An IDE is a special kind of application that makes writing,
testing, and debugging code significantly easier. You can also use Jupyter Note-
book for desktop development, which appears as part of the Anaconda tool collec-
tion (https://www.anaconda.com/products/distribution) or you can get
Jupyter Notebook as a separate download at https://jupyter.org/install.
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A vast number of other tools are available for you to use when writing
Python applications. This book doesn’t tell you much about them because Conda (a
command-line tool provided with Jupyter Notebook) performs every task needed
and it’s readily available free of charge. However, as your skills increase, you might
find the features in other tools such as Komodo Edit (https://www.activestate.
com/products/komodo-ide/downloads/edit/) more to your liking. You can
find a great list of these tools at https://wiki.python.org/moin/Integrated
DevelopmentEnvironments.

You don’t have to type the source code for this chapter manually. In fact, using the
downloadable source is a lot easier. You can find the source for this chapter in the
BPP4D3E; ©4; Comments.ipynb,BPP4D3E; ©4; Indentation.ipynb, and BPP4D3E;
@4; Sample.ipynb files of the downloadable source. See the Introduction for
details on how to find these source files.

Understanding Why IDEs Are Important
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A good question to ask is, why do you need an IDE to work with Python? It does
come with a command-line tool that you can open by typing python and pressing
Enter at a command line or terminal window for desktop setups. (You can make
things easier by ensuring that the folder in which Python is installed appears as
part of your system’s PATH environment variable or by installing Anaconda, which
comes with its own Anaconda prompt.) For that matter, Python actually comes
with a limited IDE called Integrated Development and Learning Environment
(IDLE) that appears in the Lib\idlelib folder of your Python installation (again,
for desktop setups, but please, no more email about just how dead the desktop
really is; I get it). Many people probably question the need for anything more dur-
ing the learning process and possibly to develop full-fledged applications.

Unfortunately, the tools that come with Python are interesting and even helpful in
getting started, but they won’t help you create useful applications with any ease.
In addition, accessing these tools means creating a desktop setup that may not
provide the flexibility you require because now you can’t program on your tablet
(or smart phone, if you’re really adept). If you choose to work with Python long
term, you really need a better tool for the reasons described in the following
sections.

Creating better code

A good IDE contains a certain amount of intelligence. For example, the IDE can
suggest alternatives when you type the incorrect keyword, or it can tell you that a
certain line of code simply won’t work as written. The more intelligence that an
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IDE contains, the less hard you have to work to write better code. Writing better
code is essential because no one wants to spend hours looking for errors,
called bugs.

IDEs vary greatly in the level and kind of intelligence they provide, which is why
so many IDEs exist. You may find the level of help obtained from one IDE to be
insufficient to your needs, but another IDE hovers over you like a mother hen.
Every developer has different needs and, therefore, different IDE requirements.
The point is to obtain an IDE that helps you write clean, efficient code quickly and
easily.

Debugging functionality

Finding bugs (errors) in your code is a process called debugging. Even the most
expert developer in the world spends time debugging. Writing perfect code on the
first pass is nearly impossible, especially when squinting to see the text on your
smart phone. When you do, it’s cause for celebration because it won’t happen
often. Consequently, the debugging capabilities of your IDE are critical. Unfortu-
nately, the debugging capabilities of the native Python tools are almost nonexis-
tent. If you spend any time at all debugging, you quickly find the native tools
annoying because of what they don’t tell you about your code.

The best IDEs double as training tools. Given enough features, an IDE can help you
explore code written by true experts. Tracing through applications using a debug-
ger is a time-honored method of learning new skills and honing the skills you
already possess. A seemingly small advance in knowledge can often become a
huge savings in time later. When looking for an IDE, don’t just look at debugging
features as a means to remove errors — see them also as a means to learn new
things about Python.

Defining why notebooks are useful

Most IDEs look like fancy text editors, and that’s precisely what they are. Yes, you
get all sorts of intelligent features, hints, tips, code coloring, and so on, but at the
end of the day, they’re all text editors. There’s nothing wrong with text editors,
and this chapter isn’t telling you anything of the sort. However, given that Python
developers often focus on scientific applications that require something better
than pure text presentation, using notebooks instead can be helpful.

A notebook differs from a text editor in that it focuses on a technique advanced by
Stanford computer scientist Donald Knuth called literate programming. You use
literate programming to create a kind of presentation of code, notes, math equa-
tions, and graphics. In short, you wind up with a scientist’s notebook full of
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everything needed to understand the code completely. You commonly see literate
programming techniques used in high-priced packages such as Mathematica and
MATLAB (see MATLAB For Dummies, 2nd Edition, by John Paul Mueller and Jim
Sizemore [Wiley] for details). Notebook development excels at

3 Demonstration

3 Collaboration

¥ Research

¥ Teaching objectives

¥ Presentation

This book uses Colab and Jupyter Notebook because these IDEs provide you with a
great Python coding experience, as well as help you discover the enormous poten-
tial of literate programming techniques. If you spend a lot of time performing
scientific tasks, Colab and products like it are essential. In addition, both Colab
and Jupyter Notebook are free, so you get the benefits of the literate programming
style without the cost of other packages.

When working through this book, you see Colab used to reference Google Colab
specifically, Jupyter Notebook used to reference Jupyter Notebook specifically, and
Notebook (by itself) to refer to both Colab and Jupyter Notebook generically. There
are differences between the two products that you need to know about, and the
book points them out for you.

Creating the Application

60

You’ve actually created your first Python application by using the steps in the
“Seeing the result” section of Chapter 3. The print() method may not seem like
much, but you use it quite often. However, the literate programming approach
provided by Colab requires a little more knowledge than you currently have. The
following sections don’t tell you everything about this approach, but they do help
you gain an understanding of what literate programming can provide in the way
of functionality. However, before you begin, make sure you have the BPP4D3E;
04; Sample.ipynb file open for use because you need it to explore Notebook.

Developing the code

Real applications do something more than print a message using the print()
method. Starting with Part 2 of the book, you develop the skills required to do
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something really interesting. For now though, it’s time to do something a little
better than just printing a message, even if you don’t quite understand everything
that the code does. (You definitely will later in the book.) Create a new notebook
(see the “Creating a new notebook” section of Chapter 2 if you need some help in
this regard) and type the following code into a code cell:

def addSomething(valuel, value2):
return valuel + value2

print(addSomething(1, 2))

When you click the Run Cell icon (or click the Run button in Jupyter Notebook),
you see the result of 3 magically appear. Of course, the delight in seeing code that
you typed run is momentary. A second impression might be that this is an interest-
ing group of gibberish letters that really don’t mean much to most humans. So it’s
a good time to break this code down a little and add comments to it so that you can
remember what it does. Add the following comments (in bold), as shown here:

# Define a function to encapsulate task code that accepts
# two pieces of information in boxes called variables

# named valuel and value2.

def addSomething(valuel, value2):

# Add the two values together and return the result
# to the caller.
return valuel + value2

# Call the addSomething() function with two numbers to
# add and then use print() to display the result.
print(addSomething(1, 2))

Comments always begin with a hashtag (x) so that the Python interpreter doesn’t
mistake them for code. It’s amazing what a difference a few comments can make.
Of course, you still might not understand the code completely, but you have a bet-
ter idea of how it works, which is why you always comment your code.

Adding documentation cells

Cells come in a number of different forms. This book doesn’t use them all. How-
ever, knowing how to use the documentation cells can come in handy. Select the
first cell (the one with the code you just created in it). Click the +Text button in
Colab or choose Insert = Insert Cell Above in Jupyter Notebook. You see a new cell
added to the notebook. (When working with Jupyter Notebook, you need to select
Markdown from the drop-down list that currently contains Code in it.) Type #
Creating the Application because this is the parent heading for this section. The
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symbol is called markup, which is a method of telling Notebook how to format text
(the “Working with text cells” section of the chapter talks about using markup in
more detail). Select the next cell in Colab or click Run in Jupyter Notebook. You see
the text change into a heading. Click the Move Cell Up button in Colab as needed
to place the heading correctly, as shown in Figure 4-1.

- - . v = ] X
€O BPPAD3E: 04 Sampleipynb - Co' X [
&« C Y & htips//colabresearch.google.com/drive/1vaWT... & & ¥r » 0O 0 :
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(] a function to encapsulate task code that accepts
of information in boxes called variables
el and value2.

hing(valuel, value2):
# Add the two values together and return the result
# to the caller.
return valuel + value2
# Call the addSomething() function with twe numbers to
<> # add and then use print() to display the result.

print(addSomething(l, 2))

3

« 0 completed at 10:36 AM ® X

About now, you may be thinking that these special cells act just like HTML pages,
and you’d be right. Use the same process you did for adding the first heading to
add a second heading by typing ## Developing the code. As you can see in
Figure 4-2, the number of hashes (#) you add to the text affects the heading level,
but the hashes don’t show up in the actual heading.

Notice that you have also documented precisely where the code appears in the
book. The other source code examples in the book follow this same strategy so
that you can easily match the source code to the section that describes it.

Other cell content

This chapter (and book) doesn’t demonstrate all the kinds of cell content that you
can see by using Colab and Jupyter Notebook. However, you can add things like
graphics to your notebooks, too. When the time comes, you can output (print)
your notebook as a report and use it in presentations of all sorts. The literate pro-
gramming technique is different from what you may have used in the past, but it
has definite advantages, as you see in upcoming chapters.
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FIGURE 4-2:
Using heading
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emphasis for cell
content.

FIGURE 4-3:

A scratch cell
provides a place
to experiment
and run shell
commands.
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Playing around with scratch cells

There are times when you want to experiment without making code a part of your
main application. You may also need to access a shell while working with Colab.
For example, the Linux 1ls command (https://linuxize.com/post/how-to-
list-files-in-linux-using-the-ls-command/) displays a list of files and
directories found in the location where you’re executing the Colab code. In this
case, you can create a scratch cell, like the one shown in Figure 4-3, by choosing
Insert«> Scratch Code Cell. This feature is available only in Colab and not in Jupyter

Notebook.

Scratch cell X

° print(1 + 2)

3

Clicking the ellipsis in the upper-right corner displays tasks you can perform with

the scratch cell. Here are some of the most important options:

3> Copy Cell: Copies the cell contents to the Clipboard where you can paste the

information to another application.
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TIP

WARNING

¥ Clear Output: Clears the cell output before you run the scratch code again.

3 View Output Fullscreen: Displays the cell data full screen so that you can
see all of it at one time outside the Colab panes. Press Esc to exit the
full-screen mode.

3 Move Tab to Next Pane: Places the scratch cell in the next available pane.
Normally, a scratch cell opens in its own pane, which may take up too much
screen real estate in some cases.

3 Move Tab to Previous Pane: Places the scratch cell in the previous pane,
which may be the pane originally used to hold it.

¥ Close Tab: Closes the selected scratch cell tab without affecting any other
tabs.

¥ Close All Tabs: Closes all the scratch cell tabs without affecting any other
Colab cells. Note that you may also see options for closing all the tabs to the
left of the current tab and all the tabs to the right of the current tab.

3 Change Page Layout: Determines the appearance of Colab with regard to
scratch cells. The default is to use two columns, but you can also use a single
column view where the scratch cell tabs appear across the top with a separate
tab labeled Notebook that holds your code. It's also possible to place the
scratch cells below the last line in the current Notebook pane.

You can have more than one scratch cell at a time. Every time you choose
Insert=> Scratch Code Cell, Colab creates another scratch cell tab for you. You can
close the tabs in any order desired.

Interacting with form fields

Form fields let the user enter values that a program can then use as input. Just as
Jupyter Notebook doesn’t provide scratch cells, it also doesn’t provide access to
form fields. So even though adding form fields to your Colab notebook won’t pre-
vent the code from also running in Jupyter Notebook, you also won’t see the func-
tionality that form fields provide in Jupyter Notebook.

Using form fields adds the potential for incompatibility to your notebooks. Unless
you have a good reason to add GUI elements to your notebook, it’s usually best to
skip the form fields and use standard Python data-entry methods instead, like the
input () function shown here:

name = input("Type your name: ")
print(f"Your name is: {name}")
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FIGURE 4-4:

The Add New
Form Field dialog
box allows you to
add GUI inputs to
your notebook.

TIP

Choosing a form field type

If you do decide to use form fields in your program, you choose Insert> Add A
Form Field. You see the Add New Form Field dialog box, shown in Figure 4-4. The
Form Field Type field contains a list of GUI elements you can add, which include
input, dropdown, slider, and markdown.

Add new form field

Form field type Variable type
input string

Variable name

variable_namg|

Cancel Save

The form field type that you choose determines how the Add New Form Field dia-
log box appears. For example, if you choose dropdown, you need to add a list of
drop-down options. A slider requires that you add minimum and maximum val-
ues, and the size of the steps between values.

The markdown option is interesting because it allows you to add what amounts
to a text cell within a code cell. You type Colab markdown (https://colab.
research.google.com/notebooks/markdown_guide.ipynb) in the Markdown
field. This means that you really can mix code and markdown together to create
a better looking notebook.

Defining the variable type and name

To use a form field, all you need to do is fill in the blanks. Follow these steps for
this example:

1. choose input in the Form Field Type field.

You see the dialog box shown in Figure 4-4.

N

Choose string in the Variable Type field.
3. Type YourName in the Variable Name field; then click Save.

You see the combination of code and GUI presentation shown in Figure 4-5.
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TIP

FIGURE 4-5:
Adding a form
field to your
notebook
displays a
combination of
code and GUI
presentation.

FIGURE 4-6:
Design code to
interact with the
form fields you
create.

REMEMBER

Displaying both code and GUI presentation may seem counterproductive
because you want a nice display for your notebook. To get rid of the code,
choose the ellipsis in the cell toolbar and then select Form => Hide Code from

the menu.
T o8 0
© vourtiame = " #gparan {type:"string”} YourMame:  Insert text here
Using the form field

One of the interesting aspects of form fields is that they exist as part of a code cell,
so you can add code directly below the form field entry to interact with the form
field. Type print(f“Your name is: {YourName}”) directly below the YourName =
"" g@param {type:"string"} entry in the cell. Type your name in the form field,
and you see that the code changes as well. Now, click Run Cell and you see that the
code interacts with the form field as, shown in Figure 4-6.

LR
° Yourtame = "John" #@param {type:"string"} John
print(f"Your name is: {YourName}")

YourName:

Your name is: John

By linking a number of form fields together in the same cell, you can create the
appearance of a form used in any other application. The user fills out the form and
clicks Run Cell to see the result. When you hide the code area, the GUI presentation
looks seamless, and because it resides in a notebook, you have access to the pres-
entation features that a notebook can provide as well.

Running the Application

66

In general, an application consists of the current notebook and any linked
resources. It’s not an application in the traditional sense because you can run it
just one cell at a time, but it does help to view the application as being the entire
notebook.
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TIP

Seeing the result

To this point, you have seen applications run one cell at a time. To see the entire
result without having to click Run Cell in each and every cell like an annoying little
habit that drives sane people a little batty, you can use the following options:

»
»

»

»

»

Runtime => Run All: Runs all the cells without clearing the output first.

Runtime > Run Before: Runs all the cells above the cell that currently has
focus.

Selected cells: Select multiple cells using Shift+Up Arrow or Shift+Down
Arrow; then choose Runtime => Run Selection to run just the selected cells.

Runtime => Run After: Runs all the cells below the cell that currently has
focus.

Runtime > Restart and Run All: Runs all the cells after restarting the
runtime and clearing the output.

The Jupyter Notebook options are similar, but different enough to warrant sepa-
rate coverage.

»

»
»
»
»

»

Selected cells: Select multiple cells using Shift+Down Arrow or Shift+Up
Arrow; then choose Cell = Run Cells to run just the selected cells. You can also
choose Cell = Run Cells and Select Below to run the selected cells and choose
the next cell as the focused cell. If there is no next cell, Jupyter Notebook
creates one for you. Choosing Cell &> Run Cells and Insert Below runs the
selected cells and then inserts a new cell as the focused cell even if there is an
existing cell to use.

When using this method, ensure that you have the cell selected and not the
text within the cell. Jupyter Notebook highlights the selected cells for you in a
light color.

Cell= Run All: Runs all the cells without clearing the output first.

Cell= Run All Above: Runs all the cells above the cell that currently has focus.

Cell= Run All Below: Runs all the cells below the cell that currently has focus.

Kernel ©> Restart & Clear Output: Clears the output from the previous runs
without running the code. This is an important feature if you want to run
just some of the cells without having previous results interfere with the
current test.

Kernel => Restart & Run All: Runs all the cells after restarting the runtime and
clearing the output.
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Viewing the executed code history

It’s helpful to see the history of code that you’ve run while creating an application.
Doing so can help you locate errors in logic or even execution order. Sometimes,
viewing the code history simply reminds you to restart the runtime or kernel
because things have gotten messy with variables dangling about (staying when
you don’t need them any longer) and causing problems. To see the code history in
Colab, choose View=> Executed Code History. Figure 4-7 shows a typical execution
history for the example found in the previous sections.

Executions X

LTIV
[1] # Define a function to encapsulate task code that accepts
y # two pieces of information in boxes called variables

3

043 AM mi b

[2] name = input("Type your name: ")
print(f"Your name is: {name}"}
Type your name: John
Your name is: John

045 AM [ 4
FIGURE 4-7: [3] YourName = "John" #@param {type:"string"}
VieWing the print(f"Your name is: {YourName}")
executed code vour name is: John

history can tell
you a lot about

Type code here to execuie.
your code. °

The top of each entry contains the time that you executed the code. Next to the
time stamp is an icon you can click to copy the code to a scratch cell for further
analysis. The last icon in the time stamp row scrolls the display to the code in
question and selects it so that you don’t have to manually look for it.

At the bottom of the window is a cell where you can try ideas as you browse the
executed code. It acts like a scratch cell, and you use it like any other cell.

TIP

Understanding the Use of Indentation

As you work through the examples in this book, you see that certain lines are
indented. In fact, the examples also provide a fair amount of white space (such as
extra lines between lines of code). The indentation is also functional. Python uses
indentation to define code regions such as code associated with functions and
loops. So, adding indentation is an important part of your Python program.
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FIGURE 4-8:

The Edit window
automatically
indents some
types of text.

The various uses of indentation will become more familiar as you work your way
through the examples in the book. However, you should know at the outset why
indentation is used and how it gets put in place. So it’s time for another example.
The following steps help you create a new example that uses indentation to make
the relationship between application elements a lot more apparent and easier to
figure out later.

1.

Open a new notebook by selecting New Notebook in the Colab notebook
opening dialog box, New => Python3 in Jupyter Notebook, or by choosing
File > New Notebook (optionally choosing the correct notebook type) if
you already have a notebook open.

Colab or Jupyter Notebook creates a new notebook for you.
Type print(“This is a really long line of text that will” +.

You see the text displayed normally onscreen, just as you expect. The plus sign
(+) tells Python that there is additional text to display. (Don't add the period at
the end of the sentence.) Adding text from multiple lines together into a single
long piece of text is called concatenation. You learn more about using this
feature later in the book, so you don't need to worry about it now.

Press Enter.

The insertion point doesn't go back to the beginning of the line, as you might
expect. Instead, it ends up directly under the first double quote, as shown in
Figure 4-8. This feature is called automatic indention and it's one of the
features that differentiates a regular text editor from one designed to

write code.

° print("This is a really long line of text that will " +

P e B g E

Type “appear on multiple lines in the source code file.”) and press Enter.

Notice that the insertion point goes back to the beginning of the line. When
Notebook senses that you have reached the end of the code, it automatically
outdents the text to its original position.

Click Run.

You see the output shown in Figure 4-9. Even though the text appears on
multiple lines in the source code file, it appears on just one line in the output.
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FIGURE 4-9:
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is a really long line of text that will " +
ar on multiple lines in the source code file.™)

This is a really long line of text that will appear on multiple lines in the source code file.

Adding Comments

People create notes for themselves all the time. When you need to buy groceries,
you look through your cabinets, determine what you need, and write it down on a
list or dictate it into your phone. When you get to the store, you review your list to
remember what you need. Using notes comes in handy for all sorts of needs, such
as tracking the course of a conversation between business partners or remember-
ing the essential points of a lecture. Humans need notes to jog their memories.
Comments in source code are just another form of note. You add them to the code
so that you can remember what task the code performs later. The following sec-
tions describe comments in more detail.

Understanding comments

Computers need some special way to determine that the text you’re writing is a
comment, not code to execute. Python provides two methods of defining text as a
comment and not as code. The first method is the single-line comment. It uses
the number sign (#), like this:

# This is a comment.
print("Hello from Python!") #This is also a comment.

HEADINGS VERSUS COMMENTS

You may find headings and comments a bit confusing at first. Headings appear in sepa-
rate cells; comments appear with the source code. They serve different purposes.
Headings serve to tell you about an entire code grouping, and individual comments tell
you about individual code steps or even lines of code. Even though you use both of
them for documentation, each serves a unique purpose. Comments are generally more
detailed than headings.
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FIGURE 4-10:
Multiline
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A single-line comment can appear on a line by itself or it can appear after execut-
able code. It appears on only one line. You typically use a single-line comment for
short descriptive text, such as an explanation of a particular bit of code. Notebook
shows comments in a distinctive color (usually blue or green) and in italics.

Creating multiline comments

Python doesn’t actually support a multiline comment directly, but you can create
one using a triple-quoted string (called a docstring). A multiline comment both
starts and ends with three double quotes (""") or three single quotes (''") like this:

Application: Comments.py
Written by: John
Purpose: Shows how to use comments.

Unlike single-line comments, multiline docstrings used as comments normally
appear in red and in roman type. The interpreter does read them, but you can still
use them for comments. These lines aren’t executed. Python won’t display an
error message when they appear in your code. However, Notebook treats them
differently, as shown in Figure 4-10.

R =-E- TN

° # print("This code won't execute because it's commented out™)
print("This line of code will not execute either.™)

wnprint("This line of code will not execute either.™)\n

Note that the actual Python comments, those preceded by a hash (#) in cell 1,
don’t generate any output. The triple-quote docstrings, however, do generate
output. If you plan to output your notebook as a report, you need to avoid using
triple-quoted docstrings. (Some IDEs, such as IDLE, ignore the triple-quoted
strings completely.)

You can also assign a docstring to a variable, which isn’t possible with a comment.
The code and output shown in Figure 4-11 shows what a docstring looks like as
output when assigned to a variable. Notice that the docstring isn’t printed in this
case because it appears as a variable assignment. The docstring formatting does
remain in place, though, unlike the concatenation example shown in the “Under-
standing the Use of Indentation” section, earlier in this chapter.
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lines.

T loaepa
° myString = ""°

This is a multiline string
that is assigned to myString.

print(myString)

This is a multiline string
that is assigned to myString.

You typically use multiline docstrings for longer explanations of who created an
application, why it was created, and what tasks it performs. Of course, there aren’t
any hard rules on precisely how you use comments. The main goal is to tell the
computer precisely what is and isn’t a comment so that it doesn’t become
confused.

Using comments to leave
yourself reminders

A lot of people don’t really understand comments — they don’t quite know what
to do with notes in code. Keep in mind that you might write a piece of code today
and then not look at it for years. You need notes to jog your memory so that you
remember what task the code performs and why you wrote it. In fact, here are
some common reasons to use comments in your code:

¥ Reminding yourself about what the code does and why you wrote it

¥ Recording who wrote the code when involved in a multiperson project (usually
along with other information, such as how to contact the person)

¥ Telling others how to maintain your code

¥ Making your code accessible to other developers

¥ Listing ideas for future updates

¥ Providing a list of documentation sources you used to write the code

¥ Maintaining a list of improvements you've made

You can use comments in a lot of other ways, too, but these are the most common
ways. Look at the way comments are used in the examples in the book, especially
as you get to later chapters where the code becomes more complex. As your code
becomes more complex, you need to add more comments and make the comments
pertinent to what you need to remember about it.
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FIGURE 4-12:

Use comments to
keep code from
executing.

Using comments to keep
code from executing

Developers also sometimes use the commenting feature to keep lines of code from
executing (referred to as commenting out). You might need to do this in order to
determine whether a line of code is causing your application to fail. As with any
other comment, you can use either single line commenting or multiline com-
menting. However, when using multiline commenting, you do see the code that
isn’t executing as part of the output (and it can actually be helpful to see where
the code affects the output). Figure 4-12 shows an example of code commenting
techniques.
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Making Your Notebook Informative,
Descriptive, and Pretty

FIGURE 4-13:
The text cell

toolbar contains
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a variety of
interesting
options.

After putting a lot of time and effort into creating headings and code for your
notebook, you don’t want to falter at the end and not add the fit and finish items
that will truly make your notebook stand out from any competition. Fortunately,
you don’t need a degree in media to make notebooks interesting and even pretty.
Adding pizzazz does require a little time, but the payoff is worth it when you make
a presentation. The following sections offer some ideas on how to dress your
notebook up.

Working with text cells

So far, you have worked with text cells that contain headings. You’ve also been
exposed to some of the other markup options you can employ in a heading, such
as adding italics. Boring! When you open a text cell in Colab, you see a toolbar
containing all sorts of interesting options, like those found in Figure 4-13.

Vo g X W
T B I < e B

- v @ B

# Adding Comments|

éAdding Comments

Here is what those buttons do:

¥ Toggle Heading: Cycles through the various heading levels so that you can
see how the text appears in various sizes.

¥ Bold: Makes the selected text appear in bold type.
¥ lItalics: Makes the selected text appear in italics type.

¥ Format as Code: Sets the selected text to appear as code rather than regular
text. You can use this option for things like calling syntax or examples of
usage.

¥ Insert Link: Adds a URL to the text cell so that the user can click it and see
other online resources. This is also a handy way to create reference notes for
yourself as you write the code so that you can simply go back to the website
that contains the really good coding idea.
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TIP

FIGURE 4-14:
Use indents to
create nested
lists for your
documentation.

¥ Insert Image: Places an image at the current cursor position, making it
possible to add graphical documentation to your notebook in addition to text.
This is also a dandy way to personalize your notebook so that you can see a
loved one as you type.

¥ Indent: Adds an indent to the current text. You can also use this feature to
create multiple-level bulleted and numbered lists.

3 Add Numbered List: Creates a new numeric list at the current cursor
position.

You can add bulleted sublists to a numeric list and vice versa simply by using
the indent feature. For example, Figure 4-14 shows what a nested list looks
like. Notice the use of the > symbol to increase the indent level. Also notice
that the bullet type changes to make the indent level.

T~ e B X E i
T B I ¢ o M E = = - y @ M=
## vorking with text cells
1. List item  Working with text cells
» ¥ List item !
»> *  Another List Level 1. List item
»» *  Another List Level
>t st item o Listitem
2. List item
= Ancther List Level
= Another List Level
o Listitem
2. List item

3 Add Bulleted List: Creates a new bulleted list at the current cursor position.

3 Add Horizontal Rule: Places a line across the text cell to separate one group
of material from another.

¥ LaTeX: Allows use of LaTeX markup (https://www.latex-project.org/)in
the text cell.

¥ Insert Emoji: Places the selected emoji at the current cursor location. When
you click this option, what you see is a list of standard emojis. Note that emoji
support comes with Colab, but you may have to install it on Jupyter Notebook
as described at https://sawanrai777.medium.com/have-fun-with-
emojis-in-jupyter—-notebook-£74db7£45210. Note that you can copy and
paste emojis from websites and other locations into your code, but place
them within a string to ensure correct interpretation by the IDE.
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notebook.

©

REMEMBER

Adding section headers

A section heading is simply a text cell with a heading already defined in it. You can
promote or demote the section heading level using fewer or more # characters in
front of the heading. The only difference is that Colab does some of the work for
you. Add a new section header to your notebook by choosing Insert= Section
Header Cell.

Interacting with the table of contents

The table of contents is a feature that is supported by Colab and not Jupyter Note-
book. To see the Table of Contents, choose View=> Table of Contents or click the
Table of Contents button on the left toolbar. Figure 4-15 shows typical output.

= Table of contents O x

Q, Adding Comments
Understanding comments
{x}

Creating multiline comments

o Making Your Notebook Informative,
Descriptive, and Pretty

Working with text cells

Adding section headers

To use the Table of Contents, simply click the heading that contains the material
you want to see. The currently selected heading appears in bold so that you know
where you’re currently at in the notebook.

Figure 4-15 points out the need to use separate text cells for each heading level in
your notebook, rather than combine all the headers for a particular area into one
text cell (even though it would look acceptable that way in the document). If you
don’t place each heading level in its own text cell, the feature won’t work as
intended and you’ll get really frustrated trying to make it behave itself.

Renaming a notebook

The notebooks you create should have descriptive names. Otherwise, they become
too difficult to find after you’ve accumulated enough of them. It’s sort of like hav-
ing a closet at home that’s stocked floor to ceiling with unmarked boxes (or worse
yet, boxes that have the wrong content marked on them). The only way to find
something is to take the boxes out one at a time and open them to see what’s
inside. To rename a notebook, just click the filename at the top of the notebook
such as BPP4D3E; ©4; Comments.ipynb and type a new name for it.
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Closing and Halting a Notepad

There is no need (or option) to close and halt notebooks when working with Colab.
However, when working with Jupyter Notebook, you have a local server (called a
kernel), and you need to interact with that server to ensure that all the changes you
make to a notebook are recorded. With this idea in mind, the following list con-
tains the menu options you use to interact with the server to ensure that your
changes are saved and that the server itself is halted when you want to end a
session.

»

»

»

»

»

»

File> Save and Checkpoint: Saves any changes you made to disk and
creates a checkpoint so that you can restore a previous version of your file.
However, Jupyter Notebook saves only one previous version, so your undo
options are somewhat limited.

File > Revert to Checkpoint: Presents a list of checkpoint files for this
notebook. There is usually just one such file, and selecting it will restore the
file from the previous checkpoint.

File> Close and Halt: Closes the file and halts the server for this notebook.
The overall server functionality is unaffected. To completely shut the server
down, you must click Quit in the main Jupyter Notebook screen (the one
where you select which file to open).

Kernel => Reconnect: Allows recovery after a software glitch if the server
breaks the connection with the current notebook. You can tell that the
connection is broken because you see a No Kernel message at the right side
of the menu bar.

Kernel => Shutdown: Shuts the kernel down without closing the file. You see a
No Kernel message at the right side of the menu bar when the shutdown is
complete.

Kernel=> Change Kernel: Selects an alternative kernel to use when running
the current notebook. You might install multiple versions of Python, for
example, and need to test the code with each one. (The “Seeing the result”
section of the chapter talks about various restart options you can use to
ensure you have a clean environment to use between tests.)
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IN THIS CHAPTER

» Defining what is meant by magic

» Performing magic of your own

» Discovering the magic words

Chapter 5
Performing Magic

ost everyone likes magic. You see it in films, books, magazines, online,

video games, and a seemingly endless assortment of other sources.

Watching a magician perform tricks is nothing short of amazing. Unlike
other programming languages, Python comes with its own built-in set of magic
commands. A magic command is a special kind of function that does something to
the programming environment, rather than work as code. These magical words
can make you look just like a magician on a stage; others will wonder how you
created a certain effect, and the secret of your magic commands will remain yours
alone. The first part of this chapter discusses the ins and outs of magic commands
in a little more detail.

Of course, you’ll want to start performing magic commands immediately, so the
second part of the chapter gets you started with a few beginner tricks designed to
tantalize without being too hard to use. Some magic commands can become
involved, just like those on the stage (but your code won’t ever disappear and no
one will get locked up in a tank of water).

The third part of this chapter provides an overview of the magic commands key-
words that you need to know. Each entry comes with a short description so that
you know which magic commands will fulfill needs you have with your notebooks.
Spending time working with the magic commands is the only way to learn
them well.
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REMEMBER

You don’t have to type the source code for this chapter manually. In fact, using the
downloadable source is a lot easier. You can find the source for this chapter in the
BPP4D3E; ©5; Magics.ipynb file of the downloadable source. See the Introduc-
tion for details on how to find these source files.

Understanding the Concept
of a Magic Command

FIGURE 5-1:

The %1smagic

displays a list of

command

magic commands

80

for you.

A magic command really isn’t magic. The magic is in the output. For example,
instead of displaying graphic output in a separate window, you can choose to dis-
play it within the cell, as if by magic (because the cells appear to hold only text).
Or you can use magic to check the performance of your application, and do so
without all the usual added code that such performance checks require.

A magic command begins with either a percent sign (%) or double percent sign
(%%). Those with a % sign work within the environment, and those with a %%
sign work at the cell level. For example, if you want to obtain a list of magic com-
mands, type %lsmagic and then run the command in Colab or Notebook to see
them, as shown in Figure 5-1. (You may see the output all on one line, in which
case you can apply the fix described in the “Adding magic to the magic com-
mands” sidebar.)

T e B0 .

0 Flsmagid

Available line magics:

%alias %¥alias_megic Xautocall Xoutomagic Xasutosave Xbookmark Xcat %cd Xclear Xcolors Xconfig Hconnect info

%cp %debug %dhist Xdirs %doctest_mode Xed RXedit R%env %gui Xhist Xhistory X¥killbgscripts X%ldir Xless X¥1f

%1k %11 %load %load_ext %loadpy %logoff %¥logon X¥logstart %logstate ¥logstop %ls %lsmagic %lx ¥macro ¥magic

c %pfile %¥pinfo %pinfo2 %pip
£

%man %matplotlib %mkdir ¥more %mv %notebook %page %
%popd  ¥pprint ¥precision ¥profile ¥prun ¥psearch ¥ps
1 Srehashx %reload ext %rep %rerun %reset ¥reset
%store ¥sx ¥system %th ¥tensorflow_version %time %timeit %unalias %unload_ext %who %who_ls
#xmode

%

%pwd ¥pycat ¥pylab Hgtconsole %¥quic

rce  %pushd

¥set_en hell

¥whos  %xdel

selective m  ¥rmdir %run %save Xs

Available cell magics:

k! XBHTML X¥SVG Xkbash X¥bigquery XEcapture XXdebug HX%file X¥html X¥javascript X%js %klatex HEperl H¥prun
¥¥pypy M¥python HHpython2 XXpython3 X¥ruby H¥script XMsh X¥shell %Ksvg H¥sx HMMsystem XEXtime H¥timeit
¥writefile

Automagic is ON, % prefix IS NOT needed for line magics.

PART 1 Getting Started with Python



(= =)
T
TECHNICAL
STUFF

ADDING MAGIC TO THE MAGIC COMMANDS

Depending on the IDE and browser you use (Colab tends to have this problem;
Notebook doesn't), you may notice that certain commands display a very long line of
text without any text wrap, which means you must scroll back and forth to see the
entire line. Of course, this can prove frustrating, especially if you're already having a bad
day. Rather than throw your shoe at the monitor, however, you can add the following
piece of code to the beginning of your notebook and run it in a separate cell from your
other code:

from IPython.display import HTML, display

def set_css():
display(HTML( """
<style>
pre {
white-space: pre-wrap;
}
</style>
)

get_ipython().events.register('pre_run_cell', set_css)

It's not essential to understand this code to make use of it, although understanding it
would be nice. This code tells the IDE to provide text wrapping using a specific
Cascading Style Sheets (CSS) style, pre {white-space: pre-wrap;}, as documented
athttps://developer .mozilla.org/en-US/docs/Web/CSS/white-space. You
access this style by using the IPython.display.HTML class documented athttps://
ipython.readthedocs.io/en/stable/api/generated/IPython.display.

html. You can see other IPython.display.HTML examples athttps://www.
programcreek .com/python/example/83957/IPython.display.HTML.

The call to get_ipython() obtains a copy of the interactive shell object that you then
use to register a new event handler named pre_run_cell (seehttps://ipython.
readthedocs. io/en/stable/api/generated/IPython.core.getipython.html
and https://ipython.readthedocs.io/en/stable/config/callbacks.html for
details). Every time you run a cell, the event handler adds the bit of CSS code defined by
the set_css( ) function to ensure that text lines will wrap for you. You can see other
get_ipython( ) call examples at https: //www.programcreek .com/python/
example/50972/IPython.get_ipython. The point is that the code fixes the text
wrapping problem for you.
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Each of these magic commands is part of the IPython module that is automati-
cally loaded when you load Python, no matter where or how you load it. So when
you work at the command line (something you won’t do in this book), you can still
use many of the magic commands. Of course, you have to have Python installed on
your machine to test it by typing ipython and pressing Enter at a command prompt
or in a terminal window. (Note that this is the interactive Python (ipython) com-
mand, not the standard Python (python) command.) Some magic commands
don’t have a use at the command line, such as %autosave, because the environ-
ment is different. The point is that Python provides magic commands no matter
where you work with it.

What Kind of Magic Do You
Want to Perform?

82

Magic functions are all about the programming environment rather than the
application code. When you issue a magic command, what you’re doing is access-
ing the underlying interactive shell in a manner that doesn’t require you to write
code similar to that found in the “Adding Magic to the Magic Commands” sidebar
in the chapter. All this code is already encapsulated for you in the form of the
magic functions. There are two kinds of magic commands: line and cell, as
described in the sections that follow.

Working with line magic commands

Line magic commands affect a single line in your code. When you start reviewing
them in the “An overview of line magic commands” section of the chapter, you
see that this limitation makes sense. For example, if you perform a directory list-
ing using the %1s function, you don’t want to have it keep affecting every other
cell in the application. All you really want to see are the items (files and other
directories) in the current directory.

Any line magic functions that affect settings do continue to modify the environ-
ment. For example, the settings you use with the Zmatplotlib function remain in
effect until you change them again. However, like any other line magic com-
mands, the %matplotlib affects only the current line where the setting is made.
That the setting remains permanent is a matter of application state, rather than
having the #matplotlib function remain active.
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shell and aren’t actually part of your application. For example, you can’t write

myDir = %ls and expect that myDir will contain a directory listing after you exe-
rememser  cute the command. What will happen instead is that you see a directory listing and

myDir remains empty (a call to print(myDir) will produce an output of None).

@ It’s important to note that the magic functions work directly with the interactive

Working with cell magic commands

Cell magic commands affect an entire cell in your code and some affect all cells after
the cell in which the magic command appears. For example, the %%debug function
affects only the current cell, but it does so in a manner that affects the application
as a whole because it activates the built-in debugger. You can use this debugger to
locate errors in your code much faster and with better accuracy than using
the print() function, which is how most developers debug their Python code.
The article at https://towardsdatascience.com/4-1little-known-magic-
commands-that-boost-your-productivity-afiba4268c57 tells you more about
the built-in debugger (a feature that few people even know about).

Depending on how you use %%prun and %%time functions, they can affect the
application as a whole because you’re using them to monitor performance. In fact,
%%prun actually shows all the external calls involved in running your code (the
listing can become quite long). So it’s important to view cell magic commands as
running in the current cell, but possibly affecting other cells as well.

Learning the Magic Commands

Like any good magician, you need to learn the magic words before you can per-
form magic commands. The following sections provide you with the information
needed to make creating magic in your notebooks a reality.

Getting magic command details

As previously mentioned, you can use the %1smagic command to obtain a simple
listing of available magic commands. Tables 5-1 and 5-2 list the most common
magic commands and their purpose. To obtain a full detail listing, type %quickref
and click Run Cell in Colab or Notebook to display output like that shown in
Figure 5-2. You can also find a full listing of the magic commands at https://
damontallen.github.io/IPython-quick-ref-sheets/.
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WATCHING FOR ENVIRONMENTAL
DIFFERENCES

Most of the magic commands you read about in this chapter will work in most environ-
ments. However, some magic commands don't work with Colab, and others don't work
with Jupyter Notebook. Unfortunately, the support you see for magic commands
changes all the time, so your best option is to try a magic command in the environment
in which you want to use it and see if it works. For example, %cp ——help works fine in
Colab, but doesn’t work in Jupyter Notebook (at least, not now). You may also get differ-
ent results from some commands based on environment because the environment
helps to determine the information you receive. A directory listing for Colab will defi-
nitely differ from a directory listing in Jupyter Notebook. You also see differences based
on platform — output from a Windows platform will differ from the output on a Linux

platform.
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In some cases, %quickref shows :: for an output, rather than a description, to

@ indicate that this particular magic command doesn’t have a specific output. For
example, when working with %debug or %%debug, the output depends on the code

TP that you debug. In other cases, %quickref does provide help text, but it doesn’t
really tell you how to work with the magic command, such as with %%prun, where
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FIGURE 5-3:
The %quickref
function may
not tell you
everything you
need to know.

you must supply the code to run as part of the cell, as shown in Figure 5-3. In this
case, the output from the code appears as part of the cell as usual, but the perfor-
mance information appears in a help screen.
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It’s possible to obtain even more detailed information about a particular magic
command by adding —-help to the function. For example, %cp —-help tells you
about the arguments used with the %cp function. However, this feature doesn’t
work with all magic commands.

An overview of line magic commands

Table 5-1 shows a listing of common line magic commands and their purpose. The
table also tells you when you can use the line magic command by itself. For exam-
ple, when you use the %alias magic command alone, you obtain a listing of the
currently defined aliases for systemm commands as a list of tuples, such as ( '1dir",
'ls -F -0 --color %1 | grep /$'), where 1dir is the alias for 1s -F -o
——color %1 | grep /$. Typing ldir is much shorter, of course, but it accom-
plishes so much. Note that Table 5-1 doesn’t include a few of the most advanced
magic commands, such as %gui, or those that seem incompatible or somewhat
useless, such a %dirs. In addition, you won’t find deprecated (that is, no longer
supported) magic commands such as %profile and %sc.
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TABLE 5-1 Common IPython Line Magic Commands

Type Alone
Magic Command Provides Status? Description
%alias Yes Assigns or displays an alias for a system command.
%alias_magic No Assigns an alias for a magic command. You must supply

the new name you want to use and the name of the
magic command that it represents. It's also possible to
specify —c for cell magic commands and -I for line magic
commands.

%autocall Yes Enables you to call functions without including the
parentheses. The settings are Off, Smart (default), and
Full. The Smart setting applies the parentheses only if
you include an argument with the call.

%automagic Yes Enables you to call the line magic commands without
including the percent (%) sign. The settings are False
(default) and True.

%autosave Yes Displays or modifies the intervals between automatic
Notebook saves. The default setting is every 120
seconds.

%bookmark No Makes it possible to create a bookmark in your code so

that you don't have to remember where you're at
between sessions. You must supply the bookmark name.
Use the %cd —b function to go to a bookmark in your
code.

%cd Yes Changes directory to a new storage location. You can
also use this command to move through the directory
history or to change directories to a bookmark. When
used by itself, you see the current directory on disk.

%clear No Clears the terminal window (may not be available in all
environments).

%cls No Clears the screen (may not be available in all
environments).

%colors No Specifies the colors used to display text associated with
prompts, the information system, and exception han-
dlers. You can choose between NoColor (black and
white), Linux (default), and LightBG.

%config Yes Enables you to configure IPython.

%connect_info Yes Displays the connection information for the notebook’s
interactive environment.
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Magic Command

Type Alone
Provides Status?

Description

%conda

No

Runs the specified conda command, assuming that you
have conda installed on your system (may not be availa-
ble in all environments).

%cp

No

Copies a file from a source to a destination (may not be
available in all environments).

%debug and %%debug.

No

Places the interactive environment into debug mode.

%dhist

Yes

Displays a list of directories visited during the current
session.

%dirs, %popd, %pushd,
%pwd

Yes

Pushes the current directory on the directory stack
(%pushd), pops a saved directory from the directory
stack (%popd), shows the list of directories on the direc-
tory stack (kdirs), and shows the current working direc-
tory (%pwd).

%doctest_mode

No

Toggles the interactive environment between doctest
mode and standard environment behavior. In doctest
mode, the environment behaves more like the plain
Python environment in reporting errors and outputting
information, which makes it easier to copy and paste the
information into doctests (see https://docs.python.
org/3/library/doctest.html and https://www.
digitalocean.com/community/tutorials/how-
to-write-doctests-in-python for additional
details).

%env and %set_env

Yes

Displays (kenv) and sets (%set_env) the environment
variables for the current machine. When the name of an
environment variable is provided, the output shows just
the information for that environment variable.

%file

No

Outputs the name of the file that contains the source
code for the object. (May not be available in all
environments.)

%hist and %Zhistory

Yes

Displays a list of magic commands issued during the cur-
rent session.

%install_ext

No

Installs the specified extension. (May not be available in
all environments.)

%ldir

Yes

Provides a directory listing of the current directory (no
files). It's also possible to add the path to a directory that
you want to search.

(continued)
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TABLE 5-1 (continued)

Magic Command

Type Alone

Provides Status?

Description

%load and loadpy No Loads application code from another source, such as an
online example.

%load_ext No Loads a Python extension using its module name.

%logoff,%logon, Yes Starts, stops, queries, and pauses Python logging of

%logstart, %log- application activity. The %#1ogstart and %1ogstop func-

state, and %¥logstop tions start and stop the log. Use %logoff and %1ogon
to pause and continue the log. The %1ogstate function
shows the current logging status.

%1smagic Yes Displays a list of the currently available magic
commands.

%magic Yes Displays a help screen showing information about the
magic commands.

%matplotlib Yes Sets the back-end processor used for plots. Using the
inline value displays the plot within the cell for an IPy-
thon Notebook file. The possible values are: 'gtk "',
'gtk3', 'inline', 'nbagg’, 'osx', 'qt"', 'qt4’,
"qtd', 'tk',and 'wx'.

%mkdir No Creates a new directory in the location specified.

%notebook No Exports the current environment history to the specified
notebook file that you can import and review.

%paste No Pastes the content of the Clipboard into the IPython
environment (may not be available in all environments).

%pdef No Shows how to call the object (assuming that the object is
callable).

%pdoc No Displays the docstring for an object.

%pinfo No Displays detailed information about the object (often
more than provided by help alone).

%pinfo2 No Displays extra detailed information about the object
(when available).

%pip No Runs the specified pip command assuming that you
have pip (package installer for Python) installed on your
system (may not be available in all environments).

%pprint No Toggles pretty printing (how output appears) of content

on and off.

88 PART 1 Getting Started with Python



Magic Command

Type Alone
Provides Status?

Description

%precision

No

Sets the precision for pretty printing of floating-point
values.

%prun

Yes

Profiles the specified function that appears on the same
line as the magic command, rather than the code found
in a cell as the %%prun function does. When run by itself,
you see the calls used to run %prun, making it easier to
separate the %prun calls from those made by your code.

%psearch

No

Performs a pattern search for desired objects in the
environment. For example, using %psearch dx would
search for all objects beginning with the letter d.

%pylab

Yes

Provides additional support for plotting using MatPlotLib
as described athttps://www.tutorialspoint.com/
matplotlib/matplotlib_pylab_module.htm.

%quickref

Yes

Displays a reference sheet for all the available magic
commands on a particular system (see the “Getting
magic command details” section of the chapter for
details).

%reload_ext

No

Reloads a previously installed extension.

%reset and
%reset_selective

No

Resets the namespace, removing all the variables when
used alone. It's also possible to specify which variables to
reset. Clearing the variables allows execution of code in
a clean environment but means that you must recreate
any lost variables.

%rm and %rmdir

No

Removes a directory from the specified location. Note
that the directory must be empty before you can
remove it.

%run

No

Loads the specified Python module and runs it.

%source

No

Displays the source code for the object, assuming that
the source is available (may not be available in all
environments).

%store

No

Provides the means to store variables long term in
Python. The article athttps://www.blopig.com/
blog/2020/05/storing-variables-in-jupyter—
notebooks-using-store-magic/ provides details on
how to use this magic command effectively.

%time and %timeit

No

Calculates the best performance time for an instruction.

%unalias

No

Removes a previously created alias from the list.

(continued)
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TABLE 5-1 (continued)

Type Alone
Magic Command Provides Status? Description
%unload_ext No Unloads the specified extension.
%who, %who_ls, and Yes Provides a listing of currently defined variables. The
%whos %who and %who_1s functions provide overviews. The

%whos function provides the most detailed output.

%xdel No Deletes a variable, even when the variable has several
aliases. The variable is also removed from the output
history.

%xmode No Toggles between exception handling verbosity levels:

Minimal, Plain, Context, and Verbose. By setting the ver-
bosity level correctly, you can usually reduce the time
needed to find errors in your application.

An overview of cell magic commands

Cell magic commands tend to provide greater functionality in many ways than
line magic commands do. You can perform tasks that might seem impossible, but
they actually do work (making them quite magical indeed). For example, you may
want to create an HTML presentation as part of your notebook, which would seem
impossible because notebooks don’t execute HTML very well, or do they? Using
the following code lets you execute HTML within your notebook to get just the
right presentation:

%%HTML

<p>This is a list.</p>

<ul>
<li>Morning</1i>
<li>Noon</1i>
<li>Night</1li>

</ul>

When you execute the cell, you get precisely the output you intend. Table 5-2 tells

you more about the magical nature of cell magic commands. Unlike line magic
commands, cell magic commands don’t provide status information.
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TABLE 5-2 Common IPython Cell Magic Commands

Magic Comand Description

%%\, hkbash, %sx,
%%sx, %system, and
%»%system

Performs a list of system-specific commands. The commands must match the
underlying operating system. When working with Colab, this means using Linux

commands, such as 1s. When working with Notebook, it may mean using

Windows commands, such as dir. Even though 1s and dir are equivalent, you
can't mix and match them, which makes this particular kind of magic command
brittle (prone to breaking). The %%bash function is available only on Linux systems

and provides the additional functionality detailed athttps://t1ldp.org/

LDP/Bash-Beginners-Guide/html/Bash-Beginners-Guide.html for

bash users.

%%capture

Records the stdout, stderr, and IPython’s rich display () calls for later use.

The resulting object acts as a macro that you can play back as needed. The article

athttps://notebook.community/lifeinoppo/littlefishlet—scode/
RES/REF /python_sourcecode/ipython-master/examples/IPython%20

Kernel/Capturing%2@0utput provides an example of how to use this feature.

%%file and
%kwritefile

Writes the contents of a cell to the specified file.

%%HTML and %%html

Runs the specified HTML script immediately following the magic command in the

same cell.

%%javascript and
%%js

Runs the specified JavaScript script immediately following the magic command in

the same cell.

%%latex

Renders the cell as a block of LaTeX (https://www.latex-project.org/).
The level of LaTeX support depends on the environment you're using. For exam-

ple, Jupyter Notebook supports only the level described athttps://docs.

mathjax.org/en/v2.5-1latest/tex.html. The tutorial athttps://www.

overleaf.com/learn/latex/Learn_LaTeX_in_30@_minutes tells you more
about how to work with LaTeX. You can also use LaTeX directly in markup cells as
described in the “Working with text cells” section of Chapter 4.

%%prun

Performance tests the code found in the remainder of the cell and provides
detailed statistics about it. This magic command is different from the %prun func-

tion, so don't confuse the two.

%%SVG and %%svg

Renders the cell as a Scalable Vector Graphics (SVG) literal, so you can create
images as part of your notebook. The tutorial athttps: //www.w3schools.

com/graphics/svg_intro.asp tells you more about working with SVG.

%%time and %%timeit

Calculates the best performance time for all the instructions in a cell, apart from
the one placed on the same cell line as the cell magic (which could therefore be

an initialization instruction).

CHAPTER 5 Performing Magic
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Working with various kinds of data
Changing how Python views data
Choosing paths in applications
Performing tasks more than once

Dealing with exceptional situations



IN THIS CHAPTER

» Understanding data storage

» Considering the kinds of data storage

» Adding dates and times to
applications

Chapter 6
Storing and Modifying
Information

©

REMEMBER

hapter 3 introduces you to CRUD, that is, Create, Read, Update, and Delete —

not that Chapter 3 contains cruddy material. This acronym provides an easy

method to remember precisely what tasks all computer programs perform
with information you want to manage. Of course, geeks use a special term for
information — data, but either information or data works fine for this book.

To make information useful, you have to have some means of storing it perma-
nently. Otherwise, every time you turned the computer off, all your information
would be gone and the computer would provide limited value. In addition, Python
must provide some rules for modifying information. The alternative is to have
applications running amok, changing information in any and every conceivable
manner. This chapter is about controlling information — defining how informa-
tion is stored permanently and manipulated by applications you create.

You don’t have to type the source code for this chapter manually. In fact, using the
downloadable source is a lot easier. You can find the source for this chapter in the
BPP4D3E; 06; Storing And Modifying Information.ipynb file of the down-
loadable source. See the Introduction for details on how to find these source files.

CHAPTER 6 Storing and Modifying Information 95



Storing Information

96

©

REMEMBER

OLAOD,
TECHNICAL
STUFF

An application requires fast access to information or else it will take a long time
to complete tasks. As a result, applications store information in memory. How-
ever, memory is temporary. When you turn off the machine, the information must
be stored in some permanent form, such as on your hard drive, a Universal Serial
Bus (USB) flash drive, a Secure Digital (SD) card, or on the Internet using a cloud-
based solution. In addition, you must also consider the form of the information,
such as whether it’s a number or text. The following sections discuss the issue of
storing information as part of an application in more detail.

Seeing variables as storage boxes

When working with applications, you store information in variables. A variable is
a kind of storage box. Whenever you want to work with the information, you
access it using the variable. If you have new information you want to store, you
put it in a variable. Changing information means accessing the variable first and
then storing the new value in the variable. Just as you store things in boxes in the
real world, so you store things in variables when working with applications.

Computers are actually pretty tidy. Each variable stores just one piece of informa-
tion. Using this technique makes it easy to find the particular piece of information
you need — unlike in your closet, where things from ancient Egypt could be hid-
den. Even though the examples you work with in previous chapters don’t use
variables, most applications rely heavily on variables to make working with infor-
mation easier.

Using the right box to store the data

People tend to store things in the wrong sort of box. For example, you might find
a pair of shoes in a garment bag and a supply of pens in a shoebox. However,
Python likes to be neat. As a result, you find numbers stored in one sort of variable
and text stored in an entirely different kind of variable. Yes, you use variables in
both cases, but the variable is designed to store a particular kind of information.
Using specialized variables makes it possible to work with the information inside
in particular ways. You don’t need to worry about the details just yet — just keep
in mind that each kind of information is stored in a special kind of variable.

Python uses specialized variables to store information to make things easy for the
programmer and to ensure that the information remains safe. However, comput-
ers don’t actually know about information types. All that the computer knows
about are 0s and 1s, which is the absence or presence of a voltage. At a higher level,
computers do work with numbers, but that’s the extent of what computers do.
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Numbers, letters, dates, times, and any other kind of information you can think
about all come down to 0s and 1s in the computer system. For example, the letter
A is actually stored as 01000001 or the number 65. The computer has no concept
of the letter A or of a date such as 8/31/2022.

Defining the Essential Python Data Types

FIGURE 6-1:

Use the
assignment
operator to place
information into
a variable.

Every programming language defines variables that hold specific kinds of infor-
mation, and Python is no exception. The specific kind of variable is called a data
type. Knowing the data type of a variable is important because it tells you what
kind of information you find inside. In addition, when you want to store informa-
tion in a variable, you need a variable of the correct data type to do it. Python
doesn’t allow you to store text in a variable designed to hold numeric information.
Doing so would damage the text and cause problems with the application. You can
generally classify Python data types as numeric, string, and Boolean, although
there really isn’t any limit on just how you can view them. The following sections
describe each of the standard Python data types within these classifications.

Putting information into variables

To place a value into any variable, you make an assignment using the assignment
operator (=). Chapter 7 discusses the whole range of basic Python operators in
more detail, but you need to know how to use this particular operator to some
extent now. For example, to place the number 5 into a variable named myVar, you
type myVar = 5. Even though Python doesn’t provide any additional information
to you, you can always type the variable name and click Run Cell to see the value
it contains, or use a print() function as shown in Figure 6-1.

~ Defining the Essential Python Data Types

~ Putting information into variables

T B g 0§ ¢

' ° myVar = 5

print(myvar)

5

Understanding the numeric types

Humans tend to think about numbers in general terms. We view 1 and 1.0 as being
the same number — one of them simply has a decimal point. However, as far as
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we’re concerned, the two numbers are equal and we could easily use them inter-
changeably. Python views them as being different kinds of numbers because each
form requires a different kind of processing. The following sections describe the
integer, floating-point, and complex number classes of data types that Python
supports.

Integers

Any whole number is an integer. For example, the value 1 is a whole number, so it’s
an integer. On the other hand, 1.0 isn’t a whole number; it has a decimal part to it,
so it’s not an integer. Integers are represented by the int data type.

Unlike many programming languages, Python doesn’t have an int capacity
limit — you can make an int any size you need it. In case you want to understand
how this unlimited size feature works, the site at https://jakevdp.github.io/
PythonDataScienceHandbook/02.01-understanding-data-types.html pro-
vides additional details, but you really don’t need to know how things work under
the hood to work with Python. This unlimited size feature can cause problems
with working with third-party libraries, such as NumPy (https://numpy.org/
doc/stable/user/basics.types.html), where there are different integer data
types with specific sizes, so you need to be aware of this issue when writing an
application using third-party libraries.

When working with the int type, you have access to a number of interesting fea-
tures. Many of them appear later in the book, but one feature is the ability to use
different numeric bases:

3 Base 2: Uses only 0 and 1 as numbers.
3 Base 8: Uses the numbers 0 through 7.
3 Base 10: Uses the usual numeric system.

¥ Base 16: Is also called hex (or hexadecimal) and uses the numbers 0 through 9
and the letters A through F to create 16 different possible values.

To tell Python when to use bases other than base 10, you add a 0 and a special let-
ter to the number. For example, 0b100 is the value one-zero-zero in base 2. Here
are the letters you normally use:

¥ b:Base?2
¥ o0:Base8
¥ x:Base 16
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FIGURE 6-2:
Integers have
many interesting
features,
including the
capability to use
different numeric
bases.

REMEMBER

You can also convert numeric values to other bases by using thebin(), oct(), and
hex() functions. So, putting everything together, you can see how to convert
between bases using the functions shown in Figure 6-2. Try the function shown
in the figure yourself so that you can see how the various bases work. Using a dif-
ferent base actually makes things easier in many situations, and you’ll encounter
some of those situations later in the book. For now, all you really need to know is
that integers support different numeric bases.

+ Understanding the numeric types

~ Integers

o B g0

v Q) Test = ablee

print("1@@ Binary: ", Test)
Test = eoleq
print("1@@ Octal: ", Test)
Test = 180
print ("1@@ Decimal: ", Test)
Test = @xlee
print("10@ Hexadecimal:", Test)
print(bin(Test))
print(oct(Test))
print(hex(Test))

[+ 1l@a Binary: 4
108 Octal: B4
108 Decimal: 190
108 Hexadecimal: 256
ableaoppees
@o408
ax10e

Floating-point values

Any number that includes a decimal portion is a floating-point value. For exam-
ple, 1.0 has a decimal part, so it’s a floating-point value. Many people get con-
fused about whole numbers and floating-point numbers, but the difference is
easy to remember. If you see a decimal in the number, then it’s a floating-point
value. Python stores floating-point values in the float data type.

Floating-point values have an advantage over integer values in that you can store
values with a fractional portion in them. Unlike integers, floating-point variables
do have a storage capacity because of the way in which they’re stored using
IEEE 754 format (see https://www.geeksforgeeks.org/ieee-standard-754-
floating-point—-numbers/ for details). In their case, the maximum value that a
variable can contain is +1.7976931348623157 x 103°% and the minimum value that a
variable can contain is +2.2250738585072014 x 1073°¢ on most platforms.
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UNDERSTANDING THE NEED FOR
MULTIPLE NUMBER TYPES

A lot of new developers (and even some older ones) have a hard time understanding
why there is a need for more than one numeric type. After all, humans can use just one
kind of number. To understand the need for multiple number types, you have to under-
stand a little about how a computer works with numbers.

An integer is stored in the computer as simply a series of bits that the computer reads
directly. A value of 0100 in binary equates to a value of 4 in decimal. On the other hand,
numbers that have decimal points are stored in an entirely different manner. Think
back to all those classes you slept through on exponents in school — they actually come
in handy sometimes. A floating-point number is stored as a sign bit (plus or minus),
mantissa (the fractional part of the number), and exponent (the power of 2). (Some texts
use the term significand in place of mantissa — the terms are interchangeable.) To
obtain the floating-point value, you use the equation:

Value = Sign Bit, Mantissa *x 2”"Exponent

At one time, computers all used different floating-point representations, but they all
use the IEEE-754 standard (https://standards. ieee.org/ieee/754/6210/) now.
You can read about this standard athttps: //www.geeks forgeeks.org/ieee-
standard-754-floating-point-numbers/. A full explanation of precisely how
floating-point numbers work is outside the scope of this book, but you can read a fairly
understandable description athttps: //www.cprogramming.com/tutorial/
floating_point/understanding_floating_point_representation.html.
Nothing helps you understand a concept like playing with the values. You can find a
really interesting floating-point number converter athttps://www.h-schmidt.net/
FloatConverter/IEEE754.html, where you can click the individual bits (to turn them
off or on) and see the floating-point number that results.

As you might imagine, floating-point numbers tend to consume more space in memory
because of their complexity. In addition, they use an entirely different area of the
processor — one that works more slowly than the part used for integer math. Finally,
integers are precise, as contrasted to floating-point numbers, which can't precisely rep-
resent some numbers, so you get an approximation instead. The bottom line is that
decimals are unavoidable in the real world, so you need floating-point numbers.
Computer systems have many trade-offs, and this one is unavoidable.
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FIGURE 6-3:
Floating-point
values provide
multiple
assignment
techniques.

When working with floating-point values, you can assign the information to the
variable in a number of ways. The two most common methods are to provide the
number directly and to use scientific notation. When using scientific notation, an
e separates the number from its exponent. Figure 6-3 shows both methods of
making an assignment. Notice that using a negative exponent results in a frac-
tional value.

= Floating-point values

L) B fg 08
© rest -5

print("Direct Assignment: ", Test)

Test = 2.55e2
print(“Scientific Notation: ™, Test)

Direct Assignment: 255.@
Scientific Notation: 255.@
Megative Exponent: @.8255

Complex numbers

You may or may not remember complex numbers from school. A complex number
consists of a real number and an imaginary number that are paired together. Just
in case you’ve completely forgotten about complex numbers, you can read about
them at https://www.mathsisfun.com/numbers/complex—numbers.html. Real-
world uses for complex numbers include:

¥ Electrical engineering
¥ Fluid dynamics

¥ Quantum mechanics
3 Computer graphics

¥ Dynamic systems

Complex numbers have other uses, too, but this list should give you some ideas.
In general, if you aren’t involved in any of these disciplines, you probably won’t
ever encounter complex numbers. However, Python is one of the few languages
that provides a built-in data type to support them. As you progress through the
book, you find other ways in which Python lends itself especially well to science
and engineering.
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The imaginary part of a complex number always appears with a j after it in Python.
So, if you want to create a complex number with 3 as the real part and 4 as the
imaginary part, you make an assignment like this:

myComplex = 3 + 4j

If you want to see the real part of the variable, you simply type print(myComplex.
real). Likewise, if you want to see the imaginary part of the variable, you type
print(myComplex.imag).

Understanding Boolean values

It may seem amazing, but computers always give you a straight answer! A com-
puter will never provide “maybe” as output. Every answer you get is either True
or False. In fact, there is an entire branch of mathematics called Boolean algebra
(https://www.tutorialspoint.com/computer_logical _organization/
boolean_algebra.htm) that was originally defined by George Boole (https://
plato.stanford.edu/entries/boole/), a super-geek of his time, that comput-
ers rely upon to make decisions. Contrary to common belief, Boolean algebra has
existed since 1854 — long before the time of computers.

When using Boolean values in Python, you rely on the bool type. A variable of this
type can contain only two values: True or False. You can assign a value by using
the True or False keywords, or you can create an expression that defines a logical
idea that equates to true or false. For example, you could say, myBool = 1 > 2,
which would equate to False because 1 is most definitely not greater than 2. You
see the bool type used extensively in the book, so don’t worry about understand-
ing this concept right now.

DETERMINING A VARIABLE'S TYPE

Sometimes you might want to know the variable type. Perhaps the type isn’t obvious
from the code or you've received the information from a source whose code isn't acces-
sible. Whenever you want to see the type of a variable, use the type() method. For
example, if you start by placing a value of 5 inmyInt by typing mylnt =5 and clicking
Run Cell, you can find the type of myInt by typing type(mylnt) and pressing Enter. The
output will be <class 'int'>, which means thatmyInt contains an int value.
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FIGURE 6-4:
Converting a
string to a
number is easy
by using the
int() and
float()
functions.

Understanding strings

Of all the data types, strings are the most easily understood by humans and not
understood at all by computers. If you have read the previous chapters in this
book, you have already seen strings used quite often. For example, all the example
code in Chapter 4 relies on strings. A string is simply any grouping of characters
you place within double or single quotes. For example, myString = "Python is a
great language." assigns a string of characters to myString.

The computer doesn’t see letters at all. Every letter you use is represented by a
number in memory. For example, the letter A is actually the number 65. To see
this for yourself, type print(ord(“A”)) and click Run Cell. You see 65 as output.
You can convert any single letter to its numeric equivalent by using the ord()
function.

Because the computer doesn’t really understand strings, but strings are so useful
in writing applications, you sometimes need to convert a string to a number. You
can use the int() and float() functions to perform this conversion. For example,
if you type myInt = int(“123”) and click Run Cell, you create an int named myInt
that contains the value 123. Figure 6-4 shows how you can perform this task and
validate the content and type of myInt.

~ Understanding strings

c+ v eoB QR

o ° }:'int(:ﬂ‘c ("A"))

myInt = int("123")
print(myInt)

print(type(myInt))
65

123
<class 'int'>

You can convert numbers to a string as well by using the str() function. For
example, if you type myStr = str(1234.56) and click Run Cell, you create a string
containing the value "1234.56" and assign it to myStr. Figure 6-5 shows this type
of conversion and the test you can perform on it. The point is that you can go back
and forth between strings and numbers with great ease. Later chapters demon-
strate how these conversions make a lot of seemingly impossible tasks quite
doable.
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FIGURE 6-5:

You can convert

numbers to

strings as well.

™ - |
© mystr = str(1234.56)
print(myStr)

print{(type(mystr)]|

1234.56
<class 'str'>

Working with Dates and Times
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FIGURE 6-6:

Get the current
date and time by
using the now( )
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function.

Dates and times are items that most people work with quite a bit. Society bases
almost everything on the date and time that a task needs to be or was completed.
We make appointments and plan events for specific dates and times. Most of our
day revolves around the clock. Because of the time-oriented nature of humans,
it’s a good idea to look at how Python deals with interacting with dates and time
(especially storing these values for later use). As with everything else, computers
understand only numbers — the date and time don’t really exist.

To work with dates and times, you need to perform a special task in Python. When
writing computer books, chicken-and-egg scenarios always arise, and this is one
of them. To use dates and times, you must issue a special import datetime func-
tion. Technically, this act is called importing a package, and you learn more about it
in Chapter 11. Don’t worry how the function works right now — just use it when-
ever you want to do something with date and time.

Computers do have clocks inside them, but the clocks are for the humans using
the computer. Yes, some software also depends on the clock, but again, the
emphasis is on human needs rather than anything the computer might require. To
get the current time, you can simply type print(datetime.datetime.now()) and
click Run Cell. You see the full date and time information as found on your com-
puter’s clock (see Figure 6-6).

~ Working with Dates and Times

+ B QE T
° import datetime
print(datetime.datetime.now())

2022-04-85 21:05:02.198893

You may have noticed that the date and time are a little hard to read in the existing
format. Say that you want to get just the current date, in a readable format. It’s
time to combine a few things you discovered in previous sections to accomplish
that task. Type print(str(datetime.datetime.now().date())) and click Run Cell.
Figure 6-7 shows that you now have something a little more usable.
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FIGURE 6-7:
Make the date o~ ==
and time more o ° print(str(datetime.datetime.now().date()))
readable by using
thestr()
function.

2022-84-05

Interestingly enough, Python also has a time( ) function (https://docs.python.
org/3/library/time.html), which you can use to obtain the current time. You
can obtain separate values for each of the components that make up date and time
by using the day, month, year, hour, minute, second, and microsecond values.
Later chapters help you understand how to use these various date and time fea-
tures to keep application users informed about the current date and time on their
system.
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IN THIS CHAPTER

» Understanding the Python view
of data

» Using operators to assign, modify,
and compare data

» Organizing code using functions

» Interacting with the user

Chapter 7
Managing Information

©

REMEMBER

hether you use the term information or data to refer to the content that

applications manage, the fact is that you must provide some means of

working with it or your application really doesn’t have a purpose.
Throughout the rest of the book, you see information and data used interchange-
ably because they really are the same thing, and in real-world situations, you’ll
encounter them both, so getting used to both is a good idea. No matter which term
you use, you need some means of assigning data to variables, modifying the con-
tent of those variables to achieve specific goals, and comparing the result you
receive with desired results.

Also essential is to start working through methods of keeping your code under-
standable. Yes, you could write your application as a really long procedure, but
trying to understand such a procedure is incredibly hard, and you’d find yourself
repeating some steps because they must be done more than once. Functions are
one way for you to package code so that you can more easily understand and reuse
as needed.

Applications also need to interact with the user. Yes, some perfectly usable appli-
cations exist that don’t really interact with the user, but they’re rare. To provide a
useful service, most applications interact with the user to discover how the user
wants to manage data.

You don’t have to type the source code for this chapter manually. In fact, using the
downloadable source is a lot easier. You can find the source for this chapter in the
BPP4D3E; O7; Managing Information.ipynb file of the downloadable source. See
the Introduction for details on how to find these source files.
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Controlling How Python Views Data

As discussed in Chapter 6, all data on your computer is stored as 0s and 1s. The
computer doesn’t understand the concept of letters, Boolean values, dates, times,
or any other kind of information except numbers. In addition, a computer’s capa-
bility to work with numbers is both inflexible and relatively simplistic. When you
work with a string in Python, you depend on Python to translate the concept of a
string into a form the computer can understand. The storage containers that your
application creates and uses in the form of variables tell Python how to treat the 0s
and 1s that the computer has stored. The Python view of data isn’t the same as
your view of data or the computer’s view of data — Python acts as an intermediary

to make your applications functional.

To manage data within an application, the application must control the way in
which Python views the data. The use of operators, packaging methods such as
functions, and the introduction of user input all help applications control data. All
rememeer  these techniques rely, in part, on making comparisons. Determining what to do
next means understanding what state the data is in now as compared to some

other state.

Making comparisons

Python uses operators to make comparisons. In fact, operators play a major role in
manipulating data as well. The upcoming “Working with Operators” section dis-
cusses how operators work and how you can use them in applications to control
data in various ways. Later chapters use operators extensively as you discover
techniques for creating applications that can make decisions, perform tasks

repetitively, and interact with the user in interesting ways.

In some cases, you use some fancy methods to perform comparisons (the strict
measuring of one value or one result against another) in an application. For exam-
ple, you can compare the output of two functions (as described in the “Comparing
function output” section, later in this chapter). With Python, you can perform
comparisons at a number of levels so that you can manage data without a problem
in your application. Using these techniques hides detail so that you can focus on
the point of the comparison and define how to react to that comparison. Your
choice of techniques to perform comparisons affects the manner in which Python
views the data and determines the sorts of things you can do to manage the data
after the comparison is made. Applications require comparisons to interact with

data correctly.
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Understanding how computers make
comparisons

Computers don’t understand packaging, such as functions, or any of the other
structures that you create with Python. All this packaging is for your benefit, not
the computer’s. However, computers do directly support the concept of operators
at the processor level. Most Python operators have a direct corollary with a com-
mand that the computer understands directly. For example, when you ask whether
one number is greater than another number, the computer can actually perform
this computation directly, using its hardware.

Some comparisons aren’t direct. Computers work only with numbers. So, when
you ask Python to compare two strings, what Python actually does is compare the
numeric value of each character in the string. For example, the letter A is actually
the number 65 in the computer. A lowercase letter a has a different numeric
value — 97. Consequently, the computer sees ABC as different from abc because
the numeric values of their individual letters are different.

Working with Operators

©

REMEMBER

Operators are the basis for both control and management of data within applica-
tions. You use operators to define how one piece of data is compared to another
and to modify the information within a single variable. In fact, operators are
essential to performing any sort of math-related task and to assigning data to
variables in the first place.

When using an operator, you must supply either a variable or an expression. You
already know that a variable is a kind of storage box used to hold data. An expres-
sion is an equation or formula that provides a description of a mathematical con-
cept. In most cases, the result of evaluating an expression is a Boolean (true or
false) value. The following sections describe operators in detail because you use
them everywhere throughout the rest of the book.

Defining the operators

An operator accepts one or more inputs in the form of variables or expressions,
performs a task (such as comparison or addition), and then provides an output
consistent with that task. Operators are classified partially by their effect and par-
tially by the number of elements they require. For example, a unary operator
works with a single variable or expression; a binary operator requires two; a ter-
nary operator requires three. Python doesn’t support anything above three because
that would really be ridiculous (and possibly confusing).
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the left side of the operator is called the left operand, while the operand on the
right side of the operator is called the right operand (ternary operators are special,

rememeer  as you find out in the “Understanding Python’s one ternary operator” sidebar, so
don’t worry about it for now). The following list shows the categories of operators
that you use within Python:

@ The elements provided as input to an operator are called operands. The operand on

¥ Unary

¥ Arithmetic
¥ Relational
¥ Logical

¥ Bitwise

¥ Assignment
3 Membership
¥ Identity

Each of these categories performs a specific task. For example, the arithmetic
operators perform math-based tasks, while relational operators perform
comparisons. The following sections describe the operators based on the category
in which they appear.

UNDERSTANDING PYTHON'S
ONE TERNARY OPERATOR

A ternary operator requires three elements. Python supports just one such operator,
and you use it to determine the truth value of an expression. This ternary operator
takes the following form (it apparently has no actual name, but you can call it the

if. . .else operator if desired):

TrueValue if Expression else FalseValue

When the Expression is true, the operator outputs TrueValue. When the expression
is false, it outputs FalseValue. As an example, if you type

"Hello" if True else "Goodbye"
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the operator outputs a response of 'Hello'. However, if you type
"Hello" if False else "Goodbye"

the operator outputs a response of 'Goodbye'. This is a handy operator for times
when you need to make a quick decision and don't want to write a lot of code to do it.

One of the advantages of using Python is that it normally has more than one way to do
things. Python has an alternative form of this ternary operator — an even shorter short-
cut. It takes the following form:

(FalseValue, TrueValue) [Expression]
As before, when Expression is true, the operator outputs TrueValue; otherwise, it
outputs FalseValue. Notice that the TrueValue and FalseValue elements are
reversed in this case. An example of this version is

("Hello", "Goodbye")[True]
In this case, the output of the operator is 'Goodbye' because that's the value in the

TrueValue position. Of the two forms, the first is a little clearer, while the second is
shorter.

Unary

The unary operators shown in Table 7-1 require a single variable or expression as

input. You often use these operators as part of a decision-making process.

TABLE 7-1 Python Unary Operators
Operator Description Example
~ Inverts the bits in a number so that all the 0 bits become 1 bitsand  ~4 results in a value of -5
vice versa.
- Negates the original value so that positive becomes negative and —(-4) resultsin 4 and -4
vice versa. results in -4
+ Is provided purely for the sake of completeness. This operator +4 results in a value of 4

returns the same value that you provide as input.
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Arithmetic

The complex math tasks that Python performs are often based on much simpler
math tasks, such as addition, as shown in Table 7-2. You can always create your
own libraries of math functions using these simple operators as well.

TABLE 7-2 Python Arithmetic Operators

Operator Description Example
+ Adds two values together 5+2=7

- Subtracts the right operand from the left operand 5-2=3

* Multiplies the right operand by the left operand 5*2=10
/ Divides the left operand by the right operand 5/2=25
% Divides the left operand by the right operand and returns the remainder 5%2=1
*k Calculates the exponential value of the left operand raised to the power of the 5**%2=25

right operand
// Performs integer division, in which the left operand is divided by the right oper-  5//2=2

and and only the whole number is returned (also called floor division)

Relational

The relational operators compare one value to another and tell you when the
relationship you’ve provided is true as shown in Table 7-3. For example, 1 is less
than 2, but 1 is never greater than 2.

Logical

The logical operators shown in Table 7-4 combine the true or false value of vari-
ables or expressions so that you can determine their resultant truth value. You use
the logical operators to create Boolean expressions that help determine whether to
perform tasks.

Bitwise

The bitwise operators shown in Table 7-5 interact with the individual bits in a
number. For example, the number 6 is actually 0bo110 in binary. A bitwise opera-
tor would interact with each bit within the number in a specific way. When work-
ing with a logical bitwise operator, a value of 0 counts as false and a value of 1
counts as true.
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TABLE 7-3 Python Relational Operators
Operator Description Example

== Determines whether two values are equal. Notice that the relational operator 1==2is
uses two equals signs. A mistake many developers make is using just one equals False
sign, which results in one value being assigned to another.

1= Determines whether two values are not equal. Some older versions of Python 11=2is
allowed you to use the <> operator in place of the |= operator. Using the <> oper-  True
ator results in an error in current versions of Python.

> Verifies that the left operand value is greater than the right operand value. 1>2is
False
< Verifies that the left operand value is less than the right operand value. 1<2is
True
>= Verifies that the left operand value is greater than or equal to the right operand 1>=2is
value. False
<= Verifies that the left operand value is less than or equal to the right operand 1<=2is
value. True
TABLE 7-4 Python Logical Operators
Operator Description Example
and Determines whether both operands are true. True and True is True

True and False is False
False and True is False

False and False is False

or Determines when one of two operands is true. True or True is True
True or False is True
False or True is True

False or False is False

not Negates the truth value of a single operand. A true value not True is False

becomes false and a false value becomes true. .
not False is True
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TABLE 7-5 Python Bitwise Operators

Operator Description Example

& (And) Determines whether both individual bits within two operands are 0b1100 & 0b0110 =
true and sets the resulting bit to true when they are. 0b0100

| (Or) Determines whether either of the individual bits within two operands  0b1100 | 0b0110 =
is true and sets the resulting bit to true when one of them is. 0b1110

A (Exclusive or)  Determines whether just one of the individual bits within two 0b1100 A 0b0110 =
operands is true and sets the resulting bit to true when one is. 0b1010

When both bits are true or both bits are false, the result is false.

~ (One's Calculates the one’s complement value of a number. ~0b1100 =-0b1101

complement) ~0b0110 =-0b0111

<< (Left shift) Shifts the bits in the left operand left by the value of the right 0b00110011 << 2 =
operand. All new bits are set to 0 and all bits that flow off the end 0b11001100
are lost.

>> (Right shift) Shifts the bits in the left operand right by the value of the right 0b00110011>>2=
operand. All new bits are set to 0 and all bits that flow off the end 0b00001100
are lost.
Assignment

The assignment operators shown in Table 7-6 place data within a variable, MyVar,
which has a starting value of 5. The simple assignment operator appears in previ-
ous chapters of the book, but Python offers a number of other interesting assign-
ment operators that you can use. These other (compound) assignment operators
can perform mathematical tasks during the assignment process, which makes it
possible to combine assignment with a math operation.

Membership

The membership operators shown in Table 7-7 detect the appearance of a value
within a list or sequence and then output the truth value of that appearance. Think
of the membership operators as you would a search routine for a database. You
enter a value that you think should appear in the database, and the search routine
finds it for you or reports that the value doesn’t exist in the database.

Identity

The identity operators shown in Table 7-8 determine whether a value or expres-
sion is of a certain class or type. You use identity operators to ensure that you’re
actually working with the sort of information that you think you are.
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and points to a different type than the value or expression in the left
operand.

TABLE 7-6 Python Assignment Operators
Operator Description Example
= Assigns the value found in the right operand to the left operand. MyVar = 5 results in
MyVar containing 5
+= Adds the value found in the right operand to the value found in the MyVar += 2 results in
left operand and places the result in the left operand. MyVar containing 7

—= Subtracts the value found in the right operand from the value found MyVar —= 2 results in
in the left operand and places the result in the left operand. MyVar containing 3

*= Multiplies the value found in the right operand by the value found in MyVar *= 2 results in
the left operand and places the result in the left operand. MyVar containing 10

/= Divides the value found in the left operand by the value found in the MyVar /= 2 results in
right operand and places the result in the left operand. MyVar containing 2.5

%= Divides the value found in the left operand by the value found in the MyVar %= 2 results in
right operand and places the remainder in the left operand. MyVar containing 1

*k= Determines the exponential value found in the left operand when MyVar **= 2 results in
raised to the power of the value found in the right operand and places  MyVar containing 25
the result in the left operand.

//= Divides the value found in the left operand by the value found in the MyVar //= 2 results in
right operand and places the integer (whole number) result in the left ~ MyVar containing 2
operand.

TABLE 7-7 Python Membership Operators

Operator Description Example

in Determines whether the value in the left operand appears in the “Hello” in “Hello Good-
sequence found in the right operand. bye” is True

not in Determines whether the value in the left operand is missing from “Hello” not in “Hello
the sequence found in the right operand. Goodbye" is False

TABLE 7-8 Python Identity Operators

Operator Description Example

is Evaluates to true when the type of the value or expression in the right oper-  type(2) is intis
and points to the same type in the left operand. True

is not Evaluates to true when the type of the value or expression in the right oper-  type(2) is not int

is False

CHAPTER 7 Managing Information

115



Understanding operator precedence

When you create simple statements that contain just one operator, the order of
determining the output of that operator is also simple. However, when you start
working with multiple operators, it becomes necessary to determine which oper-
ator to evaluate first. For example, you should know whether 1+ 2 * 3 evaluates to
7 (where the multiplication is done first) or 9 (where the addition is done first). An
order of operator precedence tells you that the answer is 7 unless you use paren-
theses to override the default order. In this case, (1 + 2) * 3 would evaluate to 9
because the parentheses have a higher order of precedence than multiplication
does. Table 7-9 defines the order of operator precedence for Python.

TABLE 7-9 Python Operator Precedence

Operator(s) Description

0 You use parentheses to group expressions and to override the default precedence
so that you can force an operation of lower precedence (such as addition) to take
precedence over an operation of higher precedence (such as multiplication).

*k Exponentiation raises the value of the left operand to the power of the right operand.

~ o+ = Unary operators interact with a single variable or expression.

x /% // Multiply, divide, modulo, and floor division.

+ - Addition and subtraction.

5y << Right and left bitwise shift.

& Bitwise AND.

A Bitwise exclusive OR and standard OR.

<= < > >= Comparison operators.

== I= Equality operators.

= %= /= //= - Assignment operators.

+= k= k=

is Identity operators.

is not

in Membership operators.

not in

not or and

Logical operators.
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Creating and Using Functions

©

REMEMBER

To manage information properly, you need to organize the tools used to perform
the required tasks. Each line of code that you create performs a specific task, and
you combine these lines of code to achieve a desired result. Sometimes you need
to repeat the instructions with different data, and in some cases your code becomes
so long that keeping track of what each part does is hard. Functions serve as orga-
nization tools that keep your code neat and tidy. In addition, functions make it
easy to reuse the instructions you’ve created as needed with different data. This
section of the chapter tells you all about functions.

Viewing functions as code packages

You go to your closet, open the door, and everything spills out. In fact, it’s an
avalanche, and you’re lucky that you’ve survived. That bowling ball in the top
shelf could have done some severe damage! However, you’re armed with storage
boxes and soon you have everything in the closet in neatly organized boxes. After
you’re done, you can find anything you want in the closet without fear of injury.
Functions are just like that: They take messy code and place it in packages that
make it easy to see what you have and understand how it works.

Understanding code reusability

You go to your closet, take out new pants and shirt and put them on. At the end of
the day, you take everything off and throw it in the trash. Hmmm . . . That really
isn’t what most people do. Most people take the clothes off, wash them, and then
put them back into the closet for reuse. Functions are reusable, too. No one wants
to keep repeating the same task; it becomes monotonous and boring. When you
create a function, you define a package of code that you can use over and over to
perform the same task. All you need to do is tell the computer to perform a specific
task by telling it which function to use.

When you work with functions, the code that needs services from the function is
named the caller, and it calls upon the function to perform tasks for it. Much of the
information you see about functions refers to the caller. The caller must supply
information to the function, and the function returns information to the caller.

At one time, computer programs didn’t include the concept of code reusability. As
a result, developers had to keep reinventing the same code. It didn’t take long for
someone to come up with the idea of functions, though, and the concept has
evolved over the years until functions have become quite flexible. You can make
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functions do anything you want. Code reusability is a necessary part of applica-
tions to

»
»
»
»
»
»

Reduce development time

Reduce programmer error

Increase application reliability

Allow entire groups to benefit from the work of one programmer
Make code easier to understand

Improve application efficiency

Defining a function

Creating a function doesn’t require much work. The following steps show you the
process of creating a function that you can later access:

1.

Create a new notebook in Notebook.

The book uses the filename BPP4D3E; ©7; Managing Information.ipynb,
which is where you find all the source code for this chapter. See the
Introduction for information on using the downloadable source.

Type def Hello(): and press Enter.

This step tells Python to define a function named Hello. The parentheses are
important because they define any requirements for using the function. (There
aren't any requirements in this case.) The colon at the end tells Python that
you're done defining the way in which people will access the function. Notice
that the insertion pointer is now indented, as shown in Figure 7-1. This
indentation is a reminder that you must give the function a task to perform.

FIGURE 7-1:
Define the name
of your function.

~ Creating and Using Functions

= Defining a function

o~ o8 % U8
# 2. Type def Hello(): and press Enter.
def Hello():

3.

Type print(“This is my first Python function!”) and press Enter.

You should notice something special. The insertion pointer is still indented
because Notebook is waiting for you to provide the next step in the function.
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FIGURE 7-2:
Whenever you
type the
function’s name,
you get the
output the
function
provides.

4. Click Run Cell.

The function is now complete.

Even though this is a really simple function, it demonstrates the pattern you use
when creating any Python function. You define a name, provide any requirements
for using the function (none in this case), and provide a series of steps for the
function to perform. A function ends when the insertion point is at the left side or
you move to the next cell.

Accessing functions

After you define a function, you probably want to use it to perform useful work. Of
course, this means knowing how to access the function. In the previous section,
you create a new function named Hello(). To access this function, you type
Hello() and click Run Cell. Figure 7-2 shows the output you see when you execute
this function.

~ Accessing functions

T c B HEE

< ) Hello()

This is my first Python function!

Every function you create provides a similar pattern of usage. You type the func-
tion name, an open parenthesis, any required input, and a closed parenthesis;
then you click Run Cell. In this case, you have no input, so all you type is Hello().

Sending information to functions

The Hello() example in the previous section is nice because you don’t have to
keep typing that long string every time you want to say Hello(). However, it’s
also quite limited because you can use it to say only one thing. Functions should
allow you to do more than just one thing. Otherwise, you end up writing a lot of
functions that vary by the data they use rather than the functionality they provide.
Using arguments helps you create functions that are flexible and can use a wealth
of data.
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Understanding arguments

The term argument doesn’t mean that you’re going to have a fight with the func-
tion; it means that you supply information to the function to use in processing a
request. Perhaps a better word for it would be input, but the term input has been
used for so many other purposes that developers decided to use something a bit
different: argument. An argument makes it possible for you to send data to the
function so that the function can use it when performing a task, making your
function more flexible.

TheHello() function is currently inflexible because it prints just one string. Add-
ing an argument to the function can make it a lot more flexible because you can
send strings to the function to say anything you want. To see how arguments
work, create a new function in the notebook. This version of Hello(), Hello2(),
requires an argument:

def Hello2(Greeting):
print(Greeting)

Notice that the parentheses are no longer empty. They contain a word, Greeting,
which is the argument for Hel1lo2( ). The Greeting argument is a variable that
you can pass to print() to see it onscreen.

Make sure you click Run Cell after you create Hel102( ) or you will get a NameError
message when you try to use the function in the next section.

REMEMBER
Sending required arguments
You have a new function, Hello2( ). This function requires that you provide an
argument to use it. At least, that’s what you’ve heard so far. Type Hello2() and
click Run Cell. You see an error message, as shown in Figure 7-3, telling you that
Hello2() requires an argument.
~ Sending required arguments
+ oA %dN
© O nslioa() |
TypeEreor ' Traceback (most recent call Last)
FIGURE 7-3: <ipython-input-5-62b@788617ba> in <module>()
----» 1 Hello2()
You must supply '
an argument or TypeError: Hello2() missing 1 required positional argument: 'Greeting®
you get an error Ao S OO
message.
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REMEMBER

Not only does Python tell you that the argument is missing, it tells you the name
of the argument as well. Creating a function the way you have done so far means
that you must supply an argument. Type Hello2(“This is an interesting func-
tion.”) and click Run Cell. (Note that if you’re using Jupyter Notebook, you auto-
matically advance to the next cell after clicking Run Cell.) This time, you see the
expected output. However, you still don’t know whether Hello2() is flexible
enough to print multiple messages. Press Enter (as needed) to start another line,
type Hello2(“Another message. . .”), and click Run Cell. You see the expected out-
put again, so Hello2() is indeed an improvement over Hello().

You might easily assume that Greeting will accept only a string from the tests
you have performed so far. Create a new cell (if necessary). Type Hello2(1234),
click Run Cell, and you see 1234 as the output. Likewise, type Hello2(5 + 5) in a
new cell, and click Run Cell. This time you see the result of the expression,
which is 10.

Sending arguments by name

As your functions become more complex and the methods to use them do as well,
you may want to provide a little more control over precisely how you call the func-
tion and provide arguments to it. Up until now, you have positional arguments,
which means that you have supplied values in the order in which they appear in
the argument list for the function definition. However, Python also has a method
for sending arguments by name. In this case, you supply the name of the argu-
ment followed by an equals sign (=) and the argument value. To see how this
works, type the following function in the notebook and run it:

def AddIt(Valuel, Value2):
print(Valuel, " + ", Value2, " =", (Valuel + Value2))

Notice that the print() function argument includes a list of items to print and
that those items are separated by commas. In addition, the arguments are of dif-
ferent types. Python makes it easy to mix and match arguments in this manner.

Time to test AddIt(). Of course, you want to try the function using positional
arguments first, so type AddIt(2, 3) in a new cell and click Run Cell. You see the
expected output of 2 + 3 = 5. Now type AddIt(Value2 = 3, Value1 = 2) and click
Run Cell. Again, you receive the output 2 + 3 = 5 even though the positions of the
arguments have been reversed.

Giving function arguments a default value

Whether you make the call using positional arguments or named arguments, the
functions to this point have required that you supply a value. Sometimes a
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FIGURE 7-4:
Supply default
arguments when
possible to make
your functions
easier to use.

function can use default values when a common value is available. Default values
make the function easier to use and less likely to cause errors when a developer
doesn’t provide an input. To create a default value, you simply follow the argu-
ment name with an equals sign and the default value. To see how this works, type
the following function in a new cell of the notebook and click Run Cell:

def Hello3(Greeting = "No Value Supplied"):
print(Greeting)

This is yet another version of the original Hello() and updated Hello2() func-
tions, but He1103() automatically compensates for individuals who don’t supply
a value. When someone tries to call Hello3() without an argument, it doesn’t
raise an error. Type Hello3() and click Run Cell to see for yourself. Type
Hello3(“This is a string.”) and click Run Cell to see a normal response. Lest you
think the function is now unable to use other kinds of data, type Hello3(5) and
click Run Cell; then Hello3(2 + 7) and click Run Cell. Figure 7-4 shows the output
from all these tests.

~ Giving function arguments a default value

' [18] def Hello3(Greeting = "Mo Value Supplied”):
print(Gresting)
T e 8% EE
) Helloz()
Hello3("This is a string”)
Hello3(5)
Hello3(2 + 7)

No Value Supplied
This is a string
5

9

Creating functions with a variable
number of arguments

In most cases, you know precisely how many arguments to provide with your
function. It pays to work toward this goal whenever you can because functions
with a fixed number of arguments are easier to troubleshoot later. However,
sometimes you simply can’t determine how many arguments the function will
receive at the outset. For example, when you create a Python application that
works at the command line, the user might provide no arguments, the maximum
number of arguments (assuming there is more than one), or any number of argu-
ments in between.

Fortunately, Python provides a technique for sending a variable number of argu-
ments to a function. You simply create an argument that has an asterisk in front
of it, such as xVarArgs. The usual technique is to provide a second argument that
contains the number of arguments passed as an input. However, you can
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FIGURE 7-5:
Variable
argument
functions can
make your
applications more
flexible.

eliminate the second argument and simply use the len() function to obtain the
number of arguments passed to the function. Here is an example of a function that
can print a variable number of elements. (Don’t worry too much if you don’t
understand it completely now — you haven’t seen some of these techniques used
before.)

def Hello4(ArgCount, *VarArgs):
print("You passed ", ArgCount,
for Arg in VarArgs:
print(Arg)

n

arguments.")

This example uses something called a for loop (described in Chapter 9). For now,
all you really need to know is that it takes the arguments out of VarArgs one at a
time, places the individual argument into Arg, and then prints Arg using print().
After you type the code, click Run Cell.

In a new cell, type Hello4(1, “A Test String.”) and click Run Cell. You should see
the number of arguments and the test string as output — nothing too exciting
there. In the next new cell type Hello4(3, “One”, “Two”, “Three”) and click Run
Cell. As shown in Figure 7-5, the function handles a variable number of argu-
ments without problem.

~ Creating functions with a variable number of arguments

4(ArgCount, *VarArgs):

print("You passed ", ArgCount, "

for Arg in VarArgs:
print{Arg)

arguments.™)

“ [13] Hello4(1l, "A Test String.")
You passed 1 arguments.
A Test String.
T B R E W
7 @) Helloa(s, "One”, "Two",

You passed 3 arguments.
One
Two
Three

Returning information from functions

Functions can display data directly or they can return the data to the caller so that
the caller can do something more with it. In some cases, a function displays data
directly as well as returns data to the caller, but more commonly, a function either
displays the data directly or returns it to the caller. Just how a function works
depends on the task the function is supposed to perform; a function that performs
a math-related task is more likely to return the data to the caller than other
functions.
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To return data to a caller, a function needs to include the keyword return, fol-
lowed by the data to return. You have no limit on what you can return to a caller.
Here are some types of data that you commonly see returned by a function to a
caller:

¥ Values: Any value is acceptable. You can return numbers, such as 1 or 2.5;
strings, such as “Hello There!”; or Boolean values, such as True or False.

¥ Variables: The content of any variable works just as well as a direct value.
The caller receives whatever data is stored in the variable.

3 Expressions: Many developers use expressions as a shortcut. For example,
you can simply return A + B rather than perform the calculation, place the
result in a variable, and then return the variable to the caller. Using the
expression is faster and accomplishes the same task.

3 Results from other functions: You can actually return data from another
function as part of the return of your function.

It’s time to see how return values work. Type the following code into the notebook
and click Run Cell:

def DoAdd(Valuel, Value2):
return Valuel + Value2

This function accepts two values as input and then returns the sum of those
two values. Yes, you could probably perform this task without using a function,
but this is how many functions start. To test this function, type print(“The sum
of 3 + 4 is ”’, DoAdd(3, 4)) in a new cell and click Run Cell. You see The sum of
3+ 4 is 7.

Comparing function output

You use functions with return values in a number of ways. For example, the previ-
ous section of this chapter shows how you can use functions to provide input for
another function. You use functions to perform all sorts of tasks. One of the ways
to use functions is for comparison purposes. You can actually create expressions
from them that define a logical output.

To see how this might work, use the DoAdd() function from the previous section.
Type print(“3 + 4 equals 2 + 5 is ”, (DoAdd(3, 4) == DoAdd(2, 5))) and click Run
Cell. You see the truth value of the statement that 3 + 4 equals 2 + 5, as shown in
Figure 7-6.
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FIGURE 7-6:
Use your
functions to
perform a wide

~ Comparing function output

° print("3 + 4 equals 2 + 5 is ",

3+ 4 equals 2 + 5 is True

(DoAdd(3,4)==DoAdd(2,5)))

T i i |

variety of tasks.

Getting User Input

Very few applications exist in their own world — that is, apart from the user. In
fact, most applications interact with users in a major way because computers are
designed to serve user needs. To interact with a user, an application must provide
some means of obtaining user input. The most commonly used technique for
obtaining input is also relatively easy to implement; you use the input () function.

The input () function always outputs a string. Even if a user types a number, the
output from the input () function is a string. This means that if you are expecting
a number, you need to convert it after receiving the input. The input() function

REMEMBER
what to provide in the way of information. The following example shows how to
use the input() function in a simple way:
Name = input("Tell me your name: ")
print("Hello ", Name)
In this case, the input () function asks the user for a name. After the user types a
name and presses Enter, the example outputs a customized greeting to the user.
Try running this example. Figure 7-7 shows typical results when you input John
as the username.
~ Getting User Input
FIGURE 7-7: Pl BB
Provide a £("Tell me your name: “)

» Mame}l

username and
see a greeting as
output.

Tell me your name: John
Helle John

also lets you provide a string prompt. This prompt is displayed to tell the user

You can use input () for other kinds of data; all you need is the correct conversion
function. The code in the following example provides one technique for perform-

ing such a conversion:

ANumber = float(input("Type a number: "))

print("You typed: ", ANumber)
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When you run this example, the application asks for a numeric input. The call to
float() converts the input to a number. After the conversion, print() outputs
the result. When you run the example using a value such as 5.5, you obtain the
desired result.

Understand that data conversion isn’t without risk. If you attempt to type some-
& thing other than a number, you get an error message, as shown in Figure 7-8.
Chapter 10 helps you understand how to detect and fix errors before they cause the

WARNING  program to crash.

+ EICE- TN

t(input("Type a number: ")) I
ped: ™, ANumber)

Type a number: Hello

FIGURE 7-8: —
. ValueError Traceback (most recent call last)
Data conversion <ipython-input-21-7a945e619268> in <module>()
Changes the input ----» 1 AMumber = float(input("Type a number: "))
wpe to whatever 2 print({"You typed: ", ANumber)
you need, but ValueError: could not convert string to float: "Hello'
could cause
SEARCH STACK OVERFLOW
errors.
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IN THIS CHAPTER

» Using the i f statement to make
simple decisions

» Making advanced decisions using
if...else

» Nesting statements

Chapter S
Making Decisions

©
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he ability to make a decision, to take one path or another, is an essential

element of performing useful work. Math gives the computer the capability

to obtain useful information. Decisions enable you to do something with the
information after obtaining it. Without the capability to make decisions, a com-
puter would be useless. So any language you use will include the capability to
make decisions in some manner. This chapter explores the techniques that Python
uses to make decisions.

Think through the process you use when making a decision. You obtain the actual
value of something, compare it to a desired value, and then act accordingly. For
example, when you see a signal light and see that it’s red, you compare the red
light to the desired green light, decide that the light isn’t green, and then stop
(well, you stop if you aren’t being chased by someone). Most people don’t take
time to consider the process they use because they use it so many times every day.
Decision making comes naturally to humans, but computers must perform the
following tasks every time:

1. obtain the actual or current value of something.
2. Compare the actual or current value to a desired value.

3. Perform an action that corresponds to the desired outcome of the
comparison.
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You don’t have to type the source code for this chapter manually. In fact, using the
downloadable source is a lot easier. You can find the source for this chapter in
the BPP4D3E; ©8; Making Decisions.ipynb file of the downloadable source. See
the Introduction for details on how to find these source files.

Making Simple Decisions by
Using the if Statement

128

©

REMEMBER

The if statement is the easiest method for making a decision in Python. It simply
states that if something is true, Python should perform the steps that follow. The
following sections tell you how you can use the i f statement to make decisions of
various sorts in Python. You may be surprised at what this simple statement can
do for you.

Understanding the if statement

You use if statements regularly in everyday life. For example, you may say to
yourself, “If it’s Wednesday, I'll eat tuna salad for lunch.” The Python if state-
ment is a little less verbose, but it follows precisely the same pattern. Say you
create a variable, TestMe, and place a value of 6 in it, like this:

TestMe = 6
You can then ask the computer to check for a value of 6 in TestMe, like this:

if TestMe ==
print("TestMe does equal 6!")

Every Python if statement begins, oddly enough, with the word if. When Python
sees if, it knows that you want it to make a decision. After the word if comes a
condition. A condition simply states what sort of comparison you want Python to
make. In this case, you want Python to determine whether TestMe contains the
value 6.

Notice that the condition uses the relational equality operator, ==, and not the
assignment operator, =. A common mistake that developers make is to use the
assignment operator rather than the equality operator. You can see a list of rela-
tional operators in Chapter 7.
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The condition always ends with a colon (:). If you don’t provide a colon, Python
doesn’t know that the condition has ended and will continue to look for additional
conditions on which to base its decision. After the colon come any tasks you want
Python to perform. In this case, Python prints a statement saying that TestMe is
equal to 6.

Using the if statement in an application

You can use the i f statement in a number of ways in Python. However, you imme-
diately need to know about three common ways to use it:

¥ Use a single condition to execute a single statement when the condi-
tion is true.

¥ Use a single condition to execute multiple statements when the condition
is true.

3 Combine multiple conditions into a single decision and execute one or more
statements when the combined condition is true.

The following sections explore these three possibilities and provide you with
examples of their use. You see additional examples of how to use the i f statement
throughout the book because it’s such an important method of making decisions.

Working with relational operators

A relational operator determines how a value on the left side of an expression com-
pares to the value on the right side of an expression. After it makes the determi-
nation, it outputs a value of true or false that reflects the truth value of the
expression. For example, 6 == 6 is true, while5 == 6 is false. Table 7-3 in
Chapter 7 lists the relational operators. The following steps show how to create
and use an i f statement.

1. Open a new notebook.

You can also use the downloadable source file, BPP4D3E; ©8; Making
Decisions. ipynb.

2. Type TestMe = 6 and press Enter.

This step assigns a value of 6 to TestMe. Notice that it uses the assignment
operator and not the equality operator.
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3. Typeif TestMe == 6: and press Enter.

This step creates an i f statement that tests the value of TestMe by using the
equality operator. You should notice two features of Notebook at this point:

The word if is highlighted in a different color than the rest of the statement.
The next line is automatically indented.
4. Typeprint("TestMe does equal 6!").

Notice that the word print appears in a special color because it's a function
name. In addition, the text appears in another color to show you that it's a
string value. Color coding makes it much easier to see how Python works.

5. click Run Cell.

Notebook executes the i f statement, as shown in Figure 8-1. Because TestMe
contains a value of 6, the i f statement works as expected.

~ Using the if statement in an application
FIGURE 8-1:

Simple i f
statements can ~ Working with relational operators
help your R
application know |/ @ Testie = ¢
B if TestMe == 6:
what to do in print(
certain
conditions.

e does equal 6!™)

TestHe does equal 6!

Performing multiple tasks

Sometimes you want to perform more than one task after making a decision.
Python relies on indentation to determine when to stop executing tasks as part of
an if statement. As long as the next line is indented, it’s part of the i f statement.
When the next line is outdented, it becomes the first line of code outside the i f
block. A code block consists of a statement and the tasks associated with that state-
ment. The same term is used no matter what kind of statement you’re working
with, but in this case, you’re working with an i f statement that is part of a code
block. The following steps show how to use indentation to execute multiple steps
as part of an i f statement.

1. Type the following code into a new cell in the notebook — pressing Enter
after each line:

TestMe = 6

if TestMe == 6:
print("TestMe does equal 6!")
print("All done!")
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FIGURE 8-2:

A code block can
contain multiple
lines of code —
one for each task.
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Notice that the shell continues to indent lines as long as you continue to type
code. Each line you type is part of the current i f statement code block.

2. Cclick Run Cell.

Python executes the entire code block. You see the output shown in Figure 8-2.

= Performing multiple tasks

T+ CH=-E-N'N B

< ) Testie - 8
if TestMe
print
print("All

e does equal 6!™)
done!™)

TestMe does equal 6!
All done!

Making multiple comparisons by
using logical operators

So far, the examples have all shown a single comparison. Real life often requires
that you make multiple comparisons to account for multiple requirements. For
example, when baking cookies, if the timer has gone off and the edges are brown,
it’s time to take the cookies out of the oven.

To make multiple comparisons, you create multiple conditions by using relational
operators and combine them by using logical operators (see Table 7-4 in
Chapter 7). A logical operator describes how to combine conditions. For example,
you might sayx == 6 and y == 7 as two conditions for performing one or more
tasks. The and keyword is a logical operator that states that both conditions must
be true.

One of the most common uses for making multiple comparisons is to determine
when a value is within a certain range. In fact, range checking, the act of determin-
ing whether data is between two values, is an important part of making your
application secure and user friendly. The following steps help you see how to per-
form this task.

1. Type the following code into a new cell of the notebook — pressing Enter
after each line:

Value = int(input("Type a number between 1 and 10: "))
if (Value > @) and (Value <= 10):

print("You typed: ", Value)
The example begins by obtaining an input value. You have no idea what the
user has typed other than that it's a value of some sort. The use of the int()
function means that the user must type a whole number (one without a
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The application
verifies the value

132

is in the right
range and
outputs a
message.
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decimal portion). Otherwise, the application will raise an exception (an error
indication; Chapter 10 describes exceptions). This first check ensures that the
input is at least of the correct type.

The if statement contains two conditions. The first states that Value must be
greater than @. You could also present this condition asValue >= 1.The
second condition states that Value must be less than or equal to 10. Only
when Value meets both of these conditions will the i f statement succeed and
print the value the user typed.

Click Run Cell.
Python prompts you to type a number between 1 and 10.
Type 5 and press Enter.

The application determines that the number is in the right range and outputs
the message shown in Figure 8-3.

~ Making multiple comparisons by using logical operators

o ° Value = int{input("Type & number between 1 and 1@: "))

T B EE

if (Value > @) and |(Value <|= 18):
print("You typed: ", Value)

Type & number between 1 and 18: 5
You typed: 5

The best applications use various kinds of range checking to ensure that the appli-
cation behaves in a predictable manner. The more predictable an application
becomes, the less the user thinks about the application and the more time the user
spends on performing useful work. Productive users tend to be a lot happier than

Select the cell again. Repeat Steps 2 and 3, but type 22 instead of 5.

The application doesn't output anything because the number is in the wrong
range. Whenever you type a value that's outside the programmed range, the
statements that are part of the i £ block aren't executed.

Select the cell again. Repeat Steps 2 and 3, but type 5.5 instead of 5.

Python displays the error message shown in Figure 8-4. Even though you may
think of 5.5 and 5 as both being numbers, Python sees the first number as a
floating-point value and the second as an integer.

Repeat Steps 2 and 3, but type Hello instead of 5.

Python displays about the same error message as before. Python doesn't
differentiate between types of wrong input. It knows only that the input type is
incorrect and therefore unusable.

those who constantly fight with their applications.
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FIGURE 8-4:
Typing the wrong
type of informa-
tion results in an
error message.

- B
ber between 1 and 1@: ")) I

® O volue = int(input(”
if (Value > @) and
print("You typed: ",

Type & number between 1 and 18: 5.5
ValueError Traceback (most recent call last)
<ipython-input-2-cobfa63d3691> in <module>()
----» 1 Value = int(input("Typ number between 1 and 1@: "))
2 if (Value > 0) and (Value <= 18):
3 print("You typed: ", Value)

ValueError: invalid literal for int() with base 1@: '5.5"
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Choosing Alternatives by Using
the if. . .else Statement

A

WARNING

Many of the decisions you make in an application fall into a category of choosing
one of two options based on conditions. For example, when looking at a signal
light, you choose one of two options: Press on the brake to stop or press the accel-
erator to continue (the assumption is that you won’t run the red light). The option
you choose depends on the conditions. A green light signals that you can continue
on through the light; a red light tells you to stop. The following sections describe
how Python makes choosing between two alternatives possible.

Understanding the if. . .else statement

With Python, you choose one of two alternatives by using the else clause of the i f
statement. A clause is an addition to a code block that modifies the way in which it
works. Most code blocks support multiple clauses. In this case, the else clause
enables you to perform an alternative task, which increases the usefulness of the
if statement. Most developers refer to the form of the i f statement that has the
else clause included as the i f. . .else statement, with the ellipsis implying that
something happens between i f and else.

Sometimes developers encounter problems with the i f. . . else statement because
they forget that the else clause always executes when the conditions for the if
statement aren’t met. Be sure to think about the consequences of always execut-
ing a set of tasks when the conditions are false. Sometimes doing so can lead to
unintended consequences.
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Using the if. . .else statement
in an application

The example in the previous section is a little less helpful than it could be when
the user enters a value that’s outside the intended range. Even entering data of the
wrong type produces an error message, but entering the correct type of data out-
side the range tells the user nothing. In this example, you discover the means for
correcting this problem by using an else clause. The following steps demonstrate
just one reason to provide an alternative action when the condition for an if
statement is false:

1. Type the following code into a new cell in the notebook — pressing Enter
after each line:

Value = int(input("Type a number between 1 and 10: "))
if (Value > @) and (Value <= 10):

print("You typed: ", Value)
else:

print("The value you typed is incorrect!")

As before, the example obtains input from the user and then determines
whether that input is in the correct range. However, in this case, the else
clause provides an alternative output message when the user enters data
outside the desired range.

Notice that the else clause ends with a colon, just as the i f statement does.

@ Most clauses that you use with Python statements have a colon associated
with them so that Python knows when the clause has ended. If you receive a
TP coding error for your application, make sure that you check for the presence of

the colon as needed.
2. Click Run Cell.

Python prompts you to type a number between 1 and 10.
3. Type 5 and press Enter.

The application determines that the number is in the right range and outputs
the message shown previously in Figure 8-3.

4, Repeat Steps 2 and 3, but type 22 instead of 5.

This time the application outputs the error message shown in Figure 8-5. The
user now knows that the input is incorrect and knows to try entering it again.
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FIGURE 8-5:
Providing
feedback for
incorrect input is
always a good
idea.

 Using the if...else statement in an application

© value = int(input("Type a number between 1 and 19: "))

if (value > @) and (Value <= 18):
print("You typed: ", Value)
else:

printf"The value you typed is i':-:rr:':t!")l

Type @ number between 1 and 10: 22
The value you typed is incorrect!

R -E- NN |

Type the following code into a new cell in the notebook — pressing Enter

after each line:

print("1. Red")
print("2. Orange")
print("3. Yellow")
print("4. Green")
print("5. Blue")
print("6. Purple")

Using the if. . .elif statement in an
application

You go to a restaurant and look at the menu. The restaurant offers eggs, pancakes,
waffles, and oatmeal for breakfast. After you choose one of the items, the server
brings it to you. Creating a menu selection requires something like an if. . .else
statement, but with a little extra oomph. In this case, you use the elif clause to
create another set of conditions. The elif clause is a combination of the else
clause and a separate if statement. The following steps describe how to use the
if...elif statement to create a menu.

Choice = int(input("Select your favorite color: "))

if (Choice == 1):

print("You chose Red!")
elif (Choice == 2):
print("You chose Orange!")
elif (Choice == 3):
print("You chose Yellow!")
elif (Choice == 4):
print("You chose Green!")
elif (Choice == 5):
print("You chose Blue!")
elif (Choice == 6):
print("You chose Purple!")

else:

print("You made an invalid choice!")

CHAPTER 8 Making Decisions
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FIGURE 8-6:
Menus let you
choose one
option from a list
of options.

The example begins by displaying a menu. The user sees a list of choices for
the application. It then asks the user to make a selection, which it places inside
Choice. The use of the int () function ensures that the user can't type
anything other than a number.

After the user makes a choice, the application looks for it in the list of potential
values. In each case, Choice is compared against a particular value to create a
condition for that value. When the user types 1, the application outputs the
message You chose Red!. If none of the options is correct, the else clause is
executed by default to tell the user that the input choice is invalid.

Click Run Cell.

Python displays the menu. The application asks you to select your favorite
color.

Type 1 and press Enter.

The application displays the appropriate output message, as shown in
Figure 8-6.

~ Using the if...elif statement in an application

r L oB B @R

print("1. Red")
print("2. Orange™)
print("3. Yellow™)
print("4. Green™)
print("5. Blue™)

print("6. Purple™)
Choice = int(input(“"Select your favorite color: "
if (Choice == 1):
print("You chose Red!")
elif (Choice == 2):
print("You chose Orange!™)
elif (Choice == 3):
print("You chose Yellow!™)
elif (Choice == 4):
print("You chose Green!")
elif (Choice == 5):
print("You chose Blue!")
elif (Choice == 6):
print("You chose Purple!™)
else:

-

printf"You made an invalid choice!™)

Red

. Orange

Yellow

.« @reen

. Blue

6. Purple

Select your faverite color: 1
You chose Red!

I T
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FIGURE 8-7:

Every application
you create should
include some
means of
detecting errant
input.

Repeat Steps 3 and 4, but type 5 instead of 1.

The application displays a different output message — the one associated with
the requested color.

Repeat Steps 3 and 4, but type 8 instead of 1.
The application tells you that you made an invalid choice.
Repeat Steps 3 and 4, but type Red instead of 1.

The application displays the expected error message, as shown in Figure 8-7.

Any application you create should be able to detect errors and incorrect inputs.

Chapter 10 shows you how to handle errors so that they're user friendly.

Tl oasdas
print("1. Red")
print("2. Orange")
print("3. Yellow™)
print("4. Green™)
print("5. Blue")
6. Purple™)
b (input(“Select your favorite color: ")) I
if (Choice == 1):
print("You chose Red!™)
elif (Choice == 2):
print("You chose Orange!™)
elif (Choice == 3):
print("You chose Yellow!™)
elif (Choice == 4):
print("You chose Green!™)
elif (Choice == 5):
print("You chose Blue!")
elif (Choice == &):
print("You chose Purple!™)
else:
printf"You made an invalid choice!"}}

. Red

. Orange
- Yellow
.+ Green
. Blue

. Purple
Select your favorite color:

oW e

nt call last)

ValueError Traceback (most rece
<ipython-input-3-e526lccad43cd> in <module>()

5 print({"5. Blus")

6 print{"6. Purple")
----» 7 Choice = int(input("sSelect your favorite color: "))

8 if (Choice == 1):

5 print("You chose Red!")

ValueError: invalid literal for int({) with base 1@: 'Red’
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NO SWITCH STATEMENT?

If you've worked with other languages, you might notice that Python lacks a switch
statement (if you haven't, there is no need to worry about it with Python). Developers
commonly use the switch statement in other languages to create menu-based applica-
tions. Theif...elif statementis generally used for the same purpose in Python.

However, theif...elif statement doesn't provide quite the same functionality as a
switch statement because it doesn't enforce the use of a single variable for comparison
purposes. As a result, some developers rely on Python's dictionary functionality to stand
in for the switch statement. Chapter 14 describes how to work with dictionaries. You
can also use a class approach for a switch substitute, which you can read about at
https://favtutor.com/blogs/python-switch-case. The reason the class
approach isn't covered in the book is that it's harder to implement, harder to read, and
harder to debug than using the dictionary approach.

Using Nested Decision Statements

138

The decision-making process often happens in levels. For example, when you go
to the restaurant and choose eggs for breakfast, you have made a first-level deci-
sion. Now the server asks you what type of toast you want with your eggs. The
server wouldn’t ask this question if you had ordered pancakes, so the selection of
toast becomes a second-level decision. When the breakfast arrives, you decide
whether you want to use jelly on your toast. This is a third-level decision. If you
had selected a kind of toast that doesn’t work well with jelly, you might not have
had to make this decision at all. This process of making decisions in levels, with
each level reliant on the decision made at the previous level, is called nesting.
Developers often use nesting techniques to create applications that can make
complex decisions based on various inputs. The following sections describe sev-
eral kinds of nesting you can use within Python to make complex decisions.

Using multiple if or if. . .else statements

The most commonly used multiple selection technique is a combination of i f and
if...else statements. This form of selection is often called a selection tree because
of its resemblance to the branches of a tree. In this case, you follow a particular
path to obtain a desired result. The following steps show how to create a selection
tree:
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1. Type the following code into the notebook — pressing Enter after
each line:

One = int(input("Type a number between 1 and 10: "))
Two = int(input("Type a number between 1 and 10: "))
if (One >= 1) and (One <= 10):
if (Two >= 1) and (Two <= 10):
print("Your secret number is:
else:
print("Incorrect second value!")
else:

, One x Two)

print("Incorrect first value!")

This is simply an extension of the example you see in the “Using the if. . .else
statement in an application” section of the chapter. However, notice that the
indentation is different. The second i f. . . else statement is indented within
thefirstif. . .else statement. The indentation tells Python that this is a
second-level statement.

2. Click Run Cell.

You see a Python Shell window open with a prompt to type a number between
1and 10.

3. Type 5 and press Enter.
The shell asks for another number between 1 and 10.
4, Type 2 and press Enter.

You see the combination (product) of the two numbers as output, as shown in
Figure 8-8.

~ Using Nested Decision Statements

~ Using multiple if or if...else statements

+ - E- NN
1 and 18: "
1 and 18:

“ @ one — int(input("Type a nu
Two = int( (" Type umber be
if (One >= 1) and (One <= 18):
if (Two >= 1) and (Two <= 1@):
print("Your secret number is: ", One * Two)

e

FIGURE 8-8:
Adding multiple
levels lets you
perform tasks

Type & number between 1 and 18: 5
with greater Type a number between 1 and 108: 2

Your secret number is: 19

complexity.
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This example has the same input features as the previous i f. . .else example. For
example, if you attempt to provide a value that’s outside the requested range, you
see an error message. The error message is tailored for either the first or second
input value so that the user knows which value was incorrect.

Providing specific error messages is always useful because users tend to become
confused and frustrated otherwise. In addition, a specific error message helps you
find errors in your application much faster.

Combining other types of decisions

You can use any combination of i f,if...else,andif...elif statements to pro-
duce a desired outcome. You can nest the code blocks as many levels deep as
needed to perform the required checks. For example, Listing 8-1 shows what you
might accomplish for a breakfast menu.

m Creating a Breakfast Menu

140

print("1. Eggs")
print("2. Pancakes")
print("3. Waffles")
print("4. Oatmeal")
MainChoice = int(input("Choose a breakfast item: "))
if (MainChoice == 2):
Meal = "Pancakes"
elif (MainChoice == 3):
Meal = "Waffles"
if (MainChoice == 1):
print("1. Wheat Toast")
print("2. Sour Dough")
print("3. Rye Toast")
print("4. Pancakes")
Bread = int(input("Choose a type of bread: "))
if (Bread == 1):
print("You chose eggs with wheat toast.")
elif (Bread == 2):
print("You chose eggs with sour dough.")
elif (Bread == 3):
print("You chose eggs with rye toast.")
elif (Bread == 4):
print("You chose eggs with pancakes.")
else:
print("We have eggs, but not that kind of bread.")
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elif (MainChoice == 2) or (MainChoice == 3):
print("1. Syrup")
print("2. Strawberries")
print("3. Powdered Sugar")
Topping = int(input("Choose a topping: "))
if (Topping == 1):
print ("You chose " + Meal + " with syrup.")
elif (Topping == 2):
print ("You chose " + Meal + " with strawberries.")
elif (Topping == 3):
print ("You chose " + Meal + " with powdered sugar.")
else:
print ("We have " + Meal + ", but not that topping.")
elif (MainChoice == 4):
print("You chose oatmeal.")
else:
print("We don't serve that breakfast item!")

This example has some interesting features. For one thing, you might assume that
an if...elif statement always requires an else clause. This example shows a
situation that doesn’t require such a clause. You use an if...elif statement to
ensure that Meal contains the correct value, but you have no other options to
consider.

The selection technique is the same as you saw for the previous examples. A user
enters a number in the correct range to obtain a desired result. Three of the selec-
tions require a secondary choice, so you see the menu for that choice. For example,
when ordering eggs, it isn’t necessary to choose a topping, but you do want a top-
ping for pancakes or waffles.

Notice that this example also combines variables and text in a specific way.
Because a topping can apply equally to waffles or pancakes, you need some method
for defining precisely which meal is being served as part of the output. The Meal
variable that the application defines earlier is used as part of the output after the
topping choice is made.

The best way to understand this example is to play with it. Try various menu com-
binations to see how the application works.
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IN THIS CHAPTER

» Performing a task a specific number
of times

» Performing a task until completion

» Placing one task loop within another

Chapter 9

Performing Repetitive
Tasks

11 the examples in the book so far have performed a series of steps just one

time and then stopped. However, the real world doesn’t work this way.

Many of the tasks that humans perform are repetitious. For example, the
doctor might state that you need to exercise more and tell you to do 100 push-ups
each day. If you just do one push-up, you won’t get much benefit from the exer-
cise and you definitely won’t be following the doctor’s orders. Of course, because
you know precisely how many push-ups to do, you can perform the task a specific
number of times. Python allows the same sort of repetition by using the for
statement.

Unfortunately, you don’t always know how many times to perform a task. For
example, consider needing to check a stack of coins for one of extreme rarity. Tak-
ing just the first coin from the top, examining it, and deciding that it either is or
isn’t the rare coin doesn’t complete the task. Instead, you must examine each coin
in turn, looking for the rare coin. Your stack may contain more than one. Only
after you have looked at every coin in the stack can you say that the task is com-
plete. However, because you don’t know how many coins are in the stack, you
don’t know how many times to perform the task at the outset. You only know the
task is done when the stack is gone. Python performs this kind of repetition by
using the while statement.
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Most programming languages call any sort of repeating sequence of events a loop.
The idea is to picture the repetition as a circle, with the code going round and
round executing tasks until the loop ends. Loops are an essential part of applica-
tion elements such as menus. In fact, writing most modern applications without
using loops would be impossible.

In some cases, you must create loops within loops. For example, to create a mul-
tiplication table, you use a loop within a loop. The inner loop calculates the col-
umn values and the outer loop moves between rows. You see such an example
later in the chapter, so don’t worry too much about understanding precisely how
such things work right now.

You don’t have to type the source code for this chapter manually. In fact, using the
downloadable source is a lot easier. You can find the source for this chapter in the
BPP4D3E; @9; Performing Repetitive Tasks.ipynb file of the downloadable
source. See the Introduction for details on how to find these source files.

Processing Data Using the for Statement
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The first looping code block that most developers encounter is the for statement.
It’s hard to imagine creating a conventional programming language that lacks such
a statement. In this case, the loop executes a fixed number of times, and you know
the number of times it will execute before the loop even begins. Because everything
about a for loop is known at the outset, for loops tend to be the easiest kind of loop
to use. However, in order to use one, you need to know how many times to execute
the loop. The following sections describe the for loop in greater detail.

RECURSION: ANOTHER WAY TO PERFORM
TASKS REPETITIVELY

Recursion provides a method of repeating tasks (a type of loop implementation) by using a
function that calls itself until it solves a particular problem by simplifying the original prob-
lem. It's sort of like talking to yourself until you've unraveled a problem to its simplest case,
and then you notice that people are looking at you quite strangely. Functional program-
ming languages such as Haskell get along just fine without for orwhile loops by using
recursion; seehttps: //sarakhandaker . medium.com/how—to—code-with-no-1oops-
8ed815624aae for details. Python also supports recursion as an advanced technique that
isn't covered in this book, but you can read about it athttps: //realpython.com/
python-recursion/. For the most part, when working with Python, you want to use

for and while loops to keep things simple and easy to debug.
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Understanding the for statement

A for loop begins with a for statement. The for statement describes how to per-
form the loop. The Python for loop works through a sequence of some type. It
doesn’t matter whether the sequence is a series of letters in a string or items
within a collection. You can even specify a range of values to use by specifying the
range( ) function. Here’s a simple for statement.

for Letter in "Howdy!":

The statement begins with the keyword for. The next item is a variable that holds
a single element of a sequence. In this case, the variable name is Letter. The in
keyword tells Python that the sequence comes next. In this case, the sequence is
the string "Howdy". The for statement always ends with a colon, just as the
decision-making statements described in Chapter 8 do.

Indented under the for statement are the tasks you want performed within the
for loop. Python considers every following indented statement part of the code
block that composes the for loop. Again, the for loop works just like the decision-
making statements in Chapter 8.

Creating a basic for loop

The best way to see how a for loop actually works is to create one. In this case, the
example uses a string for the sequence. The for loop processes each of the char-
acters in the string in turn until it runs out of characters.

1. Open a new notebook.

You can also use the downloadable source file, BPP4D3E; ©9; Performing
Repetitive Tasks.ipynb

2. Type the following code into the notebook — pressing Enter after
each line:

LetterNum = 1

for Letter in "Howdy!":
print("Letter ", LetterNum, " is ", Letter)
LetterNum += 1

The example begins by creating a variable, LetterNum, to track the number of

letters that have been processed. Every time the loop completes, LetterNum is
updated (incremented) by 1.
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FIGURE 9-1:
Use the for

loop to process
the characters
in a string one
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at a time.

REMEMBER

The for statement works through the sequence of letters in the string
"Howdy ! ". It places each letter, in turn, in Letter. The code that follows
displays the current LetterNum value and its associated character found in
Letter.

3. Click Run Cell.

The application displays the letter sequence along with the letter number, as
shown in Figure 9-1.

~ Processing Data Using the for Statement

~ Creating a basic for loop
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Controlling execution with
the break statement

Life is often about exceptions to the rule. For example, you might want an assem-
bly line to produce a number of clocks. However, at some point, the assembly line
runs out of a needed part. If the part isn’t available, the assembly line must stop
in the middle of the processing cycle. The count hasn’t completed, but the line
must be stopped anyway until the missing part is restocked.

Interruptions also occur in computers. You might be streaming data from an
online source when a network glitch occurs and breaks the connection; the stream
temporarily runs dry, so the application runs out of things to do even though the
set number of tasks isn’t completed.

The break clause makes breaking out of a loop possible. However, you don’t sim-
ply place the break clause in your code — you surround it with an i f statement
that defines the condition for issuing a break. The statement might say some-
thing like this: If the data stream runs dry, then break out of the loop.

In this example, you see what happens when the count reaches a certain level
when processing a string. The example is a little contrived in the interest of
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keeping things simple, but it reflects what could happen in the real world when a
data element is too long to process (possibly indicating an error condition).

1. Type the following code into a new cell in the notebook — pressing Enter
after each line:

Value = input("Type less than 6 characters: ")
LetterNum = 1
for Letter in Value:
print("Letter ", LetterNum, " is ", Letter)
LetterNum += 1
if LetterNum > 6:
print("The string is too long!")
break

This example builds on the one found in the previous section. However, it lets
the user provide a variable-length string. When the string is longer than six
characters, the application stops processing it.

The i f statement contains the conditional code. When LetterNum is greater
than 6, it means that the string is too long. Notice the second level of indentation
used for the i f statement. In this case, the user sees an error message stating
that the string is too long, and then the code executes a break to end the loop.

2. Click Run Cell.
Python displays a prompt asking for input.
3. TypeHello and press Enter.
The application lists each character in the string.
4. Pperform Steps 2 and 3 again, but type | am too long. instead of Hello.

The application displays the expected error message and stops processing the
string at character 6, as shown in Figure 9-2.

T B8 g
v ° Value = input(“"Type less than & characters: ™)
Letterhum = 1
for Letter in Value:
print("Letter , LetterNum, " is ", Letter)
Letterfum+=1
if LetterNum > 6:
print("The string is too long!™)
brEEH
FIGURE 9-2: Type less than 6 characters: I am too long.
i Letter 1 is 1T
Long Strlngs Letter 2 is
are truncated Letter 3 is &
Letter 4 is m
to ensure that Ceer = in
they remain a Letter & is t
. . The string is too long!
certain size.
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This example adds length checking to your repertoire of application data error

@ checks. Chapter 8 shows how to perform range checks, which ensure that a value

meets specific value limits. The length check is necessary to ensure that data, espe-

TIP cially strings, aren’t going to overrun the size of data fields. In addition, a small

input size makes it harder for intruders to perform certain types of hacks (such as

script injection, as described at https://www.stackhawk.com/blog/command—
injection-python/) on your system, which makes your system more secure.

Controlling execution with the
continue statement

Sometimes you want to check every element in a sequence, but don’t want to pro-
cess certain elements. For example, you might decide that you want to process all
the information for every car in a database except brown cars. Perhaps you simply
don’t need the information about that particular color of car. The break clause
simply ends the loop, so you can’t use it in this situation. Otherwise, you won’t see
the remaining elements in the sequence.

The break clause alternative that many developers use is the continue clause. As

with the break clause, the continue clause appears as part of an i f statement.

However, processing continues with the next element in the sequence rather than
rememeer  €nding completely.

The following steps help you see how the continue clause differs from the break
clause. In this case, the code refuses to process the letter w, but will process every
other letter in the alphabet.

1. Type the following code into a new cell in the notebook — pressing Enter
after each line:

LetterNum = 1
for Letter in "Howdy!":
if Letter == "w":
continue
print("Encountered w, not processed.")
print("Letter ", LetterNum, " is ", Letter)
LetterNum += 1

This example is based on the one found in the “Creating a basic for loop”

section, earlier in this chapter. However, this example adds an i f statement
with the continue clause in the i f code block.
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WARNING

FIGURE 9-3:

Use the
continue
clause to avoid
processing
specific elements.

Notice the print() function call that is part of the i f code block. You never
see this string printed because the current loop iteration ends immediately.
This kind of unreachable code is often called dead code by developers because
it just sort of sits there like a couch potato doing nothing at all. Avoid dead
code because it complicates the debugging process and makes code harder
to read and understand.

2. Cclick Run Cell.

Python displays the letter sequence along with the letter number, as shown in
Figure 9-3. However, notice the effect of the continue clause — the letter w
isn't processed.

~ Controlling execution with the continue statement
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Doing nothing with the pass statement

The Python language includes something not commonly found in other languages: a
pass clause. The pass clause tells Python to do nothing. You might wonder why a lan-
guage would include a clause that does nothing at all. Mostly, the pass clause is used
when you’re developing the logic for your application and you don’t quite know what
youw’re going to do inside an if, for, while, or other statement that isn’t complete
without code to execute. The pass clause allows you to execute your code so that you
can see the logic work without having to deal with error messages. The following steps
use an example that is similar to the one found in the previous section, “Controlling
execution with the continue statement,” except that it uses a pass clause instead.

1. Type the following code into a new cell in the notebook — pressing Enter
after each line:

LetterNum = 1
for Letter in "Howdy!":
if Letter == "w":
pass # Add some code here later to process w
print("Letter ", LetterNum, " is ", Letter)

LetterNum += 1
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2. Cclick Run Cell.

The output is similar to that shown in Figure 9-1. The pass clause simply makes
the i f statement complete in this case.

Notice how the pass clause makes it possible for this example to run even though
the i f statement would normally be considered incomplete. Using the pass clause
provides you with these advantages during development:

3 Allows you to work on the overall application first, without worrying
about details

¥ Enables you to run the code in a scaffolded form so that you can verify its
overall operation

¥ Reduces development time because you don't get involved in the detailed
work of writing the application too soon

Validating input with the else statement

Python has another loop clause that you won’t find with other languages: else.
The else clause makes executing code possible even if you have no elements to
process in a sequence. For example, you might need to convey to the user that
there simply isn’t anything to do. The else clause is always partnered with an i f
statement that’s part of the loop and matched with a break clause in this case, so
it’s an extension of the example in the “Controlling execution with the break
statement” section of the chapter. In fact, that’s what the following example does.

1. Type the following code into the notebook — pressing Enter after
each line:

Value = input("Type less than 6 characters: ")
LetterNum = 1
for Letter in Value:
print("Letter ", LetterNum, " is ", Letter)
LetterNum += 1
if (Letter == "" or Letter == Value[-1]):
break
else:

print("The string is blank.")
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FIGURE 9-4:

The else clause
enables you to
perform tasks
based on an
empty sequence.

A

WARNING

Notice the indentation levels in this case. The i f statement is indented below
the for statement, but the else clause appears at the same level of indenta-
tion as the for statement. Using the correct indentation is essential in this
situation.

The if statement also has to check for two conditions in this example:
The string is empty because the user pressed Enter.

The processing has reached the end of the string and is complete. (You
find the end of a string by using Value[-1] in this case; the “Selecting
Individual Characters” section of Chapter 12 tells you more about string
indexes.)

Click Run Cell.
Python displays a prompt asking for input.
Type Hello and press Enter.

The application lists each character in the string, as shown previously in
Figure 9-1.

Repeat Steps 2 and 3. However, simply press Enter instead of entering
any sort of text.

You see the alternative message shown in Figure 9-4 that tells you the string is
blank.

- Validating input with the else statement

70

T B8 00w

Value = input("Type less than 6 characters: ™)
Letterfium = 1
for Letter in Value:

print("Letter ", LetterNum, " is ", Letter)

LetterNumt=1

if (Letter == "" or Letter == Value[-1]):

break

else:

printf|"The string is I:'_ank“'j‘

Type less than & characters:
The string is blank.

You can easily misuse the else clause because an empty sequence doesn’t always
signify a simple lack of input. An empty sequence can also signal an application
error or other conditions that need to be handled differently from a simple omis-
sion of data. Make sure you understand how the application works with data to
ensure that the else clause doesn’t end up hiding potential error conditions,

rather than making them visible so that they can be fixed.
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while Statement
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A

WARNING

You use the while statement for situations when you’re not sure how much data
the application will have to process. Instead of instructing Python to process a
static number of items, you use the while statement to tell Python to continue
processing items until it runs out of items. This kind of loop is useful when you
need to perform tasks such as downloading files of unknown size or streaming
data from a source such as a radio station. Any situation in which you can’t define
at the outset how much data the application will process is a good candidate for
the while statement, which the following sections describe more fully.

Understanding the while statement

The while statement works with a condition rather than a sequence. The condi-
tion states that the while statement should perform a task until the condition is
no longer true. For example, imagine a deli with a number of customers standing
in front of the counter. The salesperson continues to service customers until no
more customers are left in line. The line could (and probably will) grow as the
other customers are handled, so it’s impossible to know at the outset how many
customers will be served. All the salesperson knows is that continuing to serve
customers until no more are left is important. Here is how a while statement
might look:

while Sum < 5:

The statement begins with the while keyword. It then adds a condition. In this
case, a variable, Sum, must be less than 5 for the loop to continue. Nothing speci-
fies the current value of Sum, nor does the code define how the value of Sum will
change. The only thing that is known when Python executes the statement is that
Sum must be less than 5 for the loop to continue performing tasks. The statement
ends with a colon and the tasks are indented below the statement.

Because the while statement doesn’t perform a series of tasks a set number of
times, creating an endless loop is possible, meaning that the loop never ends. For
example, say that Sum is set to @ when the loop begins, and the ending condition
is while Sum < 5. If the value of Sum never increases, the loop will continue
executing forever (or at least until the computer is shut down). Endless loops can
cause all sorts of bizarre problems on systems, such as slowdowns and even com-
puter freezes, so it’s best to avoid them. You must always provide a method for the
loop to end when using a while loop (contrasted with the for loop, in which the
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end of the sequence determines the end of the loop). So, when working with the
while statement, you must perform three tasks:

1.
2.
3.

Create the environment for the condition (such as setting Sum to @).
State the condition within the while statement (such as Sum < 5).

Update the condition as needed to ensure that the loop eventually ends (such
as adding Sum+=1 to the while code block).

As with the for statement, you can modify the default behavior of the while
statement. In fact, you have access to the same four clauses to modify the while
statement behavior:

»
»

»
»

break: Ends the current loop.

continue: Immediately ends processing of the current element, but contin-
ues on with the next element.

pass: Acts as a placeholder for future code.

else: Provides an alternative processing technique when conditions aren't
met for the loop.

Using the while statement in an application

You

can use the while statement in many ways, but this first example is

straightforward. It simply displays a count based on the starting and ending
condition of a variable named Sum. The following steps help you create and test the
example code.

1.

Type the following code into a new cell in the notebook — pressing Enter
after each line:

Sum = @

while Sum < 5:
print(Sum)
Sum += 1

The example code demonstrates the three tasks you must perform when
working with awhile loop in a straightforward manner. It begins by setting
Sum to ©, which is the first step of setting the condition environment. The
condition itself appears as part of the while statement. The end of thewhile
code block accomplishes the third step. Of course, the code displays the
current value of Sum before it updates the value of Sum.
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Awhile statement provides flexibility that you don't get with a for statement.
This example shows a relatively straightforward way to update Sum. However,
you can use any update method required to meet the goals of the application.
Nothing says that you have to update Sum in a specific manner. In addition, the
condition can be as complex as you want it to be. For example, you can track
the current value of three or four variables if you want. Of course, the more
complex you make the condition, the more likely you are to create an endless
loop, so you have a practical limit as to how complex you should make the
while loop condition.

Click Run Cell.

Python executes the while loop and displays the numeric sequence shown in
Figure 9-5.

FIGURE 9-5:
The simple
while loop
displays a
sequence of
numbers.

~ Processing Data by Using the while Statement

~ Using the while statement in an application
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while Sum < 5:
print(Sum)
Sum+=1
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Nesting Loop Statements

In some cases, you can use either a for loop or a while loop to achieve the same
effect. The loop statements work differently, but the effect is the same. In this
example, you create a multiplication table generator by nesting a while loop
within a for loop. Because you want the output to look nice, you use a little for-

matting as well. (Chapter 12 gives you the details.)

1.

Type the following code into a new cell in the notebook — pressing Enter
after each line:

X =1
Y =l
print ('{:>4}'.format(' '), end= ' ")

for X in range(1, 11):
print('{:>4}"'.format(X), end="' ")
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print()
for X in range(1,11):
print('{:>4}"'.format(X), end=' ")
while Y <= 10:
print('{:>4}"'.format(X x Y), end=" ')
Y +=1
print()
Y=1

This example begins by creating two variables, X and Y, to hold the row and
column values of the table. X is the row variable and Y is the column variable.

To make the table readable, this example must create a heading at the top and
another along the side. When users see a1 at the top and a1 at the side, and
follow these values to where they intersect in the table, they can see the value
of the two numbers when multiplied.

The first print () statement adds a space (because nothing appears in the
corner of the table; see Figure 9-6 to more easily follow this discussion). All the
formatting statement says is to create a space 4 characters wide and place a
space within it. The {: >4} part of the code determines the size of the column.
The format(' ') function determines what appears in that space. The end
attribute of the print () statement changes the ending character from a
carriage return to a simple space.

The first for loop displays the numbers 1 through 10 at the top of the table.
The range( ) function creates the sequence of numbers for you. When using
the range( ) function, you specify the starting value, which is 1 in this case, and
one more than the ending value, which is 11 in this case.

At this point, the cursor is sitting at the end of the heading row. To move it to
the next line, the code issues aprint() call with no other information.

Even though the next bit of code looks quite complex, you can figure it out if
you look at it a line at a time. The multiplication table shows the values from 1
* 1t010 x 10, so you need ten rows and ten columns to display the informa-
tion. The for statement tells Python to create ten rows.

Look again at Figure 9-6 to note the row heading. The firstprint() call
displays the row's label on the left. Of course, you have to format this informa-
tion, and the code uses a space of four characters that end with a space, rather
than a carriage return, in order to continue printing information in that row.

The while loop comes next. This loop prints the columns in an individual row.
The column values are the multiplied values of X * Y. Again, the outputis
formatted to take up four spaces. Thewhile loop ends whenY is updated to
the next value by using Y+=1.
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Now you're back into the for loop. The print () statement ends the current
row. In addition, Y must be reset to 1 so that it's ready for the beginning of the
next row, which begins with 1.

2. Cclick Run Cell.

You see the multiplication table shown in Figure 9-6.

~ Nesting Loop Statements

+ i I |
< @ =1
Y 1

print ('{:>4}".format(' "), end= ' ")
for X in range(l, 11):

print('{:>4}".format(X), end=" ")
print()
for X in range(1,11):

print('{:>4}" .format(X), end=" ")

while ¥ <= 1@:
print('{:>4}".format(X * ¥), end=" ")
Y+=1

print()

¥=1
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FIGURE 9-6:

The multiplication
table is pleasing
to the eye thanks
to its formatting.
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IN THIS CHAPTER

» Understanding error sources

» Handling error conditions
» Specifying that an error has occurred
» Developing your own error indicators

» Performing tasks even after an error
occurs

Chapter 10
Dealing with Errors

ost application code of any complexity has errors in it. When your appli-

cation suddenly freezes for no apparent reason, that’s an error. Seeing

one of those obscure message dialog boxes is another kind of error.
However, errors can occur that don’t provide you with any sort of notification. An
application might perform the wrong computation on a series of numbers you
provide, resulting in incorrect output that you may never know about unless
someone tells you that something is wrong or you check for the issue yourself.
Errors need not be consistent, either. You may see them on some occasions and
not on others. For example, an error can occur only when the weather is bad or the
network is overloaded. In short, errors occur in all sorts of situations and for all
sorts of reasons. The big thing to remember is that the computer hasn’t person-
ally targeted you and has nothing against you — computers don’t have emotions.
This chapter is designed to alleviate any computer-related angst you might have
about errors.

It shouldn’t surprise you that errors occur. Applications are written by humans,
and humans make mistakes. Most developers call application errors exceptions,
meaning that they’re the exception to the rule. Because exceptions do occur in
applications, you need to detect and do something about them whenever possible.
The act of detecting and processing an exception is called error handling or excep-
tion handling. To properly detect errors, you need to know about error sources and
why errors occur in the first place. When you do detect the error, you must process
it by catching the exception. Catching an exception means examining it and possi-
bly doing something about it. So, another part of this chapter is about discovering
how to perform exception handling in your own application.
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Sometimes your code detects an error in the application. When this happens, you
need to raise or throw an exception. You see both terms used for the same thing,
which simply means that your code encountered an error it couldn’t handle, so it
passed the error information onto another piece of code to handle (interpret, pro-
cess, and, with luck, fix the exception). In some cases, you use custom error message
objects to pass on the information. Even though Python has a wealth of generic
message objects that cover most situations, some situations are special. For exam-
ple, you might want to provide special support for a database application, and Python
doesn’t normally cover that contingency with a generic message object. You need to
know when to handle exceptions locally, when to send them to the code that called
your code, and when to create special exceptions so that every part of the application
knows how to handle the exception — all of which are topics covered by this chapter.

You don’t have to type the source code for this chapter manually. In fact, using the
downloadable source is a lot easier. You can find the source for this chapter in the
BPP4D3E; 1@; Dealing with Errors.ipynb file of the downloadable source. See
the Introduction for details on how to find these source files.

Knowing Why Python Doesn’t
Understand You

158

REMEMBER

Developers often get frustrated with programming languages and computers
because they seemingly go out of their way to cause communication problems. Of
course, programming languages and computers are both inanimate — they don’t
“want” anything. Programming languages and computers also don’t think; they
literally accept whatever the developer says. Therein lies the problem.

Neither Python nor the computer will “know what you mean” when you type
instructions as code. Both follow whatever instructions you provide to the letter
and literally as you provide them. You may not have meant to tell Python to delete
a data file unless some absurd condition occurred. However, if you don’t make the
conditions clear, Python will delete the file whether the condition exists or not.
When an error of this sort happens, people commonly say that the application has
a bug in it. Bugs are simply coding errors that you can remove by using a debugger.
(A debugger is a special kind of tool that lets you stop or pause application execu-
tion, examine the content of variables, and generally dissect the application to see
what makes it tick.)

Errors occur in many cases when the developer makes assumptions that simply
aren’t true. Of course, this includes assumptions about the application user, who
probably doesn’t care about the extreme level of care you took when crafting your
application. The user will enter bad data. Again, Python won’t know or care that
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the data is bad and will process it even when your intent was to disallow the bad
input. Python doesn’t understand the concepts of good or bad data; it simply pro-
cesses incoming data according to any rules you set, which means that you must
set rules to protect users from themselves.

Python isn’t proactive or creative — those qualities exist only in the developer.
When a network error occurs or the user does something unexpected, Python
doesn’t create a solution to fix the problem. It only processes code. If you don’t
provide code to handle the error, the application is likely to fail and crash
ungracefully — possibly taking all the user’s data with it. Of course, the developer
can’t anticipate every potential error situation, either, which is why most complex
applications have errors in them — errors of omission, in this case.

absurdity of thinking that such code is even possible. Smart developers assume
that some number of bugs will get through the code-screening process, that nature
warning  and users will continue to perform unexpected actions, and that even the smartest
developer can’t anticipate every possible error condition. Always assume that your
application is subject to errors that will cause exceptions; that way, you’ll have the
mindset required to actually make your application more reliable. Keeping
Murphy’s Law, “If anything can go wrong, it will” in mind will help more than you
think. (See more about Murphy’s laws at https://people.howstuffworks.com/
murphys-law.htm.) In addition, you must consider that some low-probability
events can have a high impact on your software. They’re called black-swan events
(https://betterprogramming.pub/the-black-swan-events-in-distributed-
systems-d6a5d51adddf), and you need to be prepared for them as well.

‘ Some developers out there think they can create bulletproof code, despite the

Considering the Sources of Errors

You might be able to divine the potential sources of error in your application by
reading tea leaves, but that’s hardly an efficient way to do things. Errors actually
fall into well-defined categories that help you predict (to some degree) when and
where they’ll occur. By thinking about these categories as you work through your
application, you’re far more likely to discover potential error sources before they
occur and cause potential damage. The two principle categories are

¥ Errors that occur at a specific time

¥ Errors that are of a specific type

The following sections discuss these two categories in greater detail. The overall
concept is that you need to think about error classifications in order to start find-
ing and fixing potential errors in your application before they become a problem.
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Classifying when errors occur

Errors occur at specific times. The two major time frames are

¥ Compile time

¥ Runtime

No matter when an error occurs, it causes your application to misbehave. The fol-
lowing sections describe each time frame.

Compile time

A compile time error occurs when you ask Python to run the application. Before
Python can run the application, it must interpret the code and put it into a form
that the computer can understand. A computer relies on machine code that is spe-
cific to that processor and architecture. If the instructions you write are mal-
formed or lack needed information, Python can’t perform the required conversion.
It presents an error that you must fix before the application can run.

Fortunately, compile-time errors are the easiest to spot and fix. Because the
application won’t run with a compile-time error in place, the user never sees this
error category. You fix this sort of error as you write your code.

The appearance of a compile-time error should tell you that other typos or omis-
sions could exist in the code. It always pays to check the surrounding code to
ensure that no other potential problems exist that might not show up as part of
the compile cycle.

CONSIDERING THE EFFECTS OF LIBRARY/
PACKAGE UPDATES ON YOUR CODE

Python relies on a huge number of third-party libraries to perform tasks. A library is
code that someone else puts together and then you use it with your application so that
you don't have to write so much code. These libraries are put into a convenient form
called a package, as sort of a gift from one programmer to another. As of this writing,
there are 3,409,411 released packages listed athttps: //pypi.org/ for use with the
Python programming language. There are 659 packages available for use with email
projects (see Chapter 17) alone. So before you write extensive code to perform a spe-
cific task, consider the fact that someone else has probably already written the code
for you.
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Libraries are usually a good addition to your programming toolbox because someone
else debugs them for you, so you have fewer errors to worry about. However, it's this
whole debugging thing that causes some problems. The code that worked fine with
library version 1.0 may not work with library version 2.0 because the updated library
fixed problems that your code depends on to work. A fix of this sort is called a breaking
change because it breaks existing code and causes it to malfunction. Consequently, your
code can work one day, but not the next, when something you install updates the librar-
ies to the new version for you without your knowledge. Yes, other programmers can
ruin your day by doing the right thing and fixing bugs in their code. Chapter 11 tells you
about importing packages (libraries) into your code and using them.

Some update errors also occur in the Python language itself. For example, when work-
ing with Python 2, you could create a statement that uses the statement version of
print like this:print "Hello World".In Python 3, you must use the function version
of print(), like this: print("Hello World").The update information athttps://
docs. python.org/3/whatsnew/3.0.html tells you more about this change (and
others).

Runtime

A runtime error occurs after Python compiles the code you write and the computer
begins to execute it. Runtime errors come in several different types, and some are
harder to find than others. You know you have a runtime error when the applica-
tion suddenly stops running and displays an exception dialog box or when the
user complains about erroneous output (or at least instability).

Not all runtime errors produce an exception. Some runtime errors cause insta-
bility (the application freezes), errant output, or data damage. Runtime errors
can affect other applications or create unforeseen damage to the platform on
which the application is running. In short, runtime errors can cause you quite a
bit of grief, depending on precisely the kind of error you’re dealing with at the
time.

Many runtime errors are caused by errant code. For example, you can misspell the
name of a variable, preventing Python from placing information in the correct
variable during execution. Leaving out an optional (it’s not absolutely required in
most cases) but necessary (it is required in this specific instance) argument when
calling a method can also cause problems. These are examples of errors of commis-
sion, which are specific errors associated with your code. In general, you can find
these kinds of errors by using a debugger or by simply reading your code line by
line to check for errors.
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Runtime errors can also be caused by external sources not associated with your
code (see the “Considering the effects of library/package updates on your code”
sidebar for additional information about third-party code). For example, the user
can input incorrect information that the application isn’t expecting, causing an
exception. A network error can make a required resource inaccessible. Sometimes
even the computer hardware has a glitch that causes a nonrepeatable application
error. These are all examples of errors of omission, from which the application
might recover if your application has error-trapping code in place. It’s important
that you consider both kinds of runtime errors — errors of commission and
omission — when building your application.

Distinguishing error types

You can distinguish errors by type, that is, by how they’re made. Knowing the
error types helps you understand where to look in an application for potential
problems. Exceptions work like many other things in life. For example, you know
that electronic devices don’t work without power. So, when you try to turn your
television on and it doesn’t do anything, you might look to ensure that the power
cord is firmly seated in the socket.

Understanding the error types helps you locate errors faster, earlier, and more
consistently, resulting in fewer misdiagnoses. The best developers know that fix-
ing errors while an application is in development is always easier than fixing it
when the application is in production because users are inherently impatient and
want errors fixed immediately and correctly. In addition, fixing an error earlier in
the development cycle is always easier than fixing it when the application nears
completion because less code exists to review.

The trick is to know where to look. With this in mind, Python (and most other
programming languages) breaks errors into the following types:

¥ Syntactical
¥ Semantic
¥ Logical
The following sections examine each of these error types in more detail. I’ve

arranged the sections in order of difficulty, starting with the easiest to find.
A syntactical error is generally the easiest; a logical error is generally the hardest.

Syntactical

Whenever you make a typo of some sort, you create a syntactical error. Some
Python syntactical errors are quite easy to find because the application simply

PART 2 Talking the Talk



REMEMBER

REMEMBER

doesn’t run. The interpreter may even point out the error for you by highlighting
the errant code and displaying an error message. However, some syntactical errors
are quite hard to find. Python is case sensitive, so you may use the wrong case for
avariable in one place and find that the variable isn’t quite working as you thought
it would. Finding the one place where you used the wrong capitalization can be
quite challenging.

Most syntactical errors occur at compile time and the interpreter points them out
for you. Fixing the error is made easy because the interpreter generally tells you
what to fix, and with considerable accuracy. Even when the interpreter doesn’t
find the problem, syntactical errors prevent the application from running cor-
rectly, so any errors the interpreter doesn’t find show up during the testing phase.
Few syntactical errors should make it into production as long as you perform ade-
quate application testing.

Semantic

When you create a loop that executes one too many times, you don’t generally
receive any sort of error information from the application. The application will
happily run because it thinks that it’s doing everything correctly, but that one
additional loop can cause all sorts of data errors. When you create an error of this
sort in your code, it’s called a semantic error.

Semantic errors occur because the meaning behind a series of steps used to per-
form a task is wrong — the result is incorrect even though the code apparently
runs precisely as it should. Semantic errors are tough to find, and you sometimes
need some sort of debugger to find them. (Chapter 20 provides a discussion of
tools that you can use with Python to perform tasks such as debugging applica-
tions. You can also find blog posts about debugging on my blog at http://blog.
johnmuellerbooks.com.)

Logical

Some developers don’t create a division between semantic and logical errors, but
they are different. A semantic error occurs when the code is essentially correct but
the implementation is wrong (such as having a loop execute once too often). Logi-
cal errors occur when the developer’s thinking is faulty. In many cases, this sort
of error happens when the developer uses a relational or logical operator incor-
rectly. However, logical errors can happen in all sorts of other ways, too. For
example, a developer might think that data is always stored on the local hard
drive, which means that the application may behave in an unusual manner when
it attempts to load data from a network drive instead.
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Logical errors are quite hard to fix because the problem isn’t with the actual code,
yet the code itself is incorrectly defined. The thought process that went into creat-
ing the code is faulty; therefore, the developer who created the error is less likely
to find it. Smart developers use a second pair of eyes to help spot logical errors.
Having a formal application specification also helps because the logic behind the
tasks the application performs is usually given a formal review.

Catching Exceptions

164

Generally speaking, a user should never see an exception dialog box. Your appli-
cation should always catch the exception and handle it before the user sees it. Of
course, the real world is different — users do see unexpected exceptions from
time to time. However, catching every potential exception is still the goal when
developing an application. The following sections describe how to catch excep-
tions and handle them.

UNDERSTANDING THE BUILT-IN
EXCEPTIONS

Python comes with a host of built-in exceptions — far more than you might think possi-
ble. You can see a list of these exceptions athttps: //docs.python.org/3.10/
library/exceptions.html. The documentation breaks the exception list down into
categories (see the exception hierarchy athttps: //docs. python.org/3.10/
library/exceptions.html#exception-hierarchy). Here is a brief overview of the
Python exception categories that you work with regularly:

® Base classes: The base classes provide the essential building blocks (such as the
Exception exception) for other exceptions. However, you might actually see some
of these exceptions, such as the ArithmeticError exception, when working with
an application.

® Concrete exceptions: Applications can experience hard errors — errors that are
hard to overcome because there really isn't a good way to handle them or they sig-
nal an event that the application must handle. For example, when a system runs
out of memory, Python generates a MemoryError exception. Recovering from this
error is hard because it isn't always possible to release memory from other uses.
When the user presses an interrupt key (such as Ctrl+C or Delete), Python gener-
ates aKeyboardInterrupt exception. The application must handle this exception
before proceeding with any other tasks.
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® OS exceptions: The operating system can generate errors that Python then passes
along to your application. For example, if your application tries to open a file that
doesn't exist, the operating system generates a FileNotFoundError exception.

® Warnings: Python tries to warn you about unexpected events or actions that could
result in errors later. For example, if you try to inappropriately use a resource, such
as an icon, Python generates a ResourceWarning exception. You want to remem-
ber that this particular category is a warning and not an actual error: Ignoring it can
cause you woe later, but you can ignore it.

Basic exception handling

To handle exceptions, you must tell Python that you want to do so and then pro-
vide code to perform the handling tasks. You have a number of ways in which you
can perform this task. The following sections start with the simplest method first
and then move on to more complex methods that offer added flexibility.

Handling a single exception

In Chapter 8, the various examples have a terrible habit of spitting out exceptions
when the user inputs unexpected values. Part of the solution is to provide range
checking. However, range checking doesn’t overcome the problem of a user typing
text such as Hello in place of an expected numeric value. Exception handling pro-
vides a more complex solution to the problem, as described in the following steps.

1. Open a new notebook.

You can also use the downloadable source file, BPP4D3E; 10; Dealing with
Errors. ipynb.

2. Type the following code into the notebook — pressing Enter after
each line:

try:

Value = int(input("Type a number between 1 and 10: "))
except ValueError:

print("You must type a number between 1 and 10!")

else:
if (Value > @) and (Value <= 10):
print("You typed: ", Value)
else:

print("The value you typed is incorrect!")
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instead of an
exception.

The code within the try block has its ValueError exception handled. In this
case, handling the exception means getting input from the user by using the
int(input()) calls. If an exception occurs outside this block, the code doesn’t
handle it. With reliability in mind, the temptation might be to enclose all the
executable code in a try block so that every exception would be handled.

However, you want to keep your exception handling small and specific to make

locating the problem easier.

The except block looks for a specific exception in this case: ValueError. When
the user creates a ValueError exception by typing Hello instead of a numeric
value, this particular exception block is executed. If the user were to generate

some other exception, this except block wouldn't handle it.

The else block contains all the code that is executed when the try block code

is successful (doesn't generate an exception). The remainder of the code is in
this block because you don't want to execute it unless the user does provide
valid input. When the user provides a whole number as input, the code can

then range check it to ensure that it's correct.

Click Run Cell.

Python asks you to type a number between 1 and 10.

Type Hello and press Enter.

The application displays an error message, as shown in Figure 10-1.

~ Catching Exceptions

~ Basic exception handling

~ Handling a single exception

10

Value = int(input("Type a number between 1 and 10: "

except ValueError:
print("You must type a number between 1 and 1@!")
else:
if (Value » 8) and (Value <= 18):
print(“You typed: ", Value)
else
printl("The value you typed is incorrect!"}|

Type & number betwsen 1 and 18: Hello
You must type @ number betwsen 1 and 18!

e B & g

Perform Steps 3 and 4 again, but type 5.5 instead of Hello.

The application generates the same error message, as shown in Figure 10-1.
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FIGURE 10-2:
Exception
handling doesn't
ensure that the
value is in the
correct range.

6. Perform Steps 3 and 4 again, but type 22 instead of Hello.

The application outputs the expected range error message, as shown in
Figure 10-2. Exception handling doesn't weed out range errors. You must still
check for them separately.

T =R- K- NN B
@ oy
Value = int(input("Type a number be
except ValueError:

ween 1 and 18: "))

print("You must type a number between 1 and 18!")
else:
if (value > 8) and (Value <= 18):
print(“You typed: ", Value)
else
printl("The value you typed is incorrect!"f|

Type @ number between 1 and 1@: 22
The value you typed is incorrect!

7. Pperform Steps 3 and 4 again, but type 7 instead of Hello.

This time, the application finally reports that you've provided a correct value of 7.
Even though it seems like a lot of work to perform this level of checking, you
can't really be certain that your application is working correctly without it.

Using the except clause without an exception

You can create an exception handling block in Python that’s generic because it
doesn’t look for a specific exception. In most cases, you want to provide a specific
exception when performing exception handling for these reasons:

¥ To avoid hiding an exception you didn't consider when designing the
application

¥ To ensure that others know precisely which exceptions your application will
handle

¥ To handle the exceptions correctly by using specific code for that exception

However, sometimes you may need a generic exception-handling capability, such
as when you’re working with third-party libraries or interacting with an external
service. The following steps demonstrate how to use an except clause without a
specific exception attached to it.

1. Type the following code into a new cell of the notebook — pressing Enter
after each line:

try:
Value = int(input("Type a number between 1 and 10: "))
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except:

print("This is the generic error!")
except ValueError:

print("You must type a number between 1 and 10!")
else:

if (Value > @) and (Value <= 10):

print("You typed: ", Value)
else:

print("The value you typed is incorrect!")

The only difference between this example and the previous example is that the
except clause doesn't have the ValueError exception specifically associated
with it. The result is that this except clause will also catch any other exception
that occurs.

2. Click Run Cell.

You see the error message shown in Figure 10-3. Python automatically detects
that you have placed the exception handlers in the wrong order. (You discover
more about this issue in the “Handling more specific to less specific exceptions”
section, later in the chapter.) Notice that the errant lines have red, squiggly lines
under them in Colab so that you can see the error with less effort.

~ Using the except clause without an exception

I -E-Eh |

ype a number between 1 and 1@!™)

(Value <= 1@):
t("You typed: ", Value)

rint("The value you typed is incorrect!™)

File “<ipython-input-3-6cal®@338674d>", line 2
Value = int(input("Type a number between 1 and 18: "))

syntaxError: default 'except:’ must be last

SEARCH STACK OVERFLOW

Type the following code in a new cell to reverse the order of the two exceptions
so that they appear like this:

try:

Value = int(input("Type a number between 1 and 10: "))
except ValueError:

print("You must type a number between 1 and 10!")
except:

print("This is the generic error!")
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else:
if (Value > @) and (Value <= 10):
print("You typed: ", Value)
else:

print("The value you typed is incorrect!")

Click Run Cell.
Python asks you to type a number between 1 and 10.
Type Hello and press Enter.

The application displays an error message (refer to Figure 10-1). When the
exceptions are in the right order, the code detects specific errors first and then
uses less specific handlers only when necessary.

Click Run Cell.
Python asks you to type a number between 1 and 10.

Choose Runtime > Interrupt Execution (when using Colab) or
Kernel = Interrupt (when using Jupyter Notebook).

This act is akin to pressing Ctrl+C or Cmd+C in other IDEs. However, nothing
actually appears to happen. If you're working with Jupyter Notebook, you can
look at the server window to see aKernel Interrupted message. In addition,
you see the generic error message. Python is still waiting for you to enter a
value in the input () textbox.

Select the input() textbox (if necessary), type 5.5, and press Enter.

You still see the generic error message as before, now shown in Figure 10-4
because Notebook is reacting to the interrupt, rather than the incorrect input;
the reason is that the interrupt came first. Python queues errors in the order in
which it receives them. Consequently, you may find that an application outputs
what appears to be the wrong error message at times.

T BREd

try:
Value = int(input("T
except ValueError:

print("You must typ
except:

print("This is the generic error!™)
elses|

if (Value » 9) and (Value <= 18):

print("You typed: ", Value)

print("The value you typed is incorrect!™)

This is the generic error!
Type a number between 1 and 18: 5.5
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8. Perform Steps 3 and 4 again, but type 5.5 instead of Hello.

The application generates the same error message as before (again, refer to
Figure 10-1). In this case, no interrupt occurred, so you see the error message
you expected.

Working with exception arguments

Most exceptions don’t provide arguments (a list of values that you can check for
additional information). The exception either occurs or it doesn’t. However, a few
exceptions do provide arguments, and you see them used later in the book. The
arguments tell you more about the exception and provide details that you need to
correct it.

For the sake of completeness, this chapter includes a simple example that gener-
e ates an exception with an argument. You can safely skip the remainder of this
6 section if desired because the information is covered in more detail later in the
TECHNICAL book.
STUFF
1. Type the following code into a new cell in the notebook — pressing Enter
after each line:

import sys
try:
File = open("myfile.txt")
except IOError as e:
print("Error opening file!\r\n" +
"Error Number: {@}\r\n".format(e.errno) +
"Error Text: {@}".format(e.strerror))
else:
print("File opened as expected.")
File.close()

This example uses some advanced features. The import statement obtains
code from another file. Chapter 11 tells you how to use this Python feature.

The open( ) function opens a file and provides access to the file through the
File variable. Chapter 16 tells you how file access works. Given thatmyfile.
txt doesn't exist in the application directory, the operating system can't open it
and will tell Python that the file doesn't exist.

Trying to open a nonexistent file generates an IOError exception. This
particular exception provides access to two arguments:

errno: Provides the operating system error number as an integer

strerror: Contains the error information as a human-readable string
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file never works.

The as clause places the exception information into a variable, e, that you can
access as needed for additional information. The except block contains a
print() call that formats the error information into an easily read error
message.

If you should decide to create themyfile.txt file, the else clause executes. In
this case, you see a message stating that the file opened normally. The code
then closes the file without doing anything with it.

2. Cclick Run Cell.

The application displays the Error opening file information, as shown in
Figure 10-5.

~ Working with exception arguments

S ER=-R- TR

< @) import sys
try:
File = open("myfile.txt")
except IOError as e:
print("Error ope
"Error Number: { \n".format(e.errno) +
"Error Text: {@ ormat (e.strerror))
else:
print("File opened as expected.”)

File.close()

Error opening file!
Error Number: 2

OBTAINING A LIST OF EXCEPTION
ARGUMENTS

The list of arguments supplied with exceptions varies by exception and by what the
sender provides. It isn't always easy to figure out what you can hope to obtain in the
way of additional information. One way to handle the problem is to simply print every-
thing by using code like this:

import sys
try:
File = open("myfile.txt")
except IOError as e:
for Arg in e.args:
print(Arg)
else:
print("File opened as expected.")
File.close()

(continued)
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The args property always contains a list of the exception arguments in string format as
shown in the following screenshot. You can use a simple for loop to print each of the
arguments. The only problem with this approach is that you're missing the argument
names, so you know the output information (which is obvious in this case), but you
don't know what to call it.

In [5]: import sys

try:
File = open{"myfile.txt")

except IOError as e:
for Arg in e.args:

print(Arg)

else:
print("File opened as expected.")
File.close()

2
No such file or directory

A more complex method of dealing with the issue is to print both the names and the
contents of the arguments. The following code displays both the names and the values
of each of the arguments:

import sys
try:
File = open("myfile.txt")
except IOError as e:
for Entry in dir(e):
if (not Entry.startswith("_")):
try:
print(Entry, " = ", e.__getattribute__(Entry))
except AttributeError:
print("Attribute ", Entry, " not accessible.")
else:
print("File opened as expected.")
File.close()

In this case, you begin by getting a listing of the attributes associated with the error
argument object using the dir () function. The output of the dir () function is a list of
strings containing the names of the attributes that you can print as shown in the follow-
ing screenshot. Only those arguments that don't start with an underscore (_) contain
useful information about the exception. However, even some of those entries are inac-
cessible, so you must encase the output code in asecond try ... except block (see
the “Nested exception handling” section, later in the chapter, for details).
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In [6]: import sys
try:
File = open("myfile.txt")
except IOError as e:
for Entry in dir(e)
if (not Entry.startswith("_")):
try:
print(Entry, " = ", e._ getattribute_ (Entry))
except AttributeError:
print("Attribute ", Entry, " not accessible.™)
else:
print("File opened as expected.")
File.close()

args = (2, 'No such file or directory')
Attribute characters_written not accessible
errno = 2

filename = myfile.txt

filename2 = HNone

strerror Mo such file or directory

wuinerror = None
with_traceback = <built-in method with_traceback of FileMotFoundError object
at 9xe00281EA3CEER440>

The attribute name is easy because it's contained in Entry. To obtain the value associ-
ated with that attribute, you must use the __getattribute() function and supply the
name of the attribute you want. When you run this code, you see both the name and
the value of each of the attributes supplied with a particular error argument object. In
this case, the actual output is as follows:

args = (2, 'No such file or directory')

Attribute characters_written not accessible.

errno = 2

filename = myfile.txt

filename2 = None

strerror = No such file or directory

with_traceback = <built-in method with_traceback of

FileNotFoundError object at 0x7f52bf07f5f0>

Handling multiple exceptions with a
single except clause

Most applications can generate multiple exceptions for a single line of code. This
fact is demonstrated in the “Using the except clause without an exception” sec-
tion of the chapter. How you handle the multiple exceptions depends on your
goals for the application, the types of exceptions, and the relative skill of your
users. Sometimes when working with a less skilled user, it’s simply easier to say
that the application experienced a nonrecoverable error and then log the details
into a log file in the application directory or a central location.
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common action fulfills the needs of all the exception types. Otherwise, you need to
handle each exception individually. The following steps show how to handle mul-
rememser  tiple exceptions by using a single except clause.

@ Using a single except clause to handle multiple exceptions works only when a

1. Type the following code into a new cell of the notebook — pressing Enter
after each line:

try:

Value = int(input("Type a number between 1 and 10: "))
except (ValueError, KeyboardInterrupt):

print("You must type a number between 1 and 10!")

else:
if (Value > @) and (Value <= 10):
print("You typed: ", Value)
else:

print("The value you typed is incorrect!")

Note that the except clause now sports both aValueError and a
KeyboardInterrupt exception. These exceptions appear within parentheses
and are separated by commas.
REMEMBER

2. Click Run Cell.
Python asks you to type a number between 1 and 10.

3. Type Hello and press Enter.
The application displays an error message (refer to Figure 10-1).

4. click Run Cell.

Python asks you to type a number between 1 and 10.

5. Choose Runtime = Interrupt Execution for Colab or Kernel => Interrupt
for Jupyter Notebook.

This act is akin to pressing Ctrl+C or Cmd+C in other IDEs.
6. ClickRun Cell, type 5.5, and press Enter.

The application displays an error message (refer to Figure 10-1).
7. Perform Steps 2 and 3 again, but type 7 instead of Hello.

This time, the application finally reports that you've provided a correct
value of 7.
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Handling multiple exceptions with
multiple except clauses

When working with multiple exceptions, it’s usually a good idea to place each
exception in its own except clause. This approach allows you to provide custom
handling for each exception and makes it easier for the user to know precisely
what went wrong. Of course, this approach is also a lot more work. The following
steps demonstrate how to perform exception handling by using multiple except
clauses.

1.

Type the following code into a new cell of the notebook — pressing Enter
after each line:

try:

Value = int(input("Type a number between 1 and 10: "))
except ValueError:

print("You must type a number between 1 and 10!")
except KeyboardInterrupt:

print("You pressed Ctrl+C!")

else:
if (Value > @) and (Value <= 10):
print("You typed: ", Value)
else:

print("The value you typed is incorrect!")

Notice the use of multiple except clauses in this case. Each except clause
handles a different exception. You can use a combination of techniques, with
some except clauses handling just one exception and other except clauses
handling multiple exceptions. Python lets you use the approach that works
best for the error-handling situation.

Click Run Cell.

Python asks you to type a number between 1 and 10.

Type Hello and press Enter.

The application displays an error message (refer to Figure 10-1).
Perform Steps 2 and 3 again, but type 22 instead of Hello.

The application outputs the expected range error message (refer to
Figure 10-2).

Perform Steps 2 and 3 again, but choose Runtime = Interrupt Execution
for Colab or Kernel = Interrupt for Jupyter Notebook.

The application outputs a specific message, You pressed Ctri+C, that tells the
user what went wrong.
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6. Perform Steps 2 and 3 again, but type 7 instead of Hello.

This time, the application finally reports that you've provided a correct
value of 7.

Handling more specific to less
specific exceptions

One strategy for handling exceptions is to provide specific except clauses for all
known exceptions and generic except clauses to handle unknown exceptions. You
can see the exception hierarchy that Python uses at https://docs.python.
org/3/library/exceptions.htmls#exception-hierarchy. When viewing this
chart, BaseException is the uppermost exception. Most exceptions are derived
from Exception. When working through math errors, you can use the generic
ArithmeticError or a more specific ZeroDivisionError exception.

Python evaluates except clauses in the order in which they appear in the source
code file. The first clause is examined first, the second clause is examined second,
and so on. The following steps help you examine an example that demonstrates
the importance of using the correct exception order. In this case, you perform
tasks that result in math errors.

1. Type the following code into a new cell of the notebook — pressing Enter
after each line:

try:
Valuel = int(input("Type the first number: "))
Value2 = int(input("Type the second number: "))
Output = Valuel / Value2
except ValueError:
print("You must type a whole number!")
except KeyboardInterrupt:
print("You pressed Ctrl+C!")
except ArithmeticError:
print("An undefined math error occurred.")
except ZeroDivisionError:
print("Attempted to divide by zero!")
else:
print(Output)

The code begins by obtaining two inputs: Valuel and Value2. The first two
except clauses handle unexpected input. The second two except clauses
handle math exceptions, such as dividing by zero. If everything goes well with
the application, the else clause executes, which prints the result of the
operation.
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FIGURE 10-6:
The order in
which Python
processes
exceptions is
important.

2. click Run Cell.
Python asks you to type the first number.
3. Type Hello and press Enter.

As expected, Python displays the ValueError exception message. However, it
always pays to check for potential problems.

4. Click Run Cell again.

Python asks you to type the first number.
5. Type 8 and press Enter.

The application asks you to enter the second number.
6. Type 0 and press Enter.

You see the error message for the ArithmeticError exception, as shown in
Figure 10-6. What you should actually see is the ZeroDivisionError excep-
tion because it's more specific than the ArithmeticError exception.

~ Handling more specific to less specific exceptions

v e B S g
© o
Valuel = int(input("Type the first number: "))
Value2 = int(input("Type the second number: "))
Output = Valuel / Value2
except ValueError:
print(“You must type a whole number!™)
except KeyboardInterrupt:|
print("You pressed CtrlsC!™)
except ArithmeticError:
print("An undefined math error occurred.”)
except ZeroDivisionError:
print("Attempted to divide by zero!")
else:
print(Output)

Type the first number: 8
Type the second number: @
An undefined math error occurred.

7. Reverse the order of the two exceptions so that they look like this:

except ZeroDivisionError:

print("Attempted to divide by zero!")
except ArithmeticError:

print("An undefined math error occurred.")

8. Perform Steps 4 through 6 again.

This time, you see the ZeroDivisionError exception message because the
exceptions appear in the correct order.
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9. Perform Steps 4 through 5 again, but type 2 for the second number
instead of 0.

This time, the application finally reports an output value of 4.0.

Notice that the output is a floating-point value. Division results in a floating-
point value unless you specify that you want an integer output by using the

floor division operator (//).
REMEMBER

Nested exception handling

Sometimes you need to place one exception-handling routine within another in a
process called nesting. When you nest exception-handling routines, Python tries
to find an exception handler in the nested level first and then moves to the outer
layers. You can nest exception-handling routines as deeply as needed to make
your code safe.

One of the more common reasons to use a dual layer of exception-handling code
is when you want to obtain input from a user and need to place the input code in
a loop to ensure that you actually get the required information. The following
steps demonstrate how this sort of code might work.

1. Type the following code into a new cell of the notebook — pressing Enter
after each line:

TryAgain = True
while TryAgain:
try:
Value = int(input("Type a whole number. "))
except ValueError:
print("You must type a whole number!")
try:
DoOver = input("Try again (y/n)? ")
except:
print("OK, see you next time!")
TryAgain = False
else:
if (str.upper(DoOver) == "N"):
TryAgain = False
except KeyboardInterrupt:
print("You pressed Ctrl+C!")
print("See you next time!")
TryAgain = False
else:
print(Value)
TryAgain = False
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The code begins by creating an input loop. Using loops for this type of purpose
is actually quite common in applications because you don't want the applica-
tion to end every time an input error is made. This is a simplified loop, and
normally you create a separate function to hold the code.

When the loop starts, the application asks the user to type a whole number. It
can be any integer value. If the user types any non-integer value or presses
Ctr+C, Cmd+C, or another interrupt key combination, the exception-handling
code takes over. Otherwise, the application prints the value that the user
supplied and sets TryAgain to False, which causes the loop to end.

AValueError exception can occur when the user makes a mistake. Because
you don't know why the user input the wrong value, you have to ask if the user
wants to try again. Of course, getting more input from the user could generate
another exception. The inner try. . .except code block handles this second-

ary input.
Notice the use of the str.upper () function when getting character input from
@ the user. This function makes it possible to receive y or Y as input and accept
them both. Whenever you ask the user for character input, converting
TIP lowercase characters to uppercase is a good idea so that you can perform a

single comparison (reducing the potential for error).

The KeyboardInterrupt exception displays two messages and then exits
automatically by setting TryAgain to False. The KeyboardInterrupt occurs
only when the user presses a specific key combination designed to end the

REMEMBER application. The user is unlikely to want to continue using the application at
this point.

2. click Run Cell.
Python asks the user to input a whole number.
3. Type Hello and press Enter.

The application displays an error message and asks whether you want to try
again.

4, Type Y and press Enter.

The application asks you to input a whole number again, as shown in
Figure 10-7.

5. Type 5.5 and press Enter.

The application again displays the error message and asks whether you want
to try again.
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FIGURE 10-7:
Using a loop

means that the
application can
recover from the

error.

~ Nested exception handling

T~ B8 958 8

@ TryAgain = True

while TryAgain:
try:
Value = int(input("Type a whole number. "))
except ValueError:
£("You must type a whole number!™)

print("0K, s
TryAgain =
else:
if (str.upper(DoOver) == "N"):
TryAgain = False
except KeyboardInterrupt:

print(value)
TryAgain = False

Type & whole number. Hello
You must type & whole number!
Try again (y/n)?

Choose Runtimer> Interrupt Execution for Colab or Kernel => Interrupt
for Jupyter Notebook to interrupt the application.

The application ends by displaying OK, see you next time!. Notice that the
message is the one from the inner exception. The application never gets to the
outer exception because the inner exception handler provides generic
exception handling.

Click Run Cell.
Python asks the user to input a whole number.

Choose Kernel => Interrupt to interrupt the application, type 5.5, and
then press Enter.

The application ends by displaying You pressed Ctrl+C!. Notice that the
message is the one from the outer exception. In Steps 6 and 8, the user ends
the application by pressing an interrupt key. However, the application uses two
different exception handlers to address the problem.

Raising Exceptions

180

So far, the examples in this chapter have reacted to exceptions. Something hap-
pens and the application provides error-handling support for that event. How-
ever, situations arise for which you may not know how to handle an error event
during the application design process. Perhaps you can’t even handle the error at
a particular level and need to pass it up to some other level to handle. In short, in
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some situations, your application must generate an exception. This act is called
raising (or sometimes throwing) the exception. The following sections describe
common scenarios in which you raise exceptions in specific ways.

Raising exceptions during
exceptional conditions

The example in this section demonstrates how you raise a simple exception —
that it doesn’t require anything special. The following steps simply create the
exception and then handle it immediately.

1. Type the following code into a new cell of the notebook — pressing Enter
after each line:

try:
raise ValueError

except ValueError:
print("ValueError Exception!")

You wouldn't ever actually create code that looks like this, but it shows you how
raising an exception works at its most basic level. In this case, the raise call
appears within atry. . .except block. A basic raise call simply provides the
name of the exception to raise (or throw). You can also provide arguments as
part of the output to provide additional information.

Notice that this try. . .except block lacks an else clause because there is
nothing to do after the call. Although you rarely use atry. . .except blockin
this manner, you can. You may encounter situations like this one sometimes
and need to remember that adding the else clause is purely optional. On the
other hand, you must add at least one except clause.

2. Click Run Cell.

Python displays the expected exception text, ValueError Exception!.

Passing error information to the caller

Python provides exceptionally flexible error handling in that you can pass infor-
mation to the caller (the code that is calling your code) no matter which exception
you use. Of course, the caller may not know that the information is available,
which leads to a lot of discussion on the topic. If you’re working with someone
else’s code and don’t know whether additional information is available, you can
always use the technique described in the “Obtaining a list of exception argu-
ments” sidebar, earlier in this chapter, to find it.
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FIGURE 10-8:

You can add error
information to
any exception.

You may have wondered whether you could provide better information when
working with aValueError exception than with an exception provided natively by

Python. The following steps show that you can modify the output so that it does
include helpful information.

1. Type the following code into a new cell of the notebook — pressing Enter
after each line:

try:
Ex = ValueError()
Ex.strerror = "Value must be within 1 and 10."
raise Ex

except ValueError as e:

print("ValueError Exception!", e.strerror)

The ValueError exception normally doesn't provide an attribute named
strerror (a common name for string error), but you can add it simply by
assigning a value to it as shown. When the example raises the exception, the
except clause handles it as usual but obtains access to the attributes usinge.

You can then access the e. strerror member to obtain the added
information.

2. Click Run Cell.

Python displays an expanded ValueError exception, as shown in Figure 10-8.

~ Passing error information to the caller

P SR=-E-N'0 B
< @ try:

= "Value must be within 1 and 18."
Ex
except ValueError as e:

print("ValueError Exception!”, e.strerror)

ValueError Exception! Value must be within 1 and 1@.

Deciding to Say “Oops” in Your Own Way:
Custom Exceptions

Python provides a wealth of standard exceptions that you should use whenever
possible. These exceptions are incredibly flexible, and you can even modify them
as needed (within reason) to meet specific needs. For example, the “Passing error
information to the caller” section of this chapter demonstrates how to modify a
ValueError exception to allow for additional data. However, sometimes you
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simply must create a custom exception because none of the standard exceptions
will work. Perhaps the exception name just doesn’t tell the viewer the purpose
that the exception serves. You may need a custom exception for specialized data-
base work or when working with a service.

The example in this section is going to seem a little complicated for now because
you haven’t worked with classes before. Chapter 15 introduces you to classes and
helps you understand how they work. If you want to skip this section until after
you read Chapter 15, you can do so without any problem.

The example in this section shows a quick method for creating your own excep-
tions. To perform this task, you must create a class that uses an existing exception
as a starting point. To make things a little easier, this example creates an excep-
tion that builds upon the functionality provided by the ValueError exception. The
advantage of using this approach rather than the one shown in the preceding sec-
tion, “Passing error information to the caller,” is that this approach tells anyone
who follows you precisely what the addition to the ValueError exception is. It also
makes the modified exception easier to use.

1. Type the following code into the notebook — pressing Enter after each
line:

class CustomValueError(ValueError):
def __init__(self, arg):
self.strerror = arg
self.args = {arg}
try:
raise CustomValueError("Value must be within 1 and 10.")
except CustomValueError as e:
print("CustomValueError Exception!", e.strerror)

This example essentially replicates the functionality of the example in the
“Passing error information to the caller” section of the chapter. However, it
places the same error in both strerror and args so that the developer has
access to either (as would normally happen).

The code begins by creating the CustomValueError class that uses the
ValueError exception class as a starting point. The __init__() function
provides the means for creating a new instance of that class. Think of the class
as a blueprint and the instance as the building created from the blueprint.

Notice that the strerror attribute has the value assigned directly to it, but
args receives it as an array. The args member normally contains an array of
all the exception values as strings, so this is standard procedure, even when
args contains just one value as it does now.
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The code for using the exception is considerably easier than modifying
ValueError directly. All you do is call raise with the name of the exception
and the arguments you want to pass, all on one line.

2. Cclick Run Cell.

The application displays a similar error message to that shown in Figure 10-8,
except this time it notes that it's a custom error message by saying,
CustomValueError Exception! Value must be within 1 and 10.

Using the finally Clause

184

Normally you want to handle any exception that occurs in a way that doesn’t
cause the application to crash. However, sometimes you can’t do anything to fix
the problem, and the application is most definitely going to crash. At this point,
your goal is to cause the application to crash gracefully, which means closing files
so that the user doesn’t lose data and performing other tasks of that nature. Any-
thing you can do to keep damage to data and the system to a minimum is an
essential part of handling data for a crashing application.

The finally clause is part of the crashing-application strategy. You use this
clause to perform any required last-minute tasks. Normally, the finally clause is
quite short and uses only calls that are likely to succeed without further problem.
It’s essential to close the files, log the user off, and perform other required tasks,
and then let the application crash before something terrible happens (such as a
total system failure). With this necessity in mind, the following steps show a sim-
ple example of using the finally clause:

1. Type the following code into a new cell in the notebook — pressing Enter
after each line:

import sys
try:
raise ValueError
print("Raising an exception.")
except ValueError:
print("ValueError Exception!")
sys.exit()
finally:
print("Taking care of last minute details.")
print("This code will never execute.")
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FIGURE 10-9:

Use the finally
clause to ensure
that specific
actions take place
before the
application ends.

In this example, the code raises a ValueError exception. The except clause
executes as normal when this happens. The call to sys.exit() means that the
application exits after the exception is handled. Perhaps the application can't
recover in this particular instance, but the application normally ends, which is
why the final print () function call won't ever execute.

The finally clause code always executes. It doesn’t matter whether the
exception happens or not. The code you place in this block needs to be
common code that you always want to execute. For example, when working
with a file, you place the code to close the file into this block to ensure that the
data isn't damaged by remaining in memory rather than going to disk.

Click Run Cell.

The application displays the except clause message and the finally clause
message, as shown in Figure 10-9. The sys.exit() call prevents any other
code from executing.

Note that this isn't a normal exit, so Jupyter Notepad displays additional
information for you in the form of a traceback. Colab doesn't display this
information, but you can display it by using %tb. Simply type %tb in an empty
cell and click Run Cell to see the information. When you use some other IDEs,
the application may simply exit without displaying any additional information.

Comment out theraise ValueErrorcall by preceding it with two pound
signs, like this:

## raise ValueError

~ Using the finally Clause

(-] ° import sys
try:
try:

4+ CA-E- NN I

ize ValueError

valueError Exception!")

ing care of last minute details.”)
s code will never execute."]|

valueError Exception!
Taking care of last minute details.
An exception has occurred, use ¥tb to see the full traceback.

SystemExit
SEARCH STACK OVERFLOW

Jusr/local/lib/python3.7/dist-packages/IPython/core/interactiveshell.py:2890: Userbarning: To exit: wse 'exit’, 'quit’, o
warn("To exit: use ‘exit’, 'quit', or Ctrl-D.*, stacklevel=1)

3
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Be sure to
remember that
the finally clause
always executes.

Removing the exception will demonstrate how the finally clause actually
works. Using two pound signs will make the commented code stand out and
easier to search for.

Click Run Cell.

The application displays a series of messages, including the finally clause
message, as shown in Figure 10-10. This part of the example shows that the
finally clause always executes, so you need to use it carefully.

[y o B8 & @

import sys
try:

##raise ValueError

print("Raising an exception.")
except ValueError:

print(“valueError Exception!™)

sys.exit()
Finally:

print(“Taking care of last minute details.™)
print("This code will never execute.")

Raising an exception.
Taking care of last minute details.
This code will never execute.
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IN THIS PART ...

Using packages instead of coding
Adding language to applications
Creating lists of things to do
Defining collections of objects

Working with classes



IN THIS CHAPTER

» Organizing your code

» Adding code from outside sources
» Locating and viewing code libraries

» Obtaining and reading library
documentation

Chapter 11

Interacting with
Packages

©
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he examples in this book are small, but the functionality of the resulting

applications is extremely limited as well. Even tiny real-world applications

contain thousands of lines of code. In fact, applications that contain millions
of lines of code are somewhat common. Imagine trying to work with a file large
enough to contain millions of lines of code — you’d never find anything. In short,
you need some method to organize code into small pieces that are easier to
manage, much like the examples in this book. The Python solution is to place code
in separate code groupings called packages. Commonly used groupings that contain
source code for generic needs and more than one package are called libraries.

Packages are contained in separate files. To use the package, you must tell Python
to grab the code and read it into the current application. The process of obtaining
code found in external files is called importing. You import a package or library to
use the code it contains. A few examples in the book have already shown the
import statement in use, but this chapter explains the import statement in detail
so that you know how to use it.

The library code is self-contained and well documented (at least in most cases it
is). Some developers might feel that they never need to look at the library code,
and they’re right to some degree — you never have to look at the library code in
order to use it. You might want to view the library code, though, to ensure that you
understand how the code works. In addition, the library code can teach you new
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programming techniques that you might not otherwise discover. So, viewing the
library code is optional, but it can be helpful.

You don’t have to type the source code for this chapter manually. In fact, using the
downloadable source is a lot easier. You can find the source for this chapter in the
BPP4D3E; 11; Interacting with Packages.ipynb and BPP4D3E; 11; Pack-

RememBer  ages. ipynb files of the downloadable source. See the Introduction for details on
how to find these source files.

Creating Code Groupings

Code groupings in the form of packages and libraries are part of working with
even the simplest program in Python. Some libraries are automatically imported
for you because you use them for every application. Other libraries require that
you import them individually. As part of the initial setup, Python created a pointer
to the general-purpose libraries it uses. That’s why you can simply add an import
statement with the name of the library, and Python can find it. However, it pays
to know how to locate the files on disk in case you ever need to update them or
want to add your own packages and libraries to the list of files that Python can use.

The one thing you do need to know how to do is obtain and use the Python library
documentation. This chapter shows you how to obtain and use the library docu-
mentation as part of the application-creation process. In the sections that follow,
you discover more about the code groupings that Python uses, including how to
interact with them at a basic level.

The example in the “Creating your first package” section that follows works well
only with Jupyter Notebook. Google Colab users can still follow along, but the act
of working online makes this particular example (the only one in the book) quite a
warning  Challenge to complete. The problems are that you would need to download the file
locally, rename it because Colab mangles the name, and then upload it to the

correct directory online, which can be insanely difficult to find. Consequently,
the steps will focus on Jupyter Notebook use in this one particular case.

I'm confused! Understanding
modules versus packages

In some sources, you may see modules used in place of packages. People often use
e the two terms interchangeably because there really isn’t much of a difference
\J between them. Most sources define a module as a single file containing code with

TecHnicAL  an extension of .py. A package is a group of modules often organized in a
STUFF
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hierarchical fashion (although, hierarchical organization isn’t a language
requirement). Even though there are small differences between the two, you can
view both as methods of putting code into an easily used container, so this chapter
uses “package” throughout because that’s the term you see most often in the
official documentation. If you want a more detailed view of the differences, you
can read about it at https://learnpython.com/blog/python-modules—
packages-libraries-frameworks/.

Creating your first package

Grouping like pieces of code together is important to make the code easier to use,
modify, and understand. As an application grows, managing the code found in a
single file becomes harder and harder. At some point, the code becomes impossi-
ble to manage because the file has become too large for anyone to work with.

The term code is used broadly in this particular case. Code groupings can include:

¥ Classes
¥ Functions
¥ Variables

¥ Runnable code

The collection of classes, functions, variables, and runnable code within a package
is known as attributes. A package has attributes that you access by that attribute’s
name. Later sections in this chapter discuss precisely how package access works.

The runnable code can actually be written in a language other than Python. For
example, it’s somewhat common to find packages that are written in C/C++ instead
of Python. The reason that some developers use runnable code is to make the
Python application faster, less resource intensive, and better able to use a
particular platform’s resources. However, using runnable code comes with the
downside of making your application less portable (able to run on other platforms)
unless you have runnable code packages for each platform that you want to
support. In addition, dual-language applications can be harder to maintain
because you must have developers who can speak each of the computer languages
used in the application.

The most common way to create a package is to define one or more separate files

containing the code you want to group separately from the rest of the application.
For example, you might want to create a print routine that an application uses in
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a number of places. The print routine isn’t designed to work on its own but is part
of the application as a whole. You want to separate it because the application uses
it in numerous places and you could potentially use the same code in another
application. The ability to reuse code ranks high on the list of reasons to create
packages.

To make things easier to understand, the examples in this chapter use a common
package. The package doesn’t do anything too amazing, but it demonstrates the
principles of working with packages. Open a Python 3 Notebook project, name
it BPP4D3E; 11; Packages, and create the code shown in Listing 11-1. After
you complete this task, download the code as a new Python file named
BPP4D3E; 11; Packagesl.py by choosing File &> Download As = Python (.py) in
Notebook.

m A Simple Demonstration Package

192
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def SayHello(Name):
print("Hello ", Name)
return

def SayGoodbye(Name):
print("Goodbye ", Name)
return

This example specifically uses a Notebook filename that contains special charac-
ters and spaces to make a point. Any package you create can’t have spaces or
special characters in the filename and still work correctly. Consequently, you must
rename BPP4D3E; 11; Packagesl.py to BPP4D3E_11_Packages.py if you want it
to work with the remainder of the example in this chapter.

You may need to copy the resulting file to your existing BPP4D3E folder, depending
on where your browser normally downloads files. When done correctly, your
Notebook dashboard should contain a copy of the file, as shown in Figure 11-1.
Using the Notebook’s Import feature makes things considerably easier. Notice
that the name of the .py file is BPP4D3E_11_Packages.py.

The example code contains two simple functions named SayHello() and Say-
Goodbye (). In both cases, you supply a Name to print and the function prints it
onscreen along with a greeting for you. At that point, the function returns control
to the caller. Obviously, you normally create more complicated functions, but
these functions work well for the purposes of this chapter.
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FIGURE 11-1:
Make sure you
place a copy of
the package in
your BPP4D3E
folder.

Files Running Clusters

Select items to perform actions on them Upload | Meww |2

[Jo  ~ Wi Anaconda Projects /| BPPAD3E Name & Last Modified File size
] seconds ago

[0 & BPP4D3E; 02, Colab Examples.ipynb 2 months ago 1.21kB
[0 & BPP4D3E; 03; Working with Commands.ipynb a month ago 327kB
[0 & BPP4D3E; 04; Comments.ipynb a month ago 3.21kB
(O & BPP4D3E; 04; Indentation.ipynb a month ago 115kB
O & BPP4D3E; 04; Sample.ipynb a month ago 281kB
[ & BPP4D3E; 0 a month ago 105 kB

(J & BPP4D3E; 06; S ifying Information.ipynb a month ago 542 kB

(J & BPP4D3E, 07 naging Information.ipynb 24 days ago 8.88 kB
(0 & BPP4D3E; 08; Making Decisions.ipynb 17 days ago 14.1 kB
[ & BPP4D3E; 09; Performing Repetitiv ipynb 14daysage  6.42kB
() & BPP4D3E; 10; Dealing with Errors ipynb 7 days ago 26.1kB
] BPP4D3E; 11; Interacting with Packages.ipynb Running 7 minutes ago 14 kB
(0 & BPP4D3E; 11; Packages ipynb 3 days ago 1.11 kB
[ [3 BPP4D3E_11_Packagss py seconds ago 242B

INTERACTING WITH THE CURRENT
PYTHON DIRECTORY

The directory that Python is using to access code affects which packages you can load.
The Python library files are always included in the list of locations that Python can
access, but Python knows nothing of the directory you use to hold your source code
unless you tell it to look there. Of course, you need to know how to interact with the
directory functions in order to tell Python where to look for specific bits of code.

1. Open a new notebook.

You can also use the downloadable source file, BPP4D3E; 11; Interacting
with Packages.ipynb.

2. Type import os and press Enter.

This action imports the Python os library. You need to import this library to change
the directory (the location Python sees on disk) to the working directory for this
book.

3. Type print(os.getcwd()) and click Run Cell.

You see the current working directory (CWD) that Python uses to obtain local code.

(continued)
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4. In a new cell, type for entry in os.listdir(): print(entry) and click Run Cell.

You see a listing of the directory entries. The listing lets you determine whether the
file you need is in the CWD. If not, you need to change directories to a location that
does contain the required file.

To change directories to a new location, you use the os . chdir () method and include
the new location as a string, such asos.chdir('C:\MyDir'). However, you normally
find with Notebook that the CWD does contain the files for your current project.

The code in this sidebar works with Google Colab as well as Jupyter Notebook, but the
@ Google Colab results are less useful. The Colab Python executable files are normally

located in the /usr/local /bin/python directory, which you can determine using the

TIP lwhich python command, where the ! (bang) operator (https://anaconda.
zendesk .com/hc/en-us/articles/360023858254-Executing-Terminal—
Commands-in-Jupyter—Notebooks) provides access to the system shell, and the
which command (https://linuxize.com/post/1inux—which—command/)
provides the location of a particular executable, python in this case.

Understanding the package types

The Python support system is immense. In fact, you’ll likely never use more than
a small fraction of it for even the most demanding applications. It’s not that
Python itself is all that huge; the language is actually somewhat concise compared
to many other languages out there. The immensity comes from the Python system
of packages and libraries that perform everything from intense scientific work, to
Al, to space exploration, to biologic modeling, to anything else you can imagine
and many things you can’t. However, not all those packages are available all the
time, so you need some idea of what sort of packages Python supports and where
you might find them (in order of preference):

3 Built-in: The built-in packages address most common needs. When working
with Jupyter Notebook as part of Anaconda (a development package contain-
ing multiple tools, including conda, that you can find athttps: //www.
anaconda.com/), you find them in the \Users\ <Username> \Adaconda3\Lib
folder on your system, and all you need to do to use them is import them
into your application. Locating them in Google Colab is somewhat more
difficult. You may need to do a little searching. However, if you're using Python
3.7, you could use this command (all on one line) in a Colab cell to obtain a
listing of the built-in packages (see the “Interacting with the current python
directory” sidebar for details on using os commands):
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for entry in os.listdir("/usr/local/lib/python3.7/
dist-packages"): print(entry)

Custom: As demonstrated in this chapter, you can create your own packages
and use them as needed. They appear on your hard drive, normally in the
same directory as your project code, and you simply import them into your
application.

Conda: You can find a wealth of packages specifically designed for Anaconda
(upyter Notebook). Many of these packages appear athttps://anaconda.
org/mutirri/repo. Before you can use these packages, you must install
them by using the conda utility at the Anaconda command line, as described
in the “Installing conda packages"” section of this chapter. After you have the
package installed, you use it as you would any built-in package. If you are
using Colab, you won't have access to the conda utility, which is explained in
the “And just why is conda missing in Colab?” section of the chapter.

Non-conda: Just because a package isn't specifically designed for use with
Anaconda doesn’'t mean that you can't use it. You can find a great wealth of
packages from third parties that provide significant functionality. To install
these packages, you use the pip utility, as described in the “Installing pack-
ages by using pip” and “Installing packages using the %pip magics” sections,
later in this chapter. After you have the package installed, you may have to
perform additional configuration as described by the party who created the
package. Generally, when the package is configured, you use it as you would
any built-in package.

Considering the package cache

This section doesn’t apply to Google Colab, so you can skip it if you’re working
online or simply don’t want to know about the package cache. Anaconda provides
a package cache that resides outside the Python library. This package cache lets
you easily interact with the Anaconda-specific packages by using the conda
command-line utility. To see how you use this package cache:

1.

Open an Anaconda command prompt or terminal window.

You get access to this feature through the Anaconda Prompt entry in the
Anacondas3 folder on your system.

Type conda list and press Enter.

You see a list of the packages that you have installed now.
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Note that the output displays the package name as you would access it from within
Anaconda, the package version, and the associated Python version. All this infor-
mation is helpful in managing the packages. The following list provides the
essential conda commands for managing your packages:

¥ conda clean: Removes packages that you aren't using.
¥ conda config: Configures the package cache setup.

¥ conda create: Defines a new conda environment that contains a specific list
of packages, which makes it easier to manage the packages and can improve
application speed.

¥ conda help: Displays a complete list of conda commands.

¥ conda info: Displays the conda configuration information, which includes
details on where conda stores packages and where it looks for new packages.

¥ conda install: Installs one or more packages into the default or specified
conda environment.

¥ conda list: Outputs a list of conda packages with varying levels of detail.
You can specify which packages to list and in which environments to look.

¥ conda remove: Removes one or more packages from the package cache.

¥ conda search: Looks for specific packages by using the search criteria you
provide.

¥ conda update: Updates some or all of the packages in the package cache.

These commands can do a lot more than you might think. Of course, it’s impossi-
ble to memorize all that information, so you can rely on the —-help command-
line switch to obtain full details on using a particular command. For example, to
learn more about conda list, type conda list --help and press Enter.

Importing Packages
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To use a package, you must import it. Python places the package code inline with
the rest of your application in memory — as if you had created one huge file. Nei-
ther file is changed on disk — they’re still separate, but the way Python views the
code is different.

You have two ways to import packages. Each technique is used in specific
circumstances:
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import: You use the import statement when you want to import an entire
package. This is the most common method that developers use to import
packages because it saves time and requires only one line of code. However,
this approach also uses more memory resources than does the approach of
selectively importing the attributes you need, which the next paragraph
describes.

from. . .import: You use the from. . .import statement when you want to
selectively import individual package attributes. This method saves resources,
but at the cost of complexity. In addition, if you try to use an attribute that you
didn't import, Python registers an error. Yes, the package still contains the
attribute, but Python can't see it because you didn't import it.

Now that you have a better idea of how to import packages, it’s time to look at
them in detail. The following sections help you work through importing packages
using the two techniques available in Python.

Using the import statement

The import statement is the most common method for importing a package into
Python. This approach is fast and ensures that the entire package is ready for use.
The following steps get you started using the import statement:

1.

Open a new notebook, if you haven’t already created one for the code in
the “Interacting with the current python directory” sidebar.

You can also use the downloadable source file, BPP4D3E; 11; Interacting
with Packages.ipynb.

Change directories, if necessary, to the downloadable source code directory.

Generally, Notebook places you in the correct directory to use the source code
files, so you won't need to perform this step. See the instructions found in the
“Interacting with the current Python directory” sidebar.

In a new cell, type import BPP4D3E_11_Packages and press Enter.

This instruction tells Python to import the contents of the BPP4D3E_11_
Packages. py file that you created in the “Creating your first package” section
of the chapter. The entire library is now ready for use.

It's important to know that Python also creates a cache of the package in the
__pycache__ subdirectory of the BPP4D3E folder. If you look into your source
code directory after you import BPP4D3E_11_Packages for the first time, you
see the new __pycache__ directory. If you want to make changes to your
package, you must delete this directory. Otherwise, Python will continue to use
the unchanged cache file instead of your updated source code file.
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4.

The cached filename includes the version of Python for which it is meant, so it's
BPP4D3E_11_Packages . cpython-38. pyc in this case. The 38 in the filename
means that this file is Python 3.8 specific. A . pyc file represents a compiled
Python file, which is used to improve application speed.

Type dir(BPP4AD3E_11_Packages) and click Run Cell.

You see a listing of the package contents, which includes the SayHello() and
SayGoodbye( ) functions, as shown in Figure 11-2. (A discussion of the other
entries appears in the “Viewing the Package Content” section, later in this
chapter.)

Using the import statement

In [3]: import BPP4D3E_11_Packages
dir(BPP4DIE_11_Packages)|

Out[3]: ['SayGoodbye',
'SayHello’,
'__builtins_ ',
'__cached__",
'__doc__ ",

" file_ ",
'__loader__",
'__name__",
'__package_ ",
'__spec_ ']

6.

In a new cell, type BPP4D3E_11_Packages.SayHello(“Josh”).

Notice that you must precede the attribute name, which is the SayHello()
function in this case, with the package name, which is BPP4D3E_11_Packages.
The two elements are separated by a period (also called a dot). Every call to a
package that you import follows the same pattern.

Type BPP4D3E_11_Packages.SayGoodbye(“Sally”) and click Run Cell.

The SayHello() and SayGoodbye( ) functions output the expected text.

Using the from. . .import statement

The from. . . import statement has the advantage of importing only the attributes
you need from a package. This difference means that the package uses less
memory and other system resources than using the import statement does. In
addition, the from. ..import statement makes the package a little easier to use
because some commands, such as dir(), show less information, or only the
information that you actually need. The point is that you get only what you want
and not anything else. The following steps demonstrate using the from. . . import
statement. However, before you can import BPP4D3E_11_Packages selectively,
you must remove it from the environment, which is the first part of the following

process.
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1.

2.

Type the following code into a new cell in the Notebook:

import sys

del sys.modules["BPP4D3E_11_Packages"]
del BPP4D3E_11_Packages

dir (BPP4D3E_11_Packages)

Click Run Cell.

You see the error message shown in Figure 11-3. Listing the content of the
BPP4D3E_11_Packages package isn't possible anymore because it's no longer
loaded.

Using the from...import statement

In [5]: import sys
del sys.modules["BPP4D3E_11_Packagss™]
del BPPAD3E_11_Packages
dir(BPP4D3E_11_Packages

NameError Traceback (most recent call last)
<ipython-input-5-87e9cabaed46> in

2 del sys.modules["BPP4D3E_11 Packages"]

3 del BPP4D3E_11 Packages
----» 4 dir(BPP4D3E_11_Packages)

NameError: name 'BPP4D3E_11_Packages' is not defined

In a new cell, type from BPP4D3E_11_Packages import SayHello and press
Enter.

Python imports the SayHello( ) function from BPP4D3E_11_Packages. Only
this specific function is now ready for use.

To import both functions you need, you create a list of attributes to import; the
names can be separated by commas, such as from BPP4D3E_11_Packages
import SayHello, SayGoodbye.

Type dir(BPP4D3E_11_Packages) and click Run Cell.

Python displays an error message, as shown previously in Figure 11-3. Python
imports only the attributes that you specifically request. This means that the
BPP4D3E_11_Packages package isn't in memory — only the attributes that you
requested are in memory.

In a new cell, type dir(SayHello) and click Run Cell.

You see a listing of attributes that are associated with the SayHello()
function, as shown in Figure 11-4 (which is only a partial list). You don’t need to
know how these attributes work just now, but you'll use some of them later in
the book.
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In [7]:|dir({SayHello)

Out[7]:

annotations__ ",
call__",
class_ ',
closure__",

n
o
o
o

defaﬁts_‘ .
delattr__ ",
dict__ ",

=y
s
=

doc__°,

'__getattribute_ ',
‘__globals__",
‘gt ',
‘__hash__",

' init ",
*__init_subclass_ *,
' kwdefaults_ ',

'__new_ ',

' __qualname__",
'__reduce_ ',
'__reduce_ex_ ',
'_repr__',
'__setattr__",
'__sizeof_ ',
f__str_ ",

' __subclasshook_ ']

6. Inanew cell, type SayHello("Angie") and click Run Cell.
The SayHello( ) function outputs the expected text.

When you import attributes by using the from. . . import statement, you don't
need to precede the attribute name with a package name. This feature makes
the attribute easier to access.

Using the from. . . import statement can also cause problems. If attributes
from two different packages have the same name, you can import only one of
them using this approach. Using the import statement form prevents name
collisions, which is important when you have a large number of attributes to
import. In sum, you must exercise care when using the from. . . import
statement.

7. Inanew cell, type SayGoodbye("Harold") and click Run Cell.

You imported only the SayHello( ) function, so Python knows nothing about
SayGoodbye( ) and displays an error message. The selective nature of the
from. . .import statement can cause problems when you assume that an
attribute is present when it really isn't.

Using the import. . .as statement

Having to precede every attribute name with the BPP4D3E_11_Packages name will
cause severe finger cramping after a while, and no one wants that! Of course, such
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a long name can also cause steaming-brain syndrome as you attempt to remem-
ber what the package name is. Fortunately, Python is concerned about your health
and provides an alternative to finger cramping and a steaming brain in the form
of the import. . .as statement. The as part of the statement gives the package a
shorter, easier-to-remember name that won’t cause finger problems or that other
thing. The following steps show how to use this approach.

1. Type the following code into a new cell in the Notebook:

import BPP4D3E_11_Packages as BPP
dir(BPP)

2. Click Run Cell.

You see the same listing of package contents as that shown in Figure 11-2, but
you had to type less code to get it.

3. Type the following code into a new cell in the Notebook:

BPP.SayHello("Albert")
BPP . SayGoodbye( "Daphne")

4. Click Run Cell.

The two functions output the expected text. However, you typed a lot less code
to obtain the results.

Finding Packages

To use the code in a package, Python must be able to locate the package and load
it into memory, so you need to know where the package resides. When working
with Jupyter Notebook, the packages reside on your hard drive. If you don’t find
them on your hard drive, you can download what you need. Colab stores its files in
the /usr/local/lib/python3.7/dist-packages folder (with the 3.7 indicating
the Python version you’re using) online. Anything on your local disk is inaccessi-
ble. The following sections discuss how to find packages that are already available
to Python in more detail. (The “Downloading Packages from Other Sources” sec-
tion, later in the chapter, tells how to obtain packages that you can’t already
access.)
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USING ENVIRONMENT VARIABLES
WITH PYTHON

Environment variables tell Python how to configure itself or where to look for resources.
Using environment variables makes sense when you need to configure Python the
same way on a regular basis. You can find a list of environment variables at https: //
www . geeks forgeeks .org/environment-variables—in-python/ and how to inter-
act with them athttps: //www.askpython.com/python/environment-variables—
in-python. Of the environment variables, the one you use most often is PYTHONPATH,
which provides a semicolon (;) separated list of directories to search for modules. This
value is stored in the sys . path variable in Python.

Locating packages on disk

Some of the information in this section works only with Jupyter Notebook; it may
not work with any browser-based IDE you use (such as Google Colab). The loca-
tion information is stored as paths within Python. Whenever you request that
Python import a package, Python looks at all the files in its list of paths to find it.
The path information comes from three sources:

3 Environment variables: Environment variables, such as PYTHONPATH, tell
Python where to find packages on disk (see the “Using environment variables
with Python” sidebar for details).

3 Current directory: Earlier in this chapter, you discover that you can change
the current Python directory so that it can locate any packages used by your
application.

3 Default directories: Even when you don't define any environment variables
and the current directory doesn't yield any usable packages, Python can still
find its own libraries in the set of default directories that are included as part
of its own path information.

Knowing the current path information is helpful because the lack of a path can
cause your application to fail. To obtain path information, type for p in sys.path:
print(p) in a new cell and click Run Cell. You see a listing of the path information,
as shown in Figure 11-5. Your listing may be different from the one shown in Fig-
ure 11-5, depending on your platform, the version of Python you have installed,
and the Python features you have installed.
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Locating packages on disk

In [12]: import sys
for p in sys.path: prirtnpﬂ

:\Users\John\Anaconda Projects\BPP4D3E
:\Users\John\anaconda3\python38.zip
\Users\John\anaconda3\DLLs
:\Users\John\anaconda3\1lib
:\Users\John\anaconda3

s NsRs s

FIGURE 11-5:

The sys.path
attribute contains
a listing of the
individual paths
for your system.

‘Wsers\Johnianaconda3\lib\site-packages
\Users\Johnianaconda3\lib\site-packages\win32
\Users\Johnianaconda3\lib\site-packages\win32\lib
\Users\John\anaconda3\lib\site-packages\Pythonuin
\Users\John\anaconda3\lib\site-packages\IPython\extensions
:\Users\John\. ipython

oo a0 oo

The sys.path attribute is reliable but may not always contain every path that
Python can see. If you don’t see a needed path, you can always check in another
place that Python looks for information. The following steps show how to perform
this task:

1. Type the following code into a new cell in the Notebook:

import os
os.environ['PYTHONPATH'] .split(os.pathsep)

When you have a PYTHONPATH environment variable defined, you see a list of
one or more paths, such as [ 'C:\\BP4D"'] or [ ' /env/python']. However, if
you don't have the environment variable defined, you see an error message
instead.

You must provide split( ) with a value to look for in splitting a list of items.
The os. pathsep constant (a variable that has one, unchangeable, defined
value) defines the path separator for the current platform so that you can use
the same code on any platform that supports Python.

2. Click Run Cell.

You see the listing of paths for your platform and setup.

You can also add and remove items from sys.path. For example, if you want to
@ add the current working directory to the list of packages, you type sys.path.
append(os.getewd()) in the Notebook cell and click Run Cell. When you list the
TIP sys.path contents again, you see that the new entry is added to the end of the list.
Likewise, when you want to remove an entry, you type sys.path.remove(os.
getcewd()) in the Notebook cell and click Run Cell. The addition is present only

during the current session.

& If you change an environment variable while the Jupyter Notebook server is run-
ning, you won’t see any changes within the Notebook. To see the changes, you

must restart Jupyter Notebook completely from scratch.
WARNING
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Locating packages online

When working with a browser-based IDE, you often see the results of using a vir-
tual environment, the platform that the host has chosen to use, or simply find the
information you need in a location other than what you expected. Consequently,
the code in the “Locating packages on disk” section may work, but may not pro-
vide what you need. For example, to ensure that you can actually find the Python
path, you need to use the !echo $PYTHONPATH command for Linux and macOS, or
lecho %PYTHONPATH% for Windows (see the article at https://www3.ntu.edu.sg/
home/ehchua/programming/howto/Environment_Variables.html for details on
how environment variables work on different operating systems). Using the
wrong form of the command for a particular host doesn’t do anything terrible;
you just won’t see the path to Python (assuming that the host actually defines the
PYTHONPATH environment variable).

In many situations, you must rely more heavily on magics (as discussed in
Chapter 5) when working with packages and attempting to perform other tasks
when using a browser-based IDE. For example, when working with Colab, every !
operator command you use creates an entirely new subshell, which means that
the changes made by each statement may be lost. Consequently, if you wanted to
do something like change directories to load a package, you’d need to use the %cd
magics command rather than the ! cd operator command, even though it seems as
if both should work. The result of the !cd operator command would go away as
soon as the command completed, but the %cd magics command is permanent for
a particular session. Note that the functions in the os package (as used in the
previous section) are often effective when working with browser-based IDEs. For
example, you may be able to use os.chdir(), rather than rely on the %cd magics.

Downloading Packages
from Other Sources

204

Your copy of Python and the associated Jupyter Notebook component of Anaconda
or Google Colab come with a wide assortment of packages that fulfill many com-
mon needs. In fact, for experimentation purposes, you seldom have to go beyond
these packages because they are already installed as part of your IDE. Of course,
someone is always thinking of some new way to do things, which requires new
code and packages to store the code. In addition, some coding techniques are so
esoteric that including the packages to support them with a default install would
consume space that most people will never use. Consequently, you may have to
install packages from online or other sources from time to time.
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The two most common methods of obtaining new packages are to use the conda
(which you find only in Jupyter Notebook) or pip (also known by the recursive
acronym Pip Installs Packages) utilities. However, you may find packages that use
other installation methods with varying degrees of success. You use conda and pip
for different purposes:

¥ conda: Provides general-purpose package management for a wide range of
languages with special needs in the conda environment.

¥ pip: Provides services specifically for Python in any environment. When you
need a Python-specific package, look to pip first. For example, pip gives you
access to the Python Package Index (PyPl) found athttps://pypi.org/.

You can read more about the differences between conda and pip at https://
jakevdp.github.io/blog/2016/08/25/conda-myths—and-misconceptions/ and
https://docs.conda.io/projects/conda/en/latest/commands.html#conda-
vs—pip-vs-virtualenv-commands. The following sections discuss these two
methods.

Opening the Anaconda Prompt

Before you can do much in the way of managing packages in Jupyter Notebook,
you must open the Anaconda Prompt. The Anaconda Prompt is just like any other
command prompt or terminal window, but it provides special configuration fea-
tures to make working with the various command-line utilities supplied with
Anaconda easier. To open the prompt, locate its icon in the Anaconda3 folder on
your machine. For example, when using a Windows system, you can open the
Anaconda Prompt by choosing Start= All Programs = Anaconda3 = Anaconda
Prompt. The Anaconda Prompt may take a moment or two to appear onscreen
because of its configuration requirements.

Working with conda packages

When working with Jupyter Notebook, you can perform a wide range of tasks
using conda, but some tasks are more common than others. The following sec-
tions describe how to perform five essential tasks using conda. You can obtain
additional information about this utility at https://docs.conda.io/projects/
conda/en/latest/commands.html. Typing conda --help at the Anaconda Prompt
or terminal window and pressing Enter also yields an overview of help
information.
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TIP

Viewing conda packages

You can view conda packages in two ways. The first is to create a list of available
packages, while the second is to search for a specific package. Listing helps you
discover whether a package is already installed. Searching helps you discover the
details about the installed package.

You can perform searching and listing in a general way to locate everything
installed on a particular system. In this case, you use the commands by
themselves:

conda list
conda search

The output of these commands is lengthy and might scroll right off the end of the
screen buffer (making it impossible to scroll back and view all of the results). You
can use conda list | more to display the output one page at a time on some
platforms.

Note that the output shows the package name, version, and associated version of
Python. You can use this output to determine whether a package is installed on your
system. However, sometimes you need more, which requires a search. For example,
say that you want to know what you have installed from the scikit-learn package
for the Windows 64-bit platform. In this case, you type conda search - -platform
win-64 scikit-learn and press Enter.

A number of flags exist to greatly increase the amount of information you receive.
For example, when you use the —— json flag, you obtain details such as a complete
list of dependencies for the package, whether the package is completely installed,
and a URL containing the location of the packages online. You can learn more
about conda searches at https://docs.conda.io/projects/conda/en/latest/
commands/search.html.

Installing conda packages

The lists of conda packages appear at https://docs.anaconda.com/anaconda/
packages/pkg-docs/. The lists are grouped by Python version number and plat-
form. To determine whether a package is available for your version of Python on a
particular platform, simply click the associated link. You can use conda to install
a package using the conda install command documented at https://docs.
conda.io/projects/conda/en/latest/commands/install.html. For example,
to install SciPy, you type conda install scipy and press Enter at the Anaconda
Prompt.
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WARNING

USING CONDA INFO

Even though the conda info command is normally associated with environment infor-
mation, you can also use it to work with packages. To discover the specifics of a particu-
lar package, you just add the package name, such asconda info numpy.
Unfortunately, using this command often results in information overload, so you need
to shorten it a little. One way to do this is to add a version number after the package
name separated by an equals (=) sign, such asconda info numpy=1.18.5 for version
1.18.5 of the NumPy package.

In most cases, you don't receive any additional information using the ——verbose switch
with packages. However, using the —— json switch can yield a little additional information,
and this switch puts the information in a form that lets you easily manipulate the output
using code, such as a script. The point is that you can use conda info to discover even
more deep, dark secrets about your packages. You can learn more about conda info at
https://docs.conda.io/projects/conda/en/latest/commands/info.html.

Updating conda packages

The packages you use to develop applications can become outdated with time. The
developers who maintain them might add new features or apply bug fixes. The
problem with updates is that they can cause your application to work incorrectly, or
sometimes not at all if you’re depending on a broken behavior. However, it’s generally
a good idea to keep packages updated if for no other reason than to apply security-
related bug fixes. Of course, you need to know that the package requires updating. To
find outdated packages, you use the conda search --outdated --names-only
command, followed by the name of the package you want to check.

After you know what you need to update, you can use the conda update command
to perform the task. For example, you might want to update the NumPy package,
which means typing conda update numpy and pressing Enter. Few packages are
stand-alone, so conda will present a list of items that you need to update along
with NumPy. Type y and press Enter to proceed. Figure 11-6 shows a typical
sequence of events during the update process.

You do have the option of updating all packages at one time. Simply type conda
update --all and press Enter to get started. However, you may find that interac-
tions between packages make the update less successful than it could be if you
performed the updates individually. In addition, the update can take a long time,
so be sure to have plenty of coffee and a copy of War and Peace on hand. You can
learn more about conda updates at https://docs.conda.io/projects/conda/
en/latest/commands/update.html.
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IThe following packages will be downloaded:

package | build
backports.functools_lru_cache-1.6.4] pyhd3ebibe_e 9 KB
backports.tempfile-1.8 | pyhd3eblbg_1 11 KB
conda-4.12.8 | py38haad5532_0 14.5 MB
conda-package-handling-1.8.1| py38h8cc25b3_@ 720 KB
xmltodict-0.12.0 | pyhd3eblbg_8& 13 KB

Total 15.2 MB

The following packages will be REMOVED:
python_abi-3.8-2_cp38

IThe following packages will be UPDATED:

backports.functoo~ 1.6.1-py_ @ --> 1.6.4-pyhd3eblbe_8
conda 4.11.6-py38haa?5532_08 --> 4.12.8-py38haad5532_o
conda-package-han~ 1.6.1-py38h62dcd37_8 --> 1.8.1-py38h8cc25b3_8

FIGURE 11-6:
You see a lot of

IThe following packages will be DOWNGRADED:

. . backports.tempfile 1.8-py 1 --> 1.8-pyhd3eblbs 1
information xmltodict 9.12.8-py_@ --> 8.12.8-pyhd3eblbo_o
during the update
process. Proceed ([y]/n)? v

Removing conda packages

At some point, you might decide that you no longer need a conda package. The
only problem is that you don’t know whether other packages depend on the pack-
age in question. Because package dependencies can become quite complex, and
you want to be sure that your applications will continue to run, you need to check
which other packages depend on this particular package. Unfortunately, the conda
info command (described at https://docs.conda.io/projects/conda/en/
latest/commands/info.html) tells you only about the package requirements —
that is, what it depends on. Best practice is to not uninstall packages after you’ve
installed them.

However, assuming that you really must remove the package, you use the conda
remove command described at https://docs.conda.io/projects/conda/en/
latest/commands/remove.html. This command removes the package that you

rememeer  Specify, along with any packages that depend on this package. In this case, best
practice is to use the ——dry-run command-line switch first to ensure that you
really do want to remove the package. For example, you may decide that you want
to remove NumPy. In this case, you type conda remove --dry-run numpy and
press Enter. The command w